


Is Microsoft’s Domination
Really unjust?

■■ eeddiittoorriiaall

The last couple of years have witnessed the growth of Linux from
an operating system that started out as the plaything of a small group
of programmers to one that is taken seriously all over the world.

Linux is the best operating system around. Linux is proof of the
power of communities. Linux stands for Freedom of choice. So claim
its ardent supporters.

Unlike the Macintosh operating system, Linux doesn’t face the
challenge of convincing people to switch to a more expensive and
proprietary hardware platform. Neither has it been stopped in its
tracks by limited hardware support, as was the fate of BeOS. For Win-
dows 98 users the differences in stability should itself have been suf-
ficient reason to switch over. But even though Linux is virtually free,
people haven’t been convinced to make the shift.

So what is really holding up this operating system in its quest for
popularity with regular desktop computer users?

The answer lies in the little details.
What is popularly referred to the ‘Linux Libraries Dependency

Hell’, makes installing new applications a tiresome process. Many
popular Windows applications are still not available on Linux and
the few world-class Linux applications have their own quirks. Con-
sider GIMP, which could really challenge Photoshop if the interface
wasn’t so clumsy. Issues such as this make the transition to Linux
extremely inconvenient for Windows users.

Newer distributions are as easy to install as Windows and the Linux
user interface itself has made great progress over the last year. How-
ever, there’s not much innovation directed at making it easier to use
for people unfamiliar with computing. The developers have wasted
several opportunities to prove that Linux is not just for geeks and
they will now find it even more difficult to make progress against the
latest Microsoft products. The traditional instability of the Windows
desktop OSes has been largely eliminated in Windows XP.

If Linux is to become more popular, its applications need to com-
pete with the best that Windows has to offer both in the features
offered, and in usability. The only way to seriously challenge Windows
is by concentrating on making Linux even more easy to use. This
would go a long way in ensuring that Linux moves beyond being an
operating system that so many love but very few choose actually to
use.

karan_manral@jasubhai.com

“Developers have
wasted several
opportunities to
prove that Linux
is not just for
geeks and they
will now find it
even more
difficult to make
progress against
Windows XP”

Karan Manral
Assistant Editor
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The PCDJ Silver is a
pumped up MP3 player
which allows you to
compose your own
music by remixing
MP3 tracks
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Michael Jackson,
Natalie Imbruglia,
and the Fast and the

Furious are some of the first
artistes to employ CDs that
use copy protection. A copy-
prevention mechanism called
key2audio has been used on
Michael Jackson’s forthcom-
ing single, ‘You Rock My
World’. This causes a comput-
er’s CD-ROM drive to incor-
rectly interpret the stored
data. Key2audio alters an
audio CD making it incom-
patible with CD-ROM, CD-R
and CD-RW drives. Similarly,
the SafeAudio system devel-
oped by Macrovision, pre-
vents one from ‘ripping’
music CDs to create digital
copies on a computer hard
disc or for downloading to a
portable player. SafeAudio is

based on the work of TTR
Technologies, Israel. SafeAu-
dio gives some of the digital
code on the CD “grossly erro-
neous values”, adding bursts
of hiss to the audio signal.
The error-correction codes on

the CD, which normally cor-
rect these errors, are distorted.
So error correction fails, leav-
ing tiny gaps in the music.

Universal uses Cactus

Data Shield to lock up ordi-
nary CD audio files. But it
includes a separate audio
player that allows digital ver-
sions of songs to be played.
These songs cannot be played
through common media play-
ers such as Windows Media or
Winamp. Nor can the digital
files be played on anything
other than a Windows OS.
Interestingly enough, you can
beat the protection by play-
ing a CD on a standard CD
player, taking the output to
the line-in jack on the com-
puter, and recording each
track into a WAV file. Once a
WAV, the song can easily be
converted to an MP3 using
any of the programs available
on the Net. It’s more time
consuming compared to a rip-
per, but it works. 

pulse ■
■ news

Northwood
■ What is it?
Northwood is the core
around which the new Intel
Pentium 4 processors will
run. They will be based on
the new 0.13-micron die
Tualatin core (116 mm), with
copper inter-connectors, will
run at speeds of more than 2
GHz and will replace the cur-
rent Pentium 4 processors.
■ What’s the fuss about?
Northwood comes with a
more compact socket type—
the socket 478, also called
mPGA478. Its small size
allows for a higher density of
pins attached on the proces-
sor. This entails a shorter dis-
tance from each other and to
the socket and hence, fewer
errors when instructions are
transmitted.

It will use 64-bit, 3.2
GBps FSB running at a 100
MHz quadpumped clock
speed. This means that it can
handle four times as many
instructions per clock cycle.
Also, its L2 cache will be
enlarged (from 256 KB) to a
standard size of a 512 KB.

Expecting an
urgent call?
There’s not

much you can do if
you’re 30 feet under-
water admiring the
lush aquatic life. But
that’s history now. A
new phone devised
by France Telecom
has made it possible
for divers to receive
calls from a landline or a
mobile phone without hav-
ing to surface. The phone,
which comes with a long
wire, is attached to a buoy
on the surface of the water.

The buoy contains a GSM
unit which picks up the sig-
nals and relays it down the
wire to the phone.

This phone has a dial pad,
a light, a buzzer and a special

mouthpiece. The
buzzer and a flashing
light alert the diver of
an incoming call. The
person receiving the
call underwater bites
on the mouthpiece to
receive the call and
hears the conversation
through sound vibra-
tions that reverberate
in the diver’s skull

towards his ear. The diver can
also talk back and use a dial-
ing pad to call anybody on a
fixed or wireless phone. Con-
nectivity now extends to the
oceans.

Oceanic Talk

Rip In Peace?

hypethesis

■ Linux breaks 100-Petabyte ceiling ■ AMD now in Indian branded PCs ■ Bug found in Intel Itanium processor ■ The cost of a pirated version of Windows XP in

snapshot

Source: www.internetindicators.com

ILLUSTRATION: Mahesh Benkar
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Micro-fans devel-
oped at Purdue
University,

Indiana, could help in
developing smaller and
faster laptops and let manu-
facturers stash in more
chips in devices than are
currently possible. These
fans, say the engineers, imi-
tate the motion of a
Chinese fan. These micro-

fans have polyester or even
metal blades, which are
“attached to tiny patches of
piezoelectric ceramic”.
When an alternating cur-
rent is applied, the ceramic
expands and contracts and
the blades move back and
forth like a Chinese fan.
However, there is scepticism
that the airflow achieved by
a ceramic fan will not cool

a chip satisfactorily. But
they could be put to work
in combination with rota-
tional fans especially in
spaces that are not reached
by the latter. Engineers also
claim that the piezoelectric
fans consume far less power
as compared to a rotational
fan. Interestingly, being
noiseless, they can also be
used in cell phones.

“I’m in a harry”
You’re a goner if your PC’s
managed to get this one.
Goner is a powerful new
Windows computer virus
busy wreaking havoc and
affecting over 17 countries,
out of which the US, the UK
and France have been the
worst affected. The e-mail is
named ‘Hi’ with a message
that reads, “How are you?
When I saw this screensaver I
immediately thought of you.
I’m in a harry (sic). I promise
you’ll love it.” It has an
attachment called
‘Gone.scr’, a screensaver
which displays a small dialog
box which fools the user into
believing that a program is
running, while in the back-
ground, the system files are
being deleted. The e-mail
sends itself to the addresses
in the Outlook Address Book.
Goner can even disable anti-
virus software in a computer.
Watch out.

Patch work 
Microsoft has released a
security patch for Internet
Explorer 5.5 and 6.0 to plug
a hole that could allow hack-
ers to steal passwords and
trick people into download-
ing virulent files. The patch
eliminates a wide range of
previously known security
problems and plugs three
new holes. One problem
affecting only IE 6.0, allows
an attacker to alter HTML
information in a way as to
trick IE to open a damaging
executable file without ask-
ing the person for confirma-
tion. Another bug allows the
hacker to gather personal
information from the local
system. A hacker could read,
but not change, any file on
the computer user’s system
that can be opened in a
browser window.

redalert

Thailand:$2.70  ■ nVidia employees accused of insider trading ■ Microsoft officially launches Xbox ■ Java-based phones making presence felt in Asia ■ Bleem shuts down 

Cool for laptops

ASilicon Valley start-up
will try to popularise
one of the more

intriguing ideas of our time:
three-dimensional semicon-
ductors. 

California-based Matrix
has received strategic funding
from Sony, Eastman Kodak
and Microsoft, to release
memory chips that contain
many more layers of circuitry
than ordinary chips. As a
result, Matrix’ chips resemble
microscopic cubes rather
than two-dimensional planes.

The chips will apparently
incorporate some design
techniques taken from digital
flat panels. Matrix has bor-
rowed many of its concepts
for building vertical chips
from the flat-panel display
industry, which has perfected
the art of mass-producing lay-
ered silicon films. The chips
will be built using many

more layers of circuitry than
current chips and as a result,
resemble microscopic cubes
instead of the existing chips
which are much flatter. 

The chips will be substan-
tially smaller than competing
products. Matrix claims that
their technique will allow
them to produce 64 MB flash
memory cards that would sell
for around $10 (current 64
MB cards cost $38). 

It seems likely we will see
these chips in devices rela-
tively soon, considering the
fact that Toshiba, Sony and
Eastman Kodak are among
the investors. 

The transition to three
dimensinal chips is driven
primarily out of a fear that
Moore’s Law will hit a wall.
Designers will have to come
up with other ways to allow
chips to continue to become
more powerful.

Mailing station
How do you send e-mail
without a PC? It’s simple. You
take a certain device, plug it
in any telephone jack and
send and retrieve e-mail from
your account. This device, for

which you have to pay 
Rs 5,990, is called an iStation
and is manufactured by
iNabling Technologies from
Bangalore. If you want to
print an e-mail, plug iStation
in a printer and fire the print;
You can even send mail in
your native language. The
iStation weighs 770 grams
and comes equipped with a
256 KB capacity, an in-built
modem, and a backlit LCD.

It’s available in two mod-
els: Premier P1001 (Rs
5,990) and Classic C1001 (Rs
7,990). The Classic model
has a printer and a PC port.
iStation permits up to five
users to use a single unit,
each having their own pri-
vate e-mail IDs.

beindian



16 JANUARY 2002

pulse ■
■ news

■ Sun pushes UltraSparcIII to over 1 GHz  ■ ATi A3 Athlon XP chipset revealed ■ Windows XP causes Intel mobile chips to overheat ■ Palm to replace buggy devices 

statattack

Here’s good news for
those born without
thumbs or have lost

them in accidents. Students
in Singapore have developed
a battery-free artificial gadget
made of aluminum that acts

as a substitute for a missing
thumb.

The device, called
‘Mimic’, is small, lightweight
and straps onto the back of
the hand and wraps round
the index finger to hold a
moveable metal thumb in
place. This metal thumb
mimics the forefinger and
moves whenever the forefin-
ger moves. Two small pulleys
and a fine steel cable keep
the forefinger’s movements
in sync with the metal
thumb. This device even
allows a person to write and
pick up small objects.

The prototype will be
available at just 100 Singa-
pore dollars. But it isn’t an
off-the shelf product. Each
piece will have to be custom
made to fit the wearer’s hand.

Thumbelina Bluetooth 
going gold
Despite a slow start and months
of stagnancy, Bluetooth is finally
poised to take off.  The wireless
networking technology  that is
designed to replace cables that
connect devices is beginning to
reach critical mass.  A growing
number of products already on
the market and those set for
release next year are bringing
back the hope Bluetooth once
had. Market researcher
Dataquest predicts that demand
for Bluetooth this year will result
in the shipment of about 4 mil-
lion chipsets. The company 
predicts shipments will rise to
36 million in 2002 and 186 mil-
lion in 2003.

Kids online: What are they doing?

Internet-related jobs: Not just in IT
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Shr(i)ek!

The Shrek DVD features a
first-ever ‘U-Dub-It’ fea-

ture that allows users to dub
their own voice in place of
any of the characters and 12
additional DVD-ROM games.
Shrek’s ReVoice Studio uses
technology that lets the
viewer become the actor.
The program enables viewers
to select from 12 of the film’s
most popular scenes and
record the lines of the char-
acters. It then syncs up
their voice with the charac-
ter’s mouth. As you read
the on-screen script into a
microphone the program
automatically synchronises
your voice with the lip
movements of the charac-
ter you have chosen to
play. It’s a bit like Karaoke,
only better.

heroes

zeroes

Windows XP
■ Microsoft finally delivers a
stable, user-friendly OS
Castle Wolfenstein 
■ The 3D game is back in a
new avatar and  takes the
market by storm
VIA 
■ Court case against Intel
won. Expect DDR-based
motherboard chipsets for
Pentium 4

iPAQ
■ Sales of iPAQ shrivelled
from 450,000 to 185,000
as users waited for Pocket
PC 2002
Domain Name 
Lottery
■ .biz staggers as
NueLevel, the company
responsible for
introducing the Internet
address, fights a lawsuit
for playing illegal lottery
for contested names
Excite
■ Excite UK shuts down
the UK operations after
funding falls short

Send Me Some
Are you lost? Don’t worry. You
can nowadays SMS your way
out of almost anything. Using a
combination of Ericsson’s
Mobile Positioning System
(MPS), Ericsson’s SMS Gateway
and AutoDesk Inc’s Location-
Logic, text-messaging can now
pinpoint a user’s location.

The first location-based
text-messaging services will lay
the foundation for more data-
rich services. Using these servic-
es, mobile operators will be
able to offer advanced versions
of SMS such as EMS (Extended
Message Service) and MMS
(Multimedia Messaging Ser-
vice). 

These messaging services
will allow the system to attach
images, such as maps, to the
reply message without upgrad-
ing their entire network infra-
structure. So hopefully you’ll be
carrying your mobile with you
the next time you are lost.  

INFOGRAPHICS: Solomon Lewis
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■ Legal music service PressPlay to allow its music to be burned on CD ■ PlayStation 2 leads holiday sales in US with 1.4  million units sold, Microsoft’s Xbox

It took more than a year of
intense speculation and media
hype to arrive. When it finally
got here, it looked a lot like a
slick scooter you strap on your
feet. The scooter-like ‘Segway
Human Transporter’, a revolu-
tionary, self-balancing person-
al transportation device using
an electric engine to propel
passengers at 12 miles per
hour, was recently unveiled by
an ‘inventrepreneur’. 

The inventor, Kamen,

who’s called this
device Ginger after
the actress Ginger
Rogers (he had named
it Fred earlier), has used
a technology called
‘Dynamic Stabilisation’
that’s designed to sim-
ulate the way the
human body moves.
Dynamic Stabilisa-
tion is achieved by
using gyroscopes
and tilt sensors

that monitor the rider’s centre
of gravity 100 times per second. 

Ginger is driven by body
movements; it moves when
you lean forward and backs up
when you lean back. The
device is about the same size as
the average human body and
can go anywhere where a man
can walk. 

Kamen, the chairman and
chief executive officer

of  Segway LLC, says
they plan to sell
Ginger starting late
2002. The company

will manufacture

three initial models of the
device—the i, e and p-series.
The i-series will be designed for
range and speed across differ-
ent terrains, the  e-series will
focus on business applications
and will haul up to 75 pounds
beyond the rider’s body weight,
and the p-series will target the
densely populated areas. 

The potential this device
wields is enormous, for the
ordinary masses as well as the
disabled, but cost and mass
manufacturing remain major
hurdles. Ginger will retail at
$3,000 (approx. Rs 1,44,000).

Gingerly there
tomorrow’stechnology

Sudden infant death syn-
drome (SIDS) is the sin-
gle biggest killer of

infants under one year in
developed countries. Belgian
researchers are hoping that a
baby suit or pyjamas based
on space technology may
help save the lives of the 
little ones. 

The prototype pyjamas
include five sensors built into
the fabric that will monitor
the baby’s breathing and
heartbeat. The sensors 
are connected to a small

detection unit that triggers an
alarm if it detects any abnor-
malities. Further, the sensors
have no direct contact with
the  skin, thus minimising

any discomfort to the
child.

Verhaert
(www.verhaert.com), a
European systems
development group
which developed the
underlying technolo-
gy, says that exten-
sive trials in Portugal
and Germany have

yielded encouraging results
and the medical communi-
ty’s feedback has been posi-
tive. These suits are slated to
hit the market in 18 months.

Life-saving pyjamas

The Japanese electronics
maker, Sharp, has recently
unveiled a retail ver-
sion of its Linux-
based PDA, Zaurus,
which it plans to make
available in the US
early next year. The
commercial version,
renamed the Zaurus SL-
5500, features a small,
retractable
keyboard and two

expansion slots for Compact
Flash and Secure Digital cards.

Sharp currently sells the
Zaurus SL-5000D to
developers for $399
(approximately Rs
19,152) from its Web
site. The company is
looking to drum up
support among devel-
opers worldwide for
developing applica-
tions on the Zaurus.

Zaurus the Linux
Unconnectedness
If you plan to surf while flying
Boeing, you’ll have to wait.
Connexion, a project by Boeing
and its three partners (American
Airlines, Delta Air Lines, and
UAL’s United Airlines), had plans
to put high-speed Internet con-
nection on Boeing planes. The
plan has now been shelved.
Boeing’s partners pulled out of
the project following severe
losses as a result of the Septem-
ber 11 terrorist attacks. Plans
were to provide Internet servic-
es via satellite.

Internet 
semantics
Tim Berners-Lee, the inventor of
the World Wide Web, is a man
on a mission—to make the Web
smarter. He aims to weave a
Semantic Web that links docu-
ments to each other and recog-
nises the meaning of the infor-
mation in those documents.
Berners-Lee says that adding
semantics to the Web changes it
from being a publishing medi-
um to a medium where diverse
data can be interpreted and
exchanged. How many times
have you searched for a particu-
lar work and ended up with irrel-
evant search results? The Seman-
tic Web will change all that with
Semantic-enabled search agents
collecting machine-readable
data from diverse sources, pro-
cessing it, and inferring new
facts to give you what you want. 

70 %
of all Internet
users started
surfing the Web
in 1998
(Gartner)

Web documents
can be accessed
by Google any
minute

3
billion

metrics

➜
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Mobile Britney
Ditch the long queues for tickets
or even the mosh-pits and stam-
pedes at a concert. Hear your
favourite artiste on your cell
phone. JCOR Wireless, a unit of
JCOR Entertainment, has signed

a deal with Britney Spears, Justin
Timberlake of N’SYNC, rapper
Jay-Z and other musicians to
develop a wireless system that
uses a combination of music,
voice messages and text-based
data to deliver a real-time enter-
tainment experience.
JCOR says it will market its wire-
less entertainment system to
wireless operators, handset mak-
ers and retailers and plans to roll
out its wireless entertainment
offerings in the first half of
2002. Meanwhile Britney waits. 

Tour White House
To make up for the disappoint-
ment caused by the cancellation
of its popular holiday season 
tours for security reasons after the
September 11 tragedy, 
the White House is offering the
public a 360-degree tour of six of
its rooms through its Web site
www.whitehouse.gov. All these
rooms have been lavishly deco-
rated for the holidays. 
Click on the links to photographs
of the rooms and scroll around to
see the entire room, and zoom in
on decorated trees and paintings.

Hear a good number at a
place but miss the name

of the song? Philips Electron-
ics is devising a new technique
called Audio Fingerprinting.
The technology allows you to
get not just a track’s title but
the artiste and album as well.
And all this within a few sec-
onds. 

Audio Fingerprinting works
by holding a mobile phone to a
radio’s speaker for three sec-

onds, which is
long enough to
record a digital fin-
gerprint.  The cell
phone then sends

the fingerprint to a database
server to lookup for matches.
In four seconds, a message on
the cell phone window pops up
presenting the user with full
information about the song,
artiste, and so on. The technol-
ogy is based upon a calculation

process involving a song’s
tempo, pitch and dynamics. 

If this technology flies cor-
recly, its usage could be more
mainstream. For example, an
ISP could offer services to cus-
tomers who download MP3s to
assist them in organising their
music collection in their PC.
Agencies of the recording
industry can use this to identify
and organise which songs are
being played on radio.

AUDIO FINGERPRINTING

Bruce Lee’s legacy is not
over yet. Chul Shin, a
South Korean filmmaker, is
planning to cast him in the

starring role in his next film. Never
mind that Lee passed away in 1973. A
$50 million budget will allow Lee’s
image to be digitally recreated in the
leading role in Dragon Warrior, which will
be released in 2004. Shin spent four years
getting permission from Bruce Lee’s widow
and daughter to recreate him in a computer
animated movie. Now that he has their con-
sent, the star will be back with all his light-
ning fury. 

The digitally created Bruce Lee will be recreated
with live actors using an actor in a blue body sock
and capturing both film and 3D space
data to then overlay Lee’s rendered
visage. Shin promises the effects will
be better than Final Fantasy. The
advent of the digital actor is the
beginning of the loosening of the
stranglehold Hollywood has on
move making. We could potentially
see a transition of stardom from
actual people to the collaboration
of body actors, voice actors and
modellers/animators.

trails with 934,000 copies ■ Watermarking scheme designed for digital video to counter piracy ■ Online advertising market expected to recover by 
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Kicked about the cool features
of the iPod in the December
issue of Digit? If you’re dying
to check out the iPod, you
don’t need to spend a bomb
on a Mac. Refer to XPod, a
software being developed by
Mediafour, which will allow
Windows PCs to talk to iPods. 
It is in the pre-beta phase of
developing XPod, which will
allow FireWire-equipped Win-
dows PCs to interact with the
iPod (see www.mediafour.com
for more information). XPod
will be compatible with vari-
ous flavours of Windows,
from Windows 95 to XP, but
will need version 7.0 or later
of Microsoft’s Windows
Media Player (WMP). It may
have a Windows Explorer-
based interface for file

exchange in addition to plug-
in functionality for WMP, but
will not be able to transfer
Windows Media Audio
(WMA) to the iPod.

Meanwhile, here’s more
food for thought. Apple has
confirmed a glitch in the
iPod, which causes a small

percentage of the players to
temporarily not wake from
sleep when the battery
reaches low charge level.
Since there’s no way to tell
which iPoD players have the
problem, Apple recommends
that all iPod owners down-
load and install the update. 

For those facing the prob-
lem, Apple suggests they
make sure the hold switch is
not on. Next,connect the
unit to a power adapter or to
a Mac, and then try to reset
the device by holding down
the Menu and Play buttons
for 10 seconds. If this fails,
disconnect the unit from its
power source, let it sit uncon-
nected for 24 hours and then
reconnect to reset the
machine.

eventtracker

The next time you receive
an SMS on your Nokia phone,
you might want to be extra
careful. The message might just
‘freeze’ your phone, locking you
out. How is this possible? By
adapting a program sms_client,
which sends an SMS message
from an Internet-connected PC,
with a broken User Data Head-
er. Once the message is
received, it is impossible to turn
on an infected phone again
without somehow deleting the
offending message.

The Nokia models affected
by this vulnerability are the
Nokia 6210, 3310 and 3330.
Nokia claims that it has fixed
the flaw and that all phones
rolling out of its plants are now
secure. Users of older Nokia
phones, however, might need
to make a trip to that service
centre nearby.

BUGGEDPHONES

Want to watch a movie? All
you need to do is reach into
your wallet and unfold the
screen! A Dutch company,
Philips Research, claims to
have made a major improve-
ment in the development of
electronic display paper. This
e-paper display uses active-

matrix technology, the kind
used in good quality laptop
computer displays, and is
made of parts that use flexi-
ble plastic transistors instead
of silicon. If produced in
bulk, this is inexpensive to
make and works well enough
to constantly refresh a screen

to create moving images.
In addition, e-paper

would need lesser power, will
come in large sheets, offer
higher contrast so that
images are visible under vary-
ing lighting conditions, and
would be durable enough to
withstand regular use.

Paper future
“Despite what
everyone says, our
software is actual-
ly cheaper.”

LARRY ELLISON
Oracle CEO 
in a presentation at Oracle
OpenWorld on Microsoft and
IBM products being slower
and less secure as well as
more expensive than Oracle

Microsoft wasn’t stay-
ing quiet:

“It’s ironic to hear
Larry claim they are
price leaders in
anything.”

STAN SORENSEN,
Microsoft’s Director,
Enterprise Server Marketing

realitybites

followup: 
Two peas in a Pod

mid-2002 ■ China shuts down over 17,000 Internet bars for failing to block Web sites considered subversive or pornographic



Hi Chetan,
The Digit Zero1 Awards is our way of rewarding the
best products (on the basis of performance and fea-
tures) in the Indian market. These products are test-
ed by out Test Centre during the course of the year. We
considered every single product that we had reviewed
between January and December 2001. These products
were compared purely on the basis of performance
and the features offered. Our panel of reviewers came
up with a shortlist of three products in each category
from which a winner was chosen. Price was not a cri-
teria—performance was. The product with the best
absolute performance was adjudged the winner. Hope
this clarifies the Digit Test Process for you.

Fully contentHi Karan,
I decided to try out Digit magazine in Oman with your Novem-

ber issue. I was initially very reluctant to buy your magazine

because I thought it would be India-centric and because it cost

twice as much as the retail price here. 
Well, all I have to say is that I am very impressed! This maga-

zine is good enough to be confused with any international com-

puter magazine, as that policeman in the Digit Diary said last

time! Thanks.EDGAR SANZVia e-mail

Dear Edgar,
I am glad you enjoyed reading Digit. Your e-mail is an
affirmation that our attempts to make this a magazine
with world-class content have paid off.

Priced for piracy

Dear Karan,

Over the last three years or so since I bought my first PC, there’s been a lot of

change in the computer industry. Most of this change has been positive, from

my perspective as a PC user. Today I have a wider range of products to choose

from with awesome performance—I can’t begin to compare the performance

of my long discarded 2 MB PCI graphics card with the 32 MB GeForce2MX card

that I have now. Most importantly, the price of hardware has dropped enor-

mously which has made it more affordable for me. 

On the software side, however, things are not so rosy. New versions of soft-

ware seem to get more and more expensive without adding many additional

features. How is it that companies such as Microsoft continue to raise the prices

of their operating system and other software? As long as software vendors con-

tinue to display this kind of attitude they have no reason to complain about

piracy.

VARUN

Via e-mail

Dear Varun,
Pricing and piracy are not issues that can be linked together.
This is something that we often do to convince ourselves that
software companies are unjust, but the argument doesn’t really
hold any water.

While you are right when you say that software upgrades
seem to get more and more expensive, it is not incumbent upon
you to upgrade unless the additional features are worth paying
for. I am sure that this was something you considered before
upgrading to the GeForce graphics card that you’ve mentioned.

Piracy of software is more about the unwillingness to pay for
a product than it is about the price itself. Take the example of
software such as games. Unlike in the past, today buying a game
is pretty reasonable even in a country like India. That doesn’t
stop most people from ‘borrowing’ a friend’s game-pack and
making a copy for themselves. 

However, you do have an option. If you think that Microsoft
or any other vendor charges unreasonably, just switch to a free,
stable alternative—Linux. The best form of protest against
unreasonable pricing is to refuse to purchase it. Piracy is not a
justification.

Picking winnersHi,
Congratulations on the article ‘A Cut Above’ in your
December issue. I have always loved Digit because
of the hardware reviews and I think that you covered
every category of hardware in this story. I am
sure that I will be referring to this issue many
times in the future.I would like to know more about theprocess you followed in picking out thewinners. And lastly, are all of the prod-ucts mentioned in Digit still available forpurchase?

CHETAN
Via e-mail

Dear Savio,
Agent 001 wishes to remain incognito so that he is free
to investigate without being recognised. Also, since he’s
constantly on the move, gathering the latest bit of infor-
mation that he needs for Undercover, we’d be unable to
provide you with a contact address. If you would like to
ask a question about which products to buy please
address your e-mail to readersletters@jasubhai.com and
we’ll be sure to pass it on. Who know’s? Perhaps next
month’s Undercover will answer your question.

Calling Agent 001Hi,
I have been reading your magazine for almost
one year and wait eagerly for its arrival every
month. My favourite section is Undercover,
which I like because of the insider market infor-
mation that it provides. How can I contact
Agent 001 with my queries?SAVIO

Via e-mail
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Short Bytes

Forum for us
Dear Karan,
Please start a reader’s forum
on your Web site which will
allow members to get infor-
mation on the forthcoming
issue.
ANSHUL CHAURASIA
Via e-mail

Hi Anshul,
You can get a peek at what’s
going to be in Digit next
month on page 139 inside
this issue.  Look out for this
preview page every month.
As part of our new year cel-
ebrations we have a new
Web site that includes a
new online forum. 

Visit us at www.thinkdig-
it.com to find answers to
your questions on comput-
ing.

If you have suggestions on
how to make Digit better,
come participate in the reader
survey at
http://www.thinkdigit.com/su
rvey/betterdigit

■■ Muddle-ware. That’s
what the December
2001 Mindware CD
turned out to be. As
Shashi Bhushan points
out, the questions and
answers of the Trou-
bleshooting FAQs don’t
match.

Our apologies for
what is clearly an error
on our part. The com-
plete CD-RW FAQs can
be downloaded from
our Web site at  HYPER-
LINK
“http://www.thinkdig-
it.com/cdrwfaqs.rtf” 

Notice any goof-ups? Write
to goof@jasubhai.com

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200;  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Change for the better

Hi Karan,

I have been your subscriber for the past three years. During the last year or so the focus of your

magazine has really changed. You have previously justified this shift as your response to chang-

ing times. However, I became your subscriber because yours was a computer magazine. And I

expect it to focus on computers. I distinctly remember the time that I used to read practically

every page of every issue. Now I find myself skipping some articles because I have no interest

in them. 

Also I don’t think that giving two CDs with every issue has made a considerable difference

to the CD content. I think you need to review some of the changes that you have made.

BIPIN BORKAR

Via e-mail

Dear Bipin,
Computing has remained the primary focus of Digit despite the changes in
the magazine during the past year. Consider for a moment the last few
issues—the Smart Buyer’s issue in October, the Web Awards in November and
the Zero1 Awards special issue in December 2001. All of these are computing
issues.

However, beginning from this New Year issue, the emphasis on computing
is going to be increased further. You will find that 65 of the 90 editorial pages
(over 70%) in this issue are completely devoted to computing. Many of the
other pages also include news and stories on computing.

Goof Ups
Digit v2.2?Dear Digit,

Last January, you gave us a completely new
magazine with two brand new cover CDs.
What can we expect in January 2002? :- )
KAPIL
Via e-mail

Dear Kapil,
Traditionally, at the beginning of every year we incorporate changes in our maga-
zine based on the feedback we receive from our readers worldwide. While
doing this, we keep in mind the changes that are taking place
in computing and technology and at the same time
retain the qualities that are inherent to us.

Digit will be accompanied by two interac-
tive cover CDs that will contain video work-
shops, the latest downloads, freshest demos, MP3s,
and much more.

In the magazine you can look forward to a modified
content structure that will contain more computing
workshops and insights. We have also introduced a gaming
section and are moving towards solution-oriented product comparison tests. Why
are we doing this? Because we know all these changes will make reading Digit an
even more enjoyable experience.
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What drives

technology to develop

faster and more

powerful processors? 

SSppeeeedd  SSppiirraall  
They said it couldn’t be done, but we’re

doing it. For years, I’ve heard industry
observers say we’re running out of time
before today’s technology impedes our

progress. Technological change and progress is a
bit like the chicken and the egg situation. Does
the industry create the need or satisfy it? Before
Sony developed the ‘Walkman’, no customer
around the world had articulated the need for
portable music. Customers didn’t see the need for
mobile phones either. Successful technologists
and marketers around the world are futurists of

sorts. They forecast and predict needs and the
ones who do well consistently emerge as leaders.

Ever so often when we deliver faster proces-
sors or launch a new generationof devices, it
meets with the pessimist’s refrain of, “Who
needs one?”. The simple answer is “The con-
sumer”. The PC does a lot of things in our life
now, from being an answering machine and
gaming station to performing complex 3D ani-
mation and video editing, and delivering
immersive Internet experiences. 

In case you haven’t noticed, computer tech-
nology gets more sophisticated by the month.
Ten years ago, we had 100 MHz chips in com-
puters used as servers, while today a server would
demand no less than 10 times of that processing
power. On the outset, there is something amiss.
We have a computer that requires at least 1 GHz
processor just to qualify being called a server yet
a decade ago, an outfit with one-tenth the power
was looked upon equally. Why this need to
develop faster and more powerful hardware? 

Since the birth of the PC 20 years ago, soft-
ware architects have been developing applica-
tions to fully exploit the potential of computers,
and at the same time, making them easier to use.
As the programs that drive your PC become
sophisticated and more powerful, they need an
adequate infrastructure to run on. This phe-
nomenon, whereby software drives the need for
high performance hardware, is called the ‘soft-
ware spiral’.  

The level of technology that we are at today
should satisfy the needs of most users. PC own-
ers do not need high-end machines to perform

simple tasks like word processing, Internet surf-
ing and e-mailing. But once we reach a surplus
on computing power, we will have to figure out
how we can actually utilise this big pool of
excess resources.

On the horizon, a new influence is set to
have an impact on the direction and the rate at
which technology escalates. From the software
spiral of the past and the present, a new gener-
ation of digital devices will provide some heavy
guidance in the work that lies ahead. 

The ‘digital spiral’ is an offshoot of what I’d

mentioned earlier, but rather than software 
leading the direction of change, current and
upcoming advances in the area of digital devices
will mould our development efforts. Imagine
using your computer to make music, not digital
music, but music in the real sense with people,
instruments and emotions—imagine your PC as
a professional recording studio. 

PCs of the future will create some terrific
special-effects movies that haven’t been pro-
duced yet. Post-production activities such as
voice dubbing and editing will bloom into per-
fection. And then imagine doing all this on a
PC that costs Rs 30,000.

Mobile computing is gaining strong momen-
tum and in 2003, Banias (codename for our
upcoming mobile processor) will make its pres-
ence felt for notebook computers worldwide.
Banias’ ability to conserve power much more
efficiently than the SpeedStep technology found
in mobile Pentium III processors is amazing. Very
soon, once we’ve optimised chips to preserve
more power, the potential will become limitless.

It’s obvious that we have our work cut out.
Though the task is challenging, I am optimistic
that Intel will be very successful at meeting and
accomplishing the challenges. We already have
a working Pentium 4 sample operating at 3.5
GHz. If you think that’s fast, you’ll be further
impressed once we start churning out proces-
sors running at tens of gigahertz—all of this and
more within the next 10 years. 

As narrated to Prashant Masrani. Avtar Saini, is
director, South Asia, Intel Asia Electronics, Inc

Digital devices, not software, will herald the next change...“ ”
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W
hile all original creations of the human spirit are unpredictable,
technology is especially more so. Businesses have been rather busy
learning this painful lesson of unpredictability.

Technology also has two sides. Cloning, some say, is wrong, but
nanotechnology is not wrong; Napster might have been labelled
bad, P2P most certainly is not. Rich nations are accused of over-
spending, does this mean they should stop all progress in robot-
ics and extra-terrestrial intelligence? What about managing your
digital assets, what about miniaturisation, what about what’s in
your genes?

Science is changing the world by the minute, but how much is the
world accepting the change? We have to first know where we’re head-
ed. Here’s where. Ten technologies your business can’t do without.

PRASHANT MASRANI

on

10
to 
bet
yourbusiness

Technologies
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Miniaturisation~Small is in

Microsoft advocates the Tablet PC as the next small
thing. Casio offers a number of computing functions
in a wrist watch. Body implants can record a number
of human functions. Growing popularity of the sci-
ence of embedded chips using nanotechnology means
that any device, however small it is, will be a comput-
er at heart. New devices will contain integrated cir-
cuits a billion times smaller than today’s chips, and
yet be many times faster. The fusion of computers,
networks and intelligent systems with nanotechnolo-
gy will change the way business is done. It will give a
whole new meaning to manufacturing. The knowl-
edge involved in manipulating atoms and molecules
with atomic level accuracy will define how manufac-
turers construct, distribute and duplicate substances
known to man. 

Optical Fibre~
Speeding things up
Fibre optic will change all notions of
network speeds and make broadband a
reality. 

Fibre optic technology is already
used in telephone infrastructure and
undersea data links. The future will see
fibre optics in the internal data paths
of a computer mainboard enabling PCs
to run faster and cooler. With wide-
spread installation of fibre optic net-
works, the resulting surge in band-
width availability will see a deviation
in the way industries communicate.
Video conferencing is one long-awaited
tool that will emerge with a more
extensive coverage of people. Once the
proper infrastructure is in place, bil-
lions around the world will have access
to this form of communication. Higher
speeds have a direct correlation to
time, and time saved is money saved.

Wireless and Mobile Technology~Instant
access
802.11b, the next iteration of 802.11, promises 54 Mbps speeds
(bettering the present standard by a factor of five) and addresses
the security concerns in wireless transmission. 802.11b-based prod-
ucts are already out in the market and should see large-scale
deployment by next year. 
Portable devices such as cell phones and PDAs are just beginning to
scratch the surface in mobile content delivery. The third-generation
(3G) networks not only seek to unify the different mobile standards
(GSM, GPRS, etc), but offer speeds ranging from 144 Kbps to 2
Mbps. Reaching out to those that are unwired enables businesses to
widen their potential customer base. The wireless application plat-
form has seen software developers queuing up to cash in on a
multi-billion dollar industry.

1

4
3

Unified Messaging~Speak my
stuff
Natural Language Processing (NLP) is the stuff
science fiction is made of—the ability of
humans and machines to chat with each
other like friends, with the machines display-
ing the ability to understand, analyse and
generate articulate speech. While NLP is still a
technology of the future, small measures are
evident in the implementation of Voice over
IP (VoIP) and speech recognition. VoIP
enables conversation (or a video conference)
using your instant messenger with another
person on a traditional telephone line.
Unified Messaging will consolidate VoIP, NLP
and several other technologies to integrate
different forms of communication (voice, fax,
electronic transmission) and make them
accessible from a variety of devices. For exam-
ple, you can use a telephone system to call in
to your office and log in to your e-mail
account and have the messages read out using
text to speech conversion. In a nutshell, uni-
fied messaging will lead to a reduction in
costs as all forms of communication travel
over data-networks.

2
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XML (eXtensible Markup
Language) is slowly becoming 
the language standard on the
Web. XML is not only platform
independent, but it can also con-
sist of various logical templates
describing how to send and char-
acterise the data. XML can be
seen as a major tool for the
domain of knowledge manage-
ment or document management
systems, especially in coding and
passing content from various

sources or file formats into one
entity. 

Since XML also stores raw
data in addition to defining it, it
currently has the potential to
replace databases, in some
instances, while retaining the
ability to create dynamic Web
sites. High-end tools are not yet
available for XML data manage-
ment and manipulation; that job
is currently reserved for high-
powered databases.

Based on Unicode, XML pro-
vides global language support,
which could literally turn itself
into a tool to enable cross-coun-
try commerce. One of the biggest
complaints emerging from e-com-
merce is the inconsistency of lan-
guage platforms and the inability
to send and receive compatible
data across servers. XML over-
comes this by forcing together a
set of standards and ensuring
tranparency. 

XML~Exchange of data7

Napster has gone down as
one of the most popular
music sharing hubs in
recent history. What made
P2P so popular was not the
notion of getting music for
nothing, but P2P’s ability
to let the masses share and
communicate without a
central authority to inter-
vene. While the RIAA
viewed it as a music piracy
racket, businesses see P2P
as collaborative growth.
P2P essentially allows
bypassing large networks
or centralised servers and
connecting directly with
other computers. This con-
cept is not new, and more
people are now discovering
the potential of this tech-
nology. 

While movies and
music seem the logical use
for P2P, the scope in the
office space is also quite
vast. P2P can help in 
collaboration tools that
include e-mail, whiteboards,
calendar, and so on.

Some of this is already
evident in Groove, a soft-
ware that’s still in the beta
stage. Project JXTA of Sun
Microsystems is a collec-
tion of low-level protocols
for building peer-to-peer
applications. The emphasis
is on grouping nodes
together so that people can
talk in small groups; pip-
ing, so the output of one
service or node can reach
another service; and meter-
ing and monitoring. 

P2P~Peering into the future

Biometrics~All in the genes
The study of discernible biological charac-
teristics is at the heart of Biometric
research. From retinal scans to fingerprint
verification, Biometrics is difficult to fool
as it scrutinises aspects that are unique to
each of us. With Biometric technology, you
are your own password. Companies are
turning to Biometrics to enhance their user
verification systems and maintain a high
level of customer service. E-commerce is
another area that will benefit hugely from
this form of identification. Biometrics
could symbolise a whole new way of con-
ducting payment transfers and at the same
time save on the cost involved in servicing
fraudulent orders. By 2003, the global pool
of Biometric systems will encompass a good
number of wealthy and medium sized
enterprises. By 2005, consumers will begin
to experience Biometrics on a much wider
scale.

6
5
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Robotics~
Extra-terrestrial intelligence 
Artificial Intelligence and wireless
technologies have evolved ‘smart
robots’ that can communicate with
each other and also be controlled
from remote access. A doctor can use
robots to perform surgical operations
and control the movements from a
distant location or using augmented
reality to derive more information
from the surrounding environment.
Smart robots, which are very capable,
are now being used for underwater
explorations and research in haz-
ardous areas. At the same time, robots
are the new age entertainment
devices, jumping around and aping
human movements. Apart from the
obvious use in mass-production,
robots will help businesses for
research purposes, act as a help for
many household chores, and do more
than just play with kids. 

Web services~Go online
Gartner forecasts that by 2003, Web services will occupy over 75 per cent of
the Web server space.

Web services allow various applications to work together using similar
data formats. Businesses can quickly translate these advantages into auto-
mated services that allow for closer and tighter relationships with various
trading partners and customers by sharing information even if their plat-
forms are different.

ASPs will enable use of software installed on some application server,
remote monitoring of networks, etc. Web services have the potential to
communicate across applications; they can cross over the bounds of hard-
ware as well. With Microsoft pushing .Net, integrated services will be the
order of the day. 

Digital Asset Management or DAM refers to efficient archiv-
ing, retrieving and distributing of information such as
images, multimedia, documents, etc. DAM ensures that the
information is not lost and also increases efficiency and
reduces costs due to easier access to information. Using
DAM, a media house can easily collate information on a
specific topic that has been generated internally over the
years. Many digital asset management tools also allow users
to access, update and manage image, audio, video and text
files from anywhere in the world using the Internet as a
connectivity tool. 

Digital Rights Management (DRM) is also made simple
with DAM systems. DRM allows creators of content (media
houses, music companies, movie studios, etc) the freedom
to protect their content against the Napster kind of attacks.
DRM encodes content and only registered users (either free
or on a payment basis) will get access to the content. Coun-
ters will monitor the number of times the content has been
accessed and payment systems will be built around that. 

10

Digital Asset Management~
Managing  Content
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Logitech’s Z560 
speaker system 

Boom Power 
Take the pictures off the walls! You
know you have some stomach-
crunching bass on your hands
when you have a heat sink in the
rear of the subwoofer. Logitech’s

new THX-certified, Z-560 speaker
system is a 4.1 surround sound,

five-piece system with 400 watts of
power. The subwoofer gets 188 watts

and each of the satellites gets 53 watts. Saying
that the system has ample power would be a
gross understatement! 

Web site:
www.logitech.com/cf/products/speakers.cfm

features ■
■ droolmaal
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Sony Cineza 

Perfectly Centered
The VPL-HS1, or Sony Cineza, is a

portable projector that offers a screen
size of 60 to 150 inches diagonally. The
Cineza home entertainment projector uses
‘SideShot digital keystone correction’, which

means that it can be placed at an angle to
the screen and still project images that are
centered on the screen. The Cineza accepts a

variety of inputs including video, DVD, computer 
games and PlayStation.

Web site: www.sony.com/cineza 

Gadgets to Die For
A sneak peek at the latest line-up of funky gizmos

➝

➝
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Y
ou have high dreams for your
child—software engineer,
high-profile programmer in
Microsoft or Oracle, inventor
of a language, etc. Charged,

you buy a PC and cram it with all kinds
of software, tutorials and encyclopaedia.
But your child shuns all your attempts
and does not spend more than a few min-
utes at the computer everyday. How do
you get him interested? 

Don’t force it! 
Making your kids love PCs is a lot like get-
ting them to read. Just make sure that you
arouse their innate curiosity. The rest will
happen soon. Operating systems have
become so user friendly that kids can use
them with just a little bit of guidance. The
best kind of education is one in which
kids learn while having fun. So, for a start,
liven up things with games and help your
child get comfortable about using the
computer. 

But that doesn’t mean you allow your
child to play a ‘blood-gore’ game such as
Quake, if he does his tutorial homework
first. Instead, get your child the right
games for his age. Anyone who has ever
played Where in the World is Carmen
Sandiego? would vouch for the educa-
tional features in this highly interesting
game. The game, with you as the detec-
tive, involves capturing the ace-thief Car-
men Sandiego, but before
that, you have to capture her
henchmen. You travel
through continents and
countries, and the clues test
your knowledge of history,
geography and culture. Car-
men Sandiego will get your

brat well-versed with the currency of
Rwanda and the colours of the flag of
Egypt. 

Puzzles, crosswords and word games
increase problem solving and compre-
hension skills. You can play Scrabble on
the computer too, while a game such as
Tetris will test their skill at understanding
blocks and placing them together. 

Multimedia magic
Kids love things in which they get to have
their say. This is where interactive pro-
grams such as multimedia software step
in. Multimedia programs involve chil-
dren and are a good way to excite their
interest in computers. There are many
programs available that teach basics such
as counting, maths, letters, spelling, etc,
through interactive tools. Many of these
are available as freeware or shareware. (For
a list of some of the hottest software for kids
under the age of 10, check out the box, ‘Kid-
die Software’.) 

If you have some money to spare,
choose a multimedia CD title suited to
your child’s age. Take care to select one
that matches your child’s aptitude. Let
him draw and colour pictures, and learn
basics such as the alphabet and counting
while playing the game. This will lay the
foundation.

Drawing for dummies
Children are attracted to big
dolls. Apart from the size,
there’s a visual attraction.
The same analogy can be
transferred to PCs and you
can start your child off on the
drawing path. A simple tool
such as MS Paint is enough

The Resource
For more 
Web sites and
game details,
visit

KKiidd-ssttuuffff??
KKiidd’’ss  ttoouugghh!!
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Spent thousands of rupees on the new PC and your child uses it only for
games? How to ensure that learning happens along with the fun…

features ■
■ firsthand
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for scribbling and filling with colour.
When your child gets used to it, get him
Discover Painting for Kids 1.0. This software
has colouring pages and basic-to-use ‘toy’
tools that are a lot of fun, and more
advanced tools that let create cool special
effects. These software will enhance the
visual comprehension of your child, apart
from giving him a sense of colours.

In addition, certain Web sites such as
Crayola (www.crayola.com/cardcreator/
index.cfm), Zeeks (www.zeeks.com) and
Berit’s Best (www.beritsbest.com) help cre-
ate greeting cards and other design mate-
rial. Expose your child to such sites and
watch as he sits glued to the PC.

Using the Web interactively 
If you have an Internet connection at
home, you can browse children’s Web sites
while sitting with your child at the PC, and
get him or her more interested in surfing.
Many Web sites feature online games for
colouring and spelling which your child
can play. You can, for example, make your
son learn recipes (and help you in the
kitchen), or your daughter learn acting. 

Once the kids get the hang of surfing
the Web, teach them how to use commu-
nication software such as e-mail. Let them
get used to e-mailing friends and relatives.
Undoubtedly, they will enjoy the pleas-
ure of communicating with others at
almost instantaneous speed. 

Hobby groups are another forum
where your kids can make friends and
interact with other kids worldwide 
who have similar interests. Many such
groups can be found at Yahooligans!
(www.yahooligans.com).

An early start
What do you think is the right time and

age for your kids to get started? The time
is now and here. As far as age is consid-
ered, there is no lower limit. You can start
off even when your kid is just a year old.
There are many programs which have
been designed for children this young.
Called ‘lapware’, the thing to look out for
in these programs is bright graphics. They
have to be responsive to any movement
on the keyboard and the mouse. For
example, if the images on the screen
change every time your child touches the
keyboard, he’d be more curious and inter-
ested. Point out these changes and talk to
him about them as they happen. If he
doesn’t seem interested in it, don’t force
him to do it. Save further explorations for
the next session.  

For older kids, you need to get more
advanced software. Encyclopedias are no
longer the brown leather-backed heavy-
weights that they used to be. They come
in a single CD or two nowadays and are
highly interactive with live animation to
ensure that kids don’t get bored while
using them. 

When you select such learning pack-
ages, always look at the content before
buying. Decide whether it’s suitable for
learning and also make sure that it’s fun
to use. The best way perhaps is to take
your child with you and let him or her
decide which one they want. This will
ensure that the CD doesn’t gather dust
in the corner.

Watch it!
Today’s computers are complete enter-
tainment modules in themselves. Teach
your child how to use PCs for entertain-
ment activities such as watching movies
and listening to music. Handling the 
PC in this manner will help drive away the
fears of using a PC from the child’s mind.

But again, while there is a whole lot
of useful things that can be done on the
PC, it’s easy to get lost there. Games are
important to get your child interested,
but not to the point of distraction.
While educational software that use
games to teach things are important, an
over indulgence in violent games such
as Quake isn’t what you need to encour-
age. An outright ban on such games is
not going to help. Limiting the time
spent on these games would make you a
better parent. 

ANIL PATRICK R.

Where in the World is Carmen Sandiego? is a
fun-filled detective game. This is part of a

series which helps
your child learn
geography, sci-
ence, mathemat-
ics, history, music,
and more. Chil-
dren learn about
various parts of
the world as they
chase Carmen

Sandiego and her V.I.L.E gang.
Other titles in the series are Carmen

Sandiego’s Great Chase Through Time, 
Carmen
Sandiego Word
Detective,
Where in the
USA is Carmen
Sandiego?, and
Carmen

Sandiego’s ThinkQuick Challenge. 
Ripley's Believe It or Not has a whole lot

of puzzles and games with a very interest-
ing interface.
It also has
multiplayer
playing
option for up
to four people
if your child
wants to play
it with you.

This game is guaranteed to keep your kid
(and you!) engrossed. 

JumpStart Languages is an excellent
educational game for teaching your child
foreign languages such as English, Spanish,
French and Japanese. This game is for kids
between three and six years of age, and it
teaches conversational phrases, words for
everyday objects, colours and numbers,
music and lyrics. 

Kiddie Games

A number of shareware and freeware
software are available on the Net (try
www.download.com). Some examples: 
Discover Painting for Kids 1.0: A
painting program with a colourful inter-
face and a very rich set of features 
123learn: Jungle Adventures 1.6:
Learn to identify animals and the
sounds they make
Dino Trilogy 4.0: Play memory, math,
and spelling games with dinosaurs
ABCs 1.0: Learn the alphabet
Kamishibai Viewer 1.06: Japanese art
of story-telling through cards

Kiddie Software

www.lycoszone.lycos.com
www.kidskhazana.com
www.funschool.com
www.disney.go.com
www.bbc.co.uk/littlekids
www.yahooligans.com
www.school.discovery.com
www.scoreone.com/kids_kitchen
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Monitor: Samsung Sync-
Master 240T
Maybe it’s fine to splurge on your PC’s display. What’s the point of that
top-of-the-line GeForce3 graphics card if all you have is a wimpy 15-inch
monitor? The massive, one-of-a-kind 24-inch display area of the

SyncMaster 240T is as good as it gets. With a
native resolution of 1920x1200, a
170 degree viewing angle, HDTV
compatibility and compact
design, it has everything that you
could ask for in obtaining com-

plete flaunt rights. Your movie and gaming
experience has never been as immersive!
www.samsungelectronics.com
Average cost: Rs 12,000 (for a 17-inch CRT
monitor)

Digital
Camera:
Canon EOS-1D
When it comes to being picture perfect,
the Canon EOS-1D captures everything it
sees with a whopping 4.15 megapixel
sensing element that allows it to capture
images with resolutions of up to
2496x1665. It also features 10 settings for
white balancing, colour temperature,
manual and autofocus, spot metering,
center weighted metering, etc. Burst
mode shooting allows the camera to cap-
ture up to 8 frames per second, making it
ideal for sports and capturing fast moving
events. Best of all, since this is an SLR

Toys of the
Rich and the Geeky

Rs 7,000
Keyboard: Logitech
Cordless Free-
dom Optical
keyboard
This keyboard sim-
ply sets you free—
you don’t even
have to be in the line
of sight of your desktop to
use it! Using wireless radio signals, con-
trolling different tasks and applications
becomes much easier. And best of all, it
looks like a spacecraft control panel! 
www.logitech.com
Average cost: Rs 500 for a keyboard

Mouse: Razer 
Boomslang 2000
Your mouse is no longer something with

just two buttons and a scroll wheel. When

thinking state-of-the-art mice, think Razer

Boomslang 2000! At a resolution of 2000

dpi this mouse is a gamer’s delight and is

almost five times as sensitive as a regular mouse.

The special low/wide profile design lends greater com-

fort and reduces wrist fatigue. With this baby in your hands, you are B. J. Blazkowicz!

www.razerzone.com
Average cost: Rs 600 (for a PS/2 scroll mouse)

Rs 8,000

R
s 

5,
00

,0
00

Rs 3,00,000

Rs 10 lakh for the peripherals of a home PC that costs Rs 2 lakh by itself! Are you nuts? 
Who in the world would ever pay that much for external components? Well, find out...
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When it comes to giving your PC the best
possible audio system, there are very few

full-fledged home speaker systems that even
come close to the Kilpsch ProMedia 5.1.
Boasting of a massive 500 Watts of RMS
power, you can bet on waking up your
neighbours! The special B.A.S.H. amplifier
delivers 200 Watts to the subwoofer, and 
60 Watts to each of the five satellite speak-
ers. With a THX certification, this speaker
system will let you hear everything crystal
clear, from the softest sigh to the loudest
concert you’ve ever heard!
www.klipsch.com
Average Cost: Rs 3,000 (for a four-channel
speaker system)

Logitech MOMO Force
This force feedback racing system gets you
as close to the race track and burning rub-
ber as possible! Designed by a company
known for conceptualising and producing

Formula 1 steering wheels, you can actually
feel the rush when you’re at the wheel of
your favourite racing simulation game. The
three-spoke wheel sports a solid look and
with its 270-degree turning angle, shifter
paddles and control buttons, you can con-
figure this device in a number of ways to feel
those bumps and rumbles. Best of all, you
don’t need a license to use this!
www.logitech.com
Average cost: Rs 4,500 (for a steering wheel
controller)

AKG K-1000
Headphones let you retreat into your own
personal space. These AKG K-1000 reference
headphones offer the most acoustically pure
experience for professionals and audiophiles.
They use a new transducer design known as
‘ear speakers’, where the speakers do not
actually touch the ears but are positioned
slightly away from them. This lets one ear lis-
ten to audio from the other speaker, creating
special depth, as is perceived in real life. This
is audio getting good, really good.
www.akg-acoustics.com
Average cost: Rs 5,000 (for a pair of average
studio headphones)

Speakers:
Klipsch ProMedia 5.1

camera, you can attach a variety of lenses
to the camera depending upon your appli-
cation. 
www.usa.canon.com
Average cost: Rs 60,000 (for an average
megapixel camera)

Photo printing never
looked so good, or so
big. This printer can
print on sheets up to
16x21 inch—from
postcards to posters.
Sporting a print resolu-
tion of 1440x720 dpi, this printer
with a four-colour print head is one of the
best solutions for colour printing. It has a
USB and parallel interface which makes it
versatile. The technology behind this
printer is a four-colour piezoelectric print
head, which is responsible for producing
very tiny ink drops to create detailed
colour printouts. If you’re looking for the
best in colour photo printing technology,
the Stylus Color 3000 is the one to pick.
www.epson.com
Average cost: Rs 10,000 (for a colour inkjet
printer)

Base System
COMPONENT PRICE
AMD Athlon XP 1900+  . . . . . . .16,000
512 MB SDRAM  . . . . . . . . . . . . .4,500
40GB IBM DeskStar 60GXP  . . . . .8,000
ASUS A7V266-E motherboard  . . .9,000
ASUS V8800 GeForce3 Deluxe 
graphics card  . . . . . . . . . . . . . .28,000
Pioneer 105SZ 16X DVD  . . . . . . .5,500
DVD-writer: Lacie DVD-R
FireWire External  . . . . . . . . . . . .70,000
SoundBlaster Live! 
Platinum 5.1 soundcard . . . . . . .16,000
Cabinet: Lian Li PC 626  . . . . . .30,000

Total  1,87,000

Peripherals
COMPONENT PRICE
Samsung SyncMaster 240T
monitor  . . . . . . . . . . . . . . . . . . .5,00,000 
Razer Boomslang 2000 mouse  . . . . .7,000
Logitech Cordless Freedom 
Optical keyboard  . . . . . . . . . . . . . .8,000
Logitech MOMO Force 
steering wheel  . . . . . . . . . . . . . . .18,000
Canon EOS-1D digital camera . . .3,00,000  
Klipsch ProMedia 5.1 speakers  . . . .50,000
AKG K-1000 headphone  . . . . . . . .30,000
Epson Stylus Color 3000 printer . . .65,000

Total  9,78,000

YOUR PC COSTS...

Rs 11,65,000

Rs 50,000

Rs 30,000
Rs 18,000

Printer:
Epson Stylus Color 3000

Rs 65,000

Steering Wheel:Headphones:
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The DMTRC: An information 
centre 
When it comes to insights into digital
products and technology, you should be
able to bank upon the best. That’s where
the Digital Media Test & Research Centre
(DMTRC) comes in. The DMTRC is the

central testing
resource for
Digit, the place
where we evalu-
ate the latest in
hardware, soft-
ware and tech-
nology, as seen
in the following
sections. These
tests and reviews
are in accor-
dance with the
most cutting-
edge evaluation
processes and

methodologies used around the world.
All this is done to help you make a more
calculated and informed choice on which
product or technology to adopt. 

Demystifying the ratings 
The DMTRC brings you hardware and soft-
ware product reviews in the Test Drive 
section of the magazine—as standalone

product reviews as well as comparison
tests. We test an assortment of hardware
and software products from the Indian
market, and the evaluation processes
involve parameters such as sheer perform-
ance, build quality, value for money and
the features of the product. A set of weigh-
tages are applied to these evaluation
parameters to arrive at an overall score.
The table given below is used in applying
the overall grades to these products based
upon the overall scores.

In the case of the comparison tests, the
weightages are applied to the various test
parameters according to their importance.
This is explained in the magazine articles
and in the Test Process section of the CD,
where the benchmarking methodology is
explained in detail.

About our Awards
Digit rewards exceptional performance in
each comparison test by picking a Best
Performance winner. This award goes to
the product that outshines the competi-
tion in our performance benchmarks. The
Best Value award, on the other hand, is
awarded to the product that we feel has
the best combination of price and per-
formance. Consider this your yardstick if
you are looking for more value for your
money.

How we Test

20-19.5

11-9.5

B-

A+
19-17.5

9-7.5    

C+

A

17-15.5

7-5.5

C

A-
15-13.5    

<5

C-

B+
13-11.5

B

VERDICTS

Excellent: a brilliant combination of price, performance and 
features, far beyond expectations
Good: a good buy, better than most products in its category
Average: reasonably competent but nothing spectacular about the
product
Mediocre: does not live up to expectations, needs improvement in
many areas
Poor: contains serious drawbacks and needs improvement before it
can be used for the target application

STAR RATINGS

This month, we bring you the best of
15 processors in our first ever proces-
sor comparison. Among the proces-
sors tested are the formidable AMD
Athlon XP processors, which are

based upon a new
Palomino core that
uses the newly incor-
porated PR indexes
of nomenclature.
We also got our
hands on Intel’s

brand new 0.13
micron-based Pentium

III Tualatin processors, sport-
ing higher clock speeds. 

Of special interest amongst stand-
alone tests in our Bazaar section (Page
68) is the Dell Precision 530 graphics
workstation. We used advanced
graphics and real-world rendering
applications to put this machine
through its paces.

What’s new?
Beginning with this issue of Digit, we
have moved to a new, more compre-
hensive set of tests and benchmark-
ing methodologies that examine
every nuance of the hardware and
software. Up first, we used a total of
15 individual benchmarking suites
and applications to evaluate the met-
tle of the processors under review.

Also new are detailed reviews of
the winning products and some of
the close contenders in the race for
the top spot.

In Test this Month

Marco D’Souza
HEAD, TEST CENTRE

There’s More on the CD 
Due to space limitations, we
carry full reviews of only the
top few products in the mag-

azine. You can find reviews of more prod-
ucts in the Test Drive section of our Mind-
ware CD. This is accompanied by the
detailed test and evaluation procedures
used in the processor comparison test. 
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ver tried working in Pho-
toshop on a 233 MHz processor? You
probably had to go watch a movie at a
theatre near you while your machine was
busy saving the file. Running more than
one application on a 233 MHz processor
was almost unthinkable.

Today, when your computer runs
many applications simultaneously, you
need some serious power. In answer to
this increasing demand for speed and
power, how do we push the performance
barriers? 

By changing the processor. 

But this is just the beginning. The per-
formance of a CPU is related to the way
your PC is configured. Yes, you will get a
performance jump when you upgrade or
buy a newer, faster processor, but to
achieve maximum utilisation, you have to
tweak it to perfection. To complicate mat-
ters further, there is a wide array of proces-
sor interfaces, RAM standards, formats,
chipsets and platforms to choose from.
PCs have moved from one standard to the
other so rapidly that today we have a jam-
boree of processors with no common de
facto standard or platform—in some cases,

Processo
How fast is fast? Very slow, if you take the pace at which
processors break speed barriers. We give you three simple facts
here: speed, power and price. It’s time to overclock!

IN TEST

AMD Athlon XP 1600+

AMD Athlon XP 1500+

AMD Athlon XP 1800+

AMD Duron 900 MHz 

AMD Athlon 1.13 GHz

Intel Celeron 1.2 GHz

Intel Celeron 800 MHz

15
PROCESSORS

PHOTOGRAPH: Mexy Xavier
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or 

Intel Pentium III 800 MHz

AMD Duron 1.1 GHz 

Intel Pentium 4 1.5 GHz

Intel Pentium 4 1.7 GHz

Intel Pentium 4 2 GHz

Intel Pentium III 700 MHz 

AMD Athlon 1.4 GHz 

Intel Pentium III 1.13 GHz 

for even the same family of processors. For
starters, consider this: a motherboard that
supports the Pentium 4, 1.8 GHz may not
support the Pentium 4, 2 GHz and above.

Buying a processor earlier used to be
fairly simple. There was a fast version and
then there was an even faster version of a
similar processor. You would get increased
performance every step of the way. 

Things are no longer that simple.
Though modern day processors can be
clocked at 2 GHz or more, there is a lot
more to performance than the clock
speed. Today we find a wide variety of

processors with variations in architecture,
supporting technologies, pricing struc-
tures and, most importantly, real-world
performance.

Confused already? That’s why we
tested 15 of the latest processors available
in the market and untangled the 
intricacies of getting the maximum per-
formance out of the processor you
already have.

Synthetically the fastest
Ideally, depending on your requirements,
you would want the fastest processor. But

(Power)
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the fastest processor is not necessarily the
one with the highest clock speed. 

In a real-world environment, it’s
very difficult to say that a given proces-
sor is absolutely the fastest. Even with
the same hardware, one processor may
outshine the other depending on the
applications in use and how it uses the
processor instructions or the operating
system. That’s why a synthetic test (syn-
thetic as in not being real-world) such as
SiSoft Sandra is used to give a theoreti-
cal indication of how well the processor
performs. The CPU benchmark of the
test gives the performance indicators
using the Dhrystone and Whetstone
benchmarks. Dhrystone gives a result in
MIPS (millions of Instructions per 
second) whereas Whetstone gives us a
measure of the Floating Point Unit
(FPU) and the scores are given in terms
of MFLOPS (Millions FLoating OPera-
tions per Second). 

So, theoretically which is the fastest

CPU? Well, that depends on your appli-
cation because in the Dhrystone bench-
mark (refer Score board), the Athlon XP
1800+ churned out 4337 MIPS as
against 3909 MIPS for the Pentium 4, 
2 GHz. However, in the Whetstone
benchmark, the Pentium 4, 2 GHz
scored 2452 MFLOPS as against 2137
MFLOPS for the Athlon XP 1800+. This
indicates that, in theory, the Pentium 4
has more FPU strength than its Athlon
XP counterpart and that, in theory, it
will be faster when it comes to applica-
tions that are intensive in 3D rendering
and image processing applications such
as Photoshop.

Work on applications faster 
You know what’s theoretically faster, but
these MIPS and MFLOPS scores from
SiSoft Sandra are only indicative of the
kind of performance that you could
expect from each of these processors. If
you want to know which processors will

make your daily use applications such as
Word, Excel, Web authoring tools, etc
faster, then the Business WinStone 2001
benchmark and the Content Creation
Winstone 2001 test will tell you about it.
Both these benchmarks run a series of
applications such as an anti-virus suite,
WinZip, Excel, Word, Adobe Premiere 6.0,
Macromedia Director 8.5, and Macrome-
dia Dreamweaver UltraDev 4. All of these
are run in a scripted sequence and the
total time consumed in performing each
task is measured. The final score is a unit-
less performance index. 

An index of 40 for both these tests
should be considered a bare minimum
and a score below this should be consid-
ered as seriously low.

At the end of these tests, you will
have the answer to the critical question:
“How fast does this processor run ‘my’
application?” 

The point to keep in mind here is that
even if a certain processor takes only a
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The Indian processor market is not com-
pletely in sync with the international mar-
ket. As a result, you still find some ‘phased
out’ processors in the market.

This throws up an interesting scenario
where older processors may even compete
against faster processors in the same
price/performance bracket. An
example of this is the wide avail-
ability of the older Coppermine
series.

Keeping this in mind,
we classified the processors by
their positioning, based on 
the current price and the 
performance. 

Elite: This category includes the flagship
processors of each manufacturer—the Pen-
tium 4s and the Athlon XP.
Performance: This category exists purely
because of the transitional period that the
Indian processor market is currently under-
going. You’ll find the Athlons and the Pen-

tium IIIs battling it out here. 
Value: Here you will see the
scaled down versions of the

flagship models—the Durons and the
Celerons.
Memory interface and other key issues:
We used the fastest available memory solu-
tion, officially endorsed by the manufac-
turer for each family of processors. Hence,
all Pentium 4s were tested with the fastest
available RDRAM, whereas the AMD series
was tested with the fastest available DDR-
SDRAM (PC2100). The Pentium III was

tested with ordinary PC-133
SDRAM since it’s the fastest
‘official’ solution till date. 
For more information on the
benchmarks used, see Digit
CD Mindware.

Digit Test Process

“Pairing today’s processors
with yesterday’s technology
is criminal!”
Hatim Kantawalla,
Deputy Head, Test Centre, Jasubhai Digital Media

The first microprocessor 
(Intel 4004) made for Busicom,
a Japanese calculator 
manufacturer. 

1971

1974

Intel 8088 microprocessor
(2 MHz clock speed; the
brain of the first real per-
sonal computer, the Altair)

1982

Intel 80286 (the 286) with clock
speeds of 8 MHz, 10 MHz, and
12 MHz, handled software appli-
cations written for 8088

First Generation

Second Generation 1985

Intel 386/386DX: Contained
250,000 transistors and was the
first processor capable of handling
32-bit data lines. Speeds ranged
from 16 to 33 MHz.

1989

Intel 80486: This had the first
built-in math coprocessor. It
could handle GUI. AMD and
Cyrix came up with products.

Intel Pentium (P5/P54C): Intel changes the
nomenclature to Pentium. Over 3 million
transistors on the chip meant more high-
tech programs, better Internet experience
and more up time. AMD enters the fifth
generation with K5, arriving a year late and
at a lower clock speed than the Pentium.

1993

Third Generation

Fourth Generation Fifth Generation



few seconds more to perform a particular
task, it still amounts to fairly large idle
time if you add up all the extra seconds
your PC has taken to perform different
tasks. For instance, if a processor takes
only 3 or 4 seconds to run, say, Microsoft
Word, it would seem to be no big deal.
But if you add up all the extra seconds it
takes to perform tasks, it will amount to
some serious time you’d spend waiting
while doing the paste job from Excel 
to Word, or while zipping up large 
documents. 

In the Elite segment we found that in
most cases the Athlon XP series performs
far better than the Pentium 4. This clear-
ly shows that despite the fact that the
Athlon XP processors are slower ‘clock for
clock’ than the Pentium 4 series, in real-
world terms they perform more work in
the same number of CPU cycles. They
score better.

In some cases the Athlon (Thunder-
bird) even beat the Pentium 4 processor
and gave some serious competition to big
brother, the Athlon XP. The Thunderbird-
based Athlon 1.4 GHz scored 75.8 in Con-
tent Creation Winstone 2001, while the
Athlon XP 1600+ which also runs at 1.4
GHz internally, returned a score of 78.4.
This clearly indicates that the Palamino
core-based Athlon XP has been tweaked
to an extent. It is not just a simple switch

to the new naming convention without a
real gain in performance. 

Though the Athlon XP won by a fair
margin, it can be argued that once you
cross 70 in Content Creation Winstone
2001, there is little discernible difference
from one processor to the other. Never-
theless, the top-of-the-line Athlon XP
1800+ zipped past all the others with a
huge score of 81.6. This is a record of sorts
and no other processor we tested came
even close to this magical figure. In the
Business Winstone 2001 test, we discov-
ered a fairly close mix of results with all
the top contenders scoring within a cou-
ple of points of each other. 

In the performance segment, the Pen-
tium III 1.13 GHz (Tualatin) scored a
decent 63.7 in Content Creation Win-
stone 2001, whereas the other Pentium
IIIs scored in the range of the 40s. Even
here, the Athlon family continued to

impress with the Athlon 1.13 GHz scor-
ing a hefty 66.6. The results were more
interesting in the Business Winstone
2001 test as only the Athlon family could
maintain scores over 50. The Pentium III
1.13 GHz finished at 49.3. 

In the Value segment, the GigaHertz
variants of the Celeron and the Duron
showed respectable scores of 61.2 each in
Content Creation Winstone 2001. The
Celeron 1.2 GHz proved to be the saving
grace for the Celeron series as the Celeron
800 scored an extremely low 33.9 in the
Business Winstone 2001 test (the lowest
in this test). Celeron 1.2 GHz pummelled
the Duron 1.1 GHz by scoring 51.5 as
against the 45 in the Business Winstone
2001 test.

One thing visible in these tests was
that the GigaHertz variants of all the
processors scored respectably well—if you
need to run only office applications and
tasks, any of these processors would fit
the bill.

The Pentium III 700 and the Celeron
800 suffered in both of these tests prima-
rily because of their low clock speeds. It
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The launch of the
Pentium II/III and
the K6 series from
AMD. The competi-
tion heats up.

1997

2000

AMD introduces the Athlon (K7),
follows it up with Thunderbird
which successfully competes
against the P-III. The battle now
moves to Intel’s (P7/Willamette)
Pentium 4 and the Athlon XP
(Palamino). 

32-bit processors: 32-bit represents the
width of the registers within the CPU
core. A register is rather like a holding
area for data. All the processors reviewed
in this comparison test are 32-bit.  
Bus: A set of lines used to move informa-
tion from one part of the computer to
another. Typically, a bus is divided into
three functional groups: data, address,
and control.  
Clock cycle: The basic unit of processor
activity. This refers to the speed at which
an integrated chip processes data. Every-
thing needs to be sequenced in comput-
ers and the clock speed determines how
fast all of this will be done.
FPU: Floating Point Unit handles calcula-
tions that use or produce non-integer
numbers. Instructions to be processed by
the FPU are known as the x87 set.
FSB: Front Side Bus is the external fre-
quency provided to the processor.
Instructions set: The set of rules that
tells the CPU what to do with each piece
of data it gets. All processors use the
basic x86 set as a starting block, but
each successively higher generation chip
utilises additional instructions. All
processors these days have extensions to
the fundamental rules that are used for
complex things such as video, audio and
mathematics. Intel calls theirs MMX and
SSE/2, whereas AMD have labeled theirs
as 3DNow! 
Multiplier: This number decides the core
internal frequency of the processor. For
example, a multiplier of 10 with the FSB
at 133 MHz will yield an internal core
frequency of 1330 MHz for 
the processor.
Transistor: A transistor is an electronic
switch. The speed at which a processor
can operate at is determined by how
quickly the transistors can switch
between their two states, which can be
increased by reducing their size and put-
ting more of them in the processor. 

To make smaller circuit sizes, the
transistors need to be made smaller too.
When we hear 0.18 micron fabrication
technology it primarily means that tran-
sistor gates etched on the silicon have a
dimension of only 0.18 microns. By
reducing this size one can physically etch
more transistors into the same piece of
silicon. 
Vcore: This is the operating voltage of
the CPU core.

Business Performance

Glossary

Sixth Generation



was interesting to observe that the Pen-
tium 4, 2 GHz could not beat the Athlon
XP 1800+ despite having 466 MHz extra
clock speed.

Even the 800 MHz processors will suf-
fice for Office applications, unless you
need to work with large chunks of data
and heavy files (such as Photoshop files)
on a regular basis. For the kind of appli-
cations and the kind of load that the aver-
age PC user puts the system through, the
higher clock speeds are wasted.

Gaming: Where speed counts
What’s the real reason behind processor
manufacturers increasing the speed limits
every few months? After all, how much
difference does it make if Word opens a

second faster or slower? For the proces-
sors today, running these day-to-day
applications is no sweat. Ask a gamer, and
he’d probably look at you askance and
reply: “Quake III”. 

Gaming and other entertainment
applications are probably the only 
applications that will show a marked
improvement in performance with
incremental increases in processor per-
formance and, as you will see in the test,

the scores vary enormously with
different processors and memory
architectures.

Most games run processors at
maximum throughput, pushing
and trying to extract every single
bit of performance. This also makes
them great indicators of system sta-
bility and your system will most
definitely crash if your processor
has heated beyond its safety limit.

If you are a power gamer and
want your gameplay to be of the
highest quality with the fastest

frame rates possible, you know where to
look again: The Pentium 4, 2 GHz blazed
ahead with a score of 314.1 fps in the nor-
mal mode benchmark of Quake III Arena,
which is considered to have one of the
most well-oiled gaming engines. The Pen-
tium 4, 2 GHz takes gaming to a level
where even if you’ve turned on all the
razzle-dazzle and razzmatazz, you will
still be able to play at a really fast frame
rate. The Athlon XP 1800+ was beaten
even by the Pentium 4, 1.7 GHz and
came in third with a score of 276.4 fps. 
In the texture-heavy Direct3D game 
Evolva, things were slightly different and
the Athlon XP 1800+ managed to edge 
ever so slightly ahead by scoring 148.2 
as against the 144 fps logged by the 
Pentium 4, 2 GHz. 

Another benchmark we ran was
3DMARK 2001, which is extremely per-
formance sensitive and scales higher the
minute you improve any of the subsys-
tems. Gaining even an extra 100 marks
in this test is very difficult. In this test,

the Athlon XP 1800+ scored 7060 as
against the 6960 3DMARKS logged by the
Pentium 4, 2 GHz. 

These three gaming tests indicate that
though the Athlon XP 1800+ will give
you a good performance in games based
on Direct3D (Evolva or Max Payne), you
will get a better performance with the
Pentium 4, 2 GHz when playing most
games, especially those based on the
Quake III engine, such as the newly
released Return to Castle Wolfenstein.

If you are not too concerned about
top-notch effects and are content with
decent playable frame rates, consider the
choices available in the performance cat-
egory of processors. In this segment there
was a discernible drop in performance in
all the gaming tests. Nevertheless, the
Athlon series held its own very well 
here, beating the Pentium III series in all
the tests. 

In the value segment there was an
even further drop in performance—by as
much as 100 fps in Quake III alone. 
In Quake III Arena the Duron 1.1 GHz
logged a decent 196 fps in normal mode
as against the 179.3 fps logged by 
the Celeron.

In this segment the 3DMARK 2001
scores dropped to under 6000 even
though these processors were paired with
the fastest graphics card around (nVidia
GeForce3 64 MB DDR). If you have a
casual interest in gaming then the Value
segment should fulfil your requirements.
However, keep in mind that using a high-
end graphics card with such a processor
would not serve any purpose.

The performance of the under 1 GHz
processors in the gaming tests clearly
shows that if you want an acceptable per-
formance in most modern games, you’d
be better off with a processor rated at 
1 GHz or more.

Multimedia performance
When Intel introduced the Pentium
MMX (Multimedia Extensions), it was for
the first time that you had processors
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The GigaHertz Wars
The battle lines were drawn between
AMD and Intel.
Round 1: March 2000
Athlon 1 GHz vs Pentium III 1 GHz
AMD released Athlon 1 GHz which had
the L2 cache running at 333 MHz (L2
multiplier set at 1/3). Just two days after
AMD’s release came Intel’s Pentium III 1
GHz, which had the L2 cache running

at full speed. The flipside however was
that it made the Pentium III a night-
mare to manufacture. AMD went for
the kill and released the Thunderbird 
1 GHz that had the L2 cache running at
full core speed. 
Round 2: August 2001
Pentium 4, 2 GHz vs Athlon XP 
It took eight years to traverse 900 MHz
(from 100 MHz to 1 GHz) and just over
a year to reach the 2 GHz mark. The
Pentium 4, 2 GHz is a testimony to the
way the processor industry continually
propels itself to new heights. Intel beat
AMD to this landmark by an easy mar-
gin! Athlon XP languishes at 1.6 GHz.

Gaming Performance
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optimising multimedia applications.
These optimisations have primarily con-
centrated on delivering smoother and
richer content at a faster pace for multi-
media. These instruction sets allow pro-
cessing of large amounts of similar data
(like video content) at once using one
instruction. This significantly speeds up
the processing. 

Working with audio and video con-
tent is probably the most CPU-intensive
task and hardly any other task can
demand as much processor-power as
video encoding. In the video encoding
test, we encoded a standard MPEG video
of 5 minutes into AVI at a bitrate of 900
Kbps. The scores logged in these tests are
for small files but if you extrapolate
them, the differences would be enor-
mous when it comes to encoding an
entire CD full of audio, or while down-
sampling video content that is in 
Gigabytes. The time taken may even run
into hours. 

If your work demands working with
multimedia or audio-video content,
then you should consider a processor
that falls in the Elite range. The Athlon
XP 1800+ was fastest here too, encoding
the entire file in less than 100 seconds
(99 seconds to be exact). The Pentium 4,
2 GHz took about 111 seconds to com-
plete. Though the difference is only 12
seconds, if you extrapolate these num-
bers for an hour-long video, you will
find out that the Pentium 4, 2 GHz takes
slightly more than 2 minutes longer to
complete the encoding process than the
Athlon XP 1800+.

Even in the audio encoding test
where we encoded a 50.3 MB WAV file to
MP3 at 192 Kbps, we found a difference of

over 5 seconds in the time logged by the
Athlon XP 1800+ (20 seconds) and the
Pentium 4, 2 GHz (25 seconds). 

In the performance segment, the
Athlon 1.4 GHz was the fastest by far,
taking 108 seconds to complete the
video encoding and 21 seconds for the
audio encoding. In fact, it was faster
even than the Pentium 4, 2 GHz here.
The top Pentium III was quite slow in
these tests, taking 149 seconds for video
encoding and 35 seconds for audio; it
was beaten by the similarly clocked
Athlon 1.1 3 GHz by a fair margin too.
The Athlon 1.4 GHz should serve you
well if you are an amateur dabbling in
multimedia and audio-video editing or
want a PC that will give you a good out-
put when viewing high-quality multi-
media content.

In the value segment, the Duron 1.1
GHz took 141 seconds for the video
encoding test as against the 164 seconds
taken by the Celeron 1.2 GHz. 

Professional applications and FPU
strength
Users of software such as Maya 3D, Auto-
CAD and Photoshop have a constant
complaint about the time it takes to 
render. If you ask them, then probably 
no speed is enough, and probably even
Athlon XP 1800+ (which performed the
best in these tests) would be slow 
for them. 

All the processors were tested for
image processing, ray tracing and inten-
sive rendering tests. All of these tests pri-
marily focus on the FPU strength of the
processor. 

Here we used the Photoshop filter
test, POV Ray for the ray tracing test and

SpecViewperf for the rendering tests. The
Photoshop test applies 21 filters one after
the other to an image and calculates the
time taken for each filter to execute and
complete. 

POV Ray mathematically models the
light rays as they bounce around a virtu-
al world, reflecting and refracting. This
can quite literally involve millions of
floating point calculations and has
proved to be an extremely stressful test.

Fine-tuning Performance 

So you’ve bought the latest speed
demon and fail to understand why it’s
not living up to all the hype. Well, part
of the problem lies in the way you con-
figure your system. The first and the
most important part of tweaking starts
not from within Windows but from the
BIOS of your system.

Here are few ways to tweak the BIOS
to perfection:
1. Enable the Internal and External
caches. The External cache in most cases
points towards the L2 cache. This should
never be disabled.
2. CAS/RAS latencies/DRAM cycle time:
This setting affects the entire memory
subsystem and the lower the latency, the
better it is. A setting of 2 is ideal and will
significantly improve performance but if
your memory is incapable of handling
this setting, then you will see random
lockups and freezes.
3. PCI Dynamic Bursting, PCI-to-DRAM
Prefetch, CPU-to-PCI write buffer: Make
sure you have all of these enabled. All of
these in combination will yield a sizeable
amount of performance, especially in the
CPU to PCI write buffer. When this fea-
ture is enabled, up to four data words
can be written to the buffer to be
queued to the PCI when it is ready to
receive data. If this feature is disabled,
the CPU can only write to the PCI bus
directly and has to wait for the PCI bus
to be ready to receive data. Enabling the
buffer can drastically reduce the wait
stages (idle cycles) of the CPU. 
CAUTION: Before changing any settings
make sure you write down all the origi-
nal settings on a piece of paper. Do not
rely on the BIOS fail safe and default set-
tings, though they will bring back your
BIOS to a factory setting. If you are tech-
nically inclined, you can download the
latest current version of your BIOS (if
available) from your motherboard manu-
facturer’s Web site.

AMD
Athlon XP

This is the desktop debut of the 
Palamino core. It can push core clock

speed up to 1.6 GHz.

Athlon
Sporting 256 KB full speed cache, this

thunderbird core processor can 
go up to 1.4 GHz. 

Duron
Based on a scaled down version of the

desktop core, this features a reduced L2
cache and a clock speed of up to 1.2 GHz. 

INTEL
Pentium 4
It sports radical concepts such as Hyper
Pipelined Technology which allow clock
speed up to 2 GHz. 

Pentium III
Using Intel’s very own SSE instruction set,
this chip had 256 KB of full speed Level 2
cache and could go up to 1 GHz.

Celeron
An improved version of Celeron, this offers
a higher clock speed (1.2 GHz) and incor-
porates a 100 MHz Front Side Bus (FSB).

Face to Face: How the giants position themselves

➜



The SpecViewperf test consists of six tests
performing various complex OpenGL cal-
culations under a variety of conditions. 

The Athlon XP 1800+ completed the
entire Photoshop test in 63.1 seconds
whereas the Pentium 4, 2 GHz took about
68.3 seconds to complete it. In the ray
tracing test, the Athlon XP 1800+ 
finished rendering the image in 7 min-
utes 2 seconds. The Pentium 4, 2 GHz
took 8 minutes 36 seconds to complete
the same. 

In the performance segment the
results were similar: the sheer power of
Athlon’s FPU strength was too much for
the Pentium III to handle. 

Surprisingly, in the value segment we
saw the Celeron 1.2 GHz pummelling the
Duron 1.1 GHz in the Photoshop test—it

took 76.4 seconds to complete the test as
compared to the 84.8 seconds taken by
the Duron 1.1 GHz.

MAKING A CHOICE
The processor market is out to spoil you
with a wide array of choices. Those days
when you could only buy an Intel
processor and had just a couple of speed
options to pick from are gone. Today
you can choose between the older Pen-
tium III and Athlon processors—which
still provide dependable performance—
and the latest cutting edge chips from
Intel and AMD. While most of us feel
that variety is the spice of life, these var-
ious options can actually become pretty
confusing.

First of all, you need to know what

you’re going to use the system for. That
sometimes can get more difficult as most
of us have a tendency to load a lot of
applications, but use hardly any of
them. 

If you use the PC for running Office
applications and surfing the Web, then
one of the Value processors should suit
you quite well. If, on the other hand, you
are planning to use some of the heavier
professional applications such as Photo-
shop or Corel Draw, the additional power
of one of the performance processors
would come in handy.

Those who want to use their PCs for
more processor-intensive applications—
audio/video encoding, 3D modelling

test drive ■
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1. How do I check that I
got the processor I was
promised?
Most vendors won’t show you
what they put inside your PC,
but you can use a popular tool
known as WCPUID to find out
the exact speed and make of
your processor. When your PC
starts up, check for the CPU
name and speed that the BIOS
identifies.
2. What is a retail original
boxed packed CPU and
what are the advantages
of buying one?
When you buy a retail original
boxed packed CPU, you get a
limited warranty for three
years. The warranty does not
cover non-boxed products
purchased from resellers or
otherwise, and it doesn’t
extend beyond what your sys-
tem vendor has provided.
Both AMD and Intel provide
original heatsink-fan combina-
tions with boxed processors. 

3. How do I monitor my
CPUs health?
All modern motherboards sup-
port some form of hardware
monitoring which allows you
to monitor your CPU’s temper-
ature. You can also use Moth-
erboard Monitor (MBM
v5.1.02), a popular freeware
program. It’s easy to configure
and if you leave it running in
the background, it will tell you
the maximum temperatures
that your CPU touched while
running heavy applications or
playing games. 

You can also set alarms
and ask the program to shut
down the PC in case the 
CPU reaches a particular 
temperature.
4. How hot is hot?
As a rule, make sure your
Processor runs below 55
degrees Centigrade at all
times. 

If you find that your
processor crosses 60 degrees

Centigrade, then you need
additional cooling. If there is a
difference of more than 10
degrees Centigrade between
the idle and full load tempera-
tures (when the CPU is run-
ning at 100 per cent utilisa-
tion), then you need to check
whether there is adequate
contact between your heatsink
and your processor. 

You can improve contact
by applying a thin layer of
thermal grease between the
surface of the processor and
the heatsink.
5. Is a 1 GHz processor
machine twice as fast as a
500 MHz processor?
No, a 25 per cent system wide
performance increase is some-
thing that you can only hope
for. A 10-20 per cent is some-
thing that you will see imme-
diately. This is because the
machine’s performance is
based on a number of factors
other than just the processor. 

6. Can I overclock?
Overclocking means increasing
the rated speeds of the proces-
sor by changing the internal
multiplier or the external fre-
quency. Most modern proces-
sors have their internal mulipli-
ers locked leaving you the
option of only changing the
external frequency. By chang-
ing the FSB (Front Side Bus)
you are in effect also over-
clocking all the other PCI
devices. Overclock your
processor only if you under-
stand processors quite well
and are willing to take the risk
of the warranty being void. 

Among the tested proces-
sors, the Pentium 4, 2 GHz
could be overclocked to 2.34
GHz and it ran flawlessly even
at over 340 MHz above its
rated frequency. The new
Tualatins, the Celeron 
1.2 GHz, and the Pentium III 
1.13 GHz are also overclocker-
friendly.

Processor FAQs

The Processor Families 

Processor Clock Speed Bus Speed Form Factor L1/L2 Cache
Athlon 1.4 GHz 266 MHz Socket A 128/256 KB
AthlonXP 1900+ (1.6 GHz) 266 MHz Socket A 128/256 KB
Duron 1.2 GHz 200 MHz Socket A 128/64 KB
Pentium III 1.2 GHz 133 MHz Socket 370 32/256 KB
Celeron 1.2 GHz 100 MHz Socket 370 32/256 KB
Pentium 4 2.0 GHz 400 MHz Socket 478 20/256 KB

Multimedia Performance



and, of course, gaming—will really
appreciate the incredible power that the
Elite category of processors can deliver.

With the heated competition
between AMD and Intel, processors have
become much more powerful and afford-
able across all categories. Isn’t it amazing
that today, even what we call a value
processor, runs at over 1 GHZ and costs 
Rs 6,000? Competition has driven the
prices down. The processors are much
cheaper today when compared to their
predecessors.

THE WINNERS

Athlon XP 1800+ is the undisputed
champion and it beat the Pentium 4, 2
GHz in almost all the tests by a fair mar-
gin. Despite all the hype behind Pentium
4, 2 GHz, it fails to live up to the per-
formance of Athlon XP 1800+ in key
benchmarks like Photoshop, Business
Winstone 2001 and 3DMark2001. 

Choosing a winner for the Best Value
award was much more difficult. While
the Duron has consistently outperformed
the Celeron by a mile in the past, the lat-
est Celeron (Tualatin) 1.2 GHz processor,
which made it into our labs just in time
for this comparison test, matched up well
against the 1.1 GHz Duron in some tests,
and even beat it in the Business Winstone
2001 by a large margin. Despite this, we
voted the Duron 1.1 GHz as our Best
Value processor because it’s Rs 1,000 

lesser than the Celeron, performs really
good, and drives a fair bargain. 

Athlon XP (Palamino)
The  Athlon XP is AMD’s latest warhorse
in the fight for processor supremacy.
Based on the Palamino core, it can push
core clock speed up to 1.6 GHz (Athlon
XP 1900+). The Athlon XP builds upon
the strengths of the AMD Athlon series

and is a worthy com-
petitor of the Pen-
tium 4. 

The Athlon XP
1800+ tested in this
comparison test
simply blew the
Pentium 4, 2 GHz to
bits by completing
the POV-Ray FPU
intensive ray-tracing
test in just 7 minutes
2 seconds.

The Pentium 4,
2 GHz took over 

1 minute 34 seconds extra to complete
this test. All of this goes to show that the
real meat lies in the performance and not
in the ‘speed’. 

In the video encoding test, the
Athlon XP 1800+ took just 99 seconds
to complete the test as compared to 111
seconds by the Pentium 4, 2 GHz.

This translates into a performance
difference of over 10 per cent with a
MHz deficiency of over 400 MHz!
Rating: A+
Verdict: If you want the fastest in
terms of pure performance, the Athlon
XP 1800+ will deliver.

Duron (Morgan)
The Duron series is essentially a low-cost
variant of the Athlon range of chips. The
Morgan core is based on the Palamino,
which appears in the Athlon XP. The
Duron 1.1 GHz (Morgan) beat the 
Pentium III 1.13 GHz (Tualatin) in the
ray-tracing test: it scored 9 minutes 
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How old is my PC?
If your PC is about a year or
so old then you have a fair

chance of upgrading your processor with-
out going through major changes. 
Will the upgrade demand a new
motherboard?
If you are using a Slot interface board then
you may have trouble upgrading since sock-
et adapters for the newer processors such as
the Athlon XP and the Pentium III (Tualatin)
are not available. Even if your motherboard
sports the slower Pentium 4s (1.4 to 1.8
GHz) and uses the Socket 423 format, you
will not be able to upgrade to the latest Pen-
tium 4s since they use the newer Socket 478
format. If you have an older board and are
using an older Athlon (200 MHz FSB) then
you will not be able to upgrade to the
newer Athlons that sport a 266 MHz FSB.

Which memory standard do I need? 
You will need faster memory standards such
as RDRAM for the Pentium 4 or DDR SDRAM
for the Athlon XP. Most new applications and
games consume a lot of RAM and 256 MB
should be considered the bare minimum. 
Does the upgrade involve changing
the cabinet and power supply?
Pentium 4 requires an entirely new type of
power supply standard (ATX 2.03), so you
will need a Pentium 4 certified cabinet and
power supply. An ATX 2.03 compliant
power supply can be easily identified by
the addition of a 2x2 pin connector and
an optional 1x6 pin auxiliary connector,
which looks like the old-style AT connector.
Both are essential for running the Pentium
4. For the Athlon series you need a decent
300+ Watt power supply and a standard
cabinet.

How much extra performance will
my upgraded processor deliver?
Monitor your system’s memory and CPU
usage when running the applications you
use and prefer, on your current setup. If
you find that you consistently experience
sluggish behaviour and your memory and
CPU usage is at all times over 75 per cent,
then you should consider an upgrade. 
Am I ready for upgrade?
If you use graphics-rich applications and
have a system that is over a year old, you
will find significant improvement in per-
formance if you upgrade to the current
generation of processors. On the other
hand, if you have a 500 MHz or higher
processor and use your PC primarily for
surfing the Internet and for office applica-
tions, then just adding more RAM will give
you enough of a performance boost.

6

Professional Applications

Questions to Ask Yourself before you Upgrade

The less time taken the better



Benchmarks/Processors

Content Creation Winstone 2001

Business Winstone 2001

SiSoft Sandra Prof. 2001 Te

CPU Dhrystone (MIPS)

CPU Whetstone(MFLOPS)

POV-Ray* 

Specviewperf OpenGL

Photoshop 6.01 (seconds)*

Audio Encoding (seconds)*

Video Encoding (seconds)*

3DMARK 2001

Evolva

Quake III Arena

Normal

High

Rating

Contact Details

Vendor

Phone

Fax

E-mail

Price (Rs)

AthlonXP

1800+

(1.53 GHz)

81.6

59.5

4337

2137

7 mins

2 secs

205.2

63.1

20

99

7060

148.2

276.4

264.5

A+

Great

World &

Co

022-

3892828

022-

3879020

sales@gtech

world.com

13,500

AthlonXP

1600+

(1.4GHz)

78.4

57.1

3960

1962

7 mins 

42 secs

203.9

66.8

21

105

6907

147.6

274.3

259

A

Zeta

Techno-

logies

022-

4102288

022-

4102277

tejas@zeta

india.com

10,416

AthlonXP

1500+

(1.33GHz)

76.8

56.9

3771

1858

8 min 

5 secs

202.8

68.6

22

108

6818

144.9

273

256.5

A-

Zeta

Techno-

logies

022-

4102288

022-

4102277

tejas@zetai

ndia.com

9,765

Pentium

4 2.0GHz 

78.6

57.7

3909

2452

8 mins 

36 secs

207.8

68.3

25

111

6960

144

314.1

273

A

Nebula

Techno-

logies 

022-

6347158

022-

6347156

sandip@

nebulate

ch.com

27,500

Pentium

4 1.7GHz

68.6

52.2

3277

2092

10 mins 

6 secs

202.7

77.7

28

126

6655

138.9

289.3

263.3

B

Nebula

Techno-

logies 

022-

6347158

022-

6347156

sandip@

nebulate

ch.com

14,000

Pentium

4 1.5GHz

62.4

47.8

2952

1845

11 mins

30 secs

198.3

88.7

31

122

6331

134.9

265.1

251.5

B+

Nebula

Techno-

logies 

022-

6347158

022-

6347156

sandip@

nebulate

ch.com

9,800

Athlon

1.4GHz

75.8

57.8

3960

1936

7 mins 

42 secs

191.3

71.6

21

108

6765

145.3

266.7

252.2

B+

Zeta

Techno-

logies

022-

4102288

022-

4102277

tejas@zeta

india.com

9,114

Athlon

1.13GHz

66.6

50.9

3205

1567

9 mins 

30 secs

183.7

81.7

27

122

6385

140.3

232.1

234.9

A-

Zeta

Techno-

logies

022-

4102288

022-

4102277

tejas@zeta

india.com

7,052

Pentium

III/T

1.13GHz

63.7

49.3

3205

1534

10 mins

18 secs

155.6

75.8

35

149

5752

128.6

202.1

199.5

B

Nebula

Techno-

logies 

022-

6347158

022-

6347156

sandip@

nebulate

ch.com

14,000

Pentium

III

800MHz

48.2

40.5

2159

1083

14 mins

36 secs

126.2

107.6

52

196

4810

116.8

170.2

169.4

C+

Ockam

Infotech 

022-

6330375

022-

6347805

kamlesh@

ockamin

dia.com

8,000

Pentium

III

700MHz

40.8

34.9

1878

952

17 mins 

6 secs

111.3

121.8

60

227

4308

105.3

144.2

143.1

C-

Ockam

Infotech 

022-

6330375

022-

6347805

kamlesh@

ockamin-

dia.com

7,000

Processor Test

* A lower score indicates better performance
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46 seconds, whereas
the Pentium III 
1.13 GHz took 10
minutes 18 seconds.
In the other bench-
marks, the scores
logged by the Duron
1.1 GHz were almost
at par with the Pen-
tium III 1.13 GHz
(196 fps in normal
mode in Quake III

Arena as compared
to 202 fps logged 

by the Pentium III 
1.13 GHz).

Rating: B
Verdict: A good buy. The Duron coupled
with a low-cost VIA-based platform will
give you a PC that can give the big boys
some serious trouble. 

The worthy mentions

Pentium 4 (Willamette)
Pentium 4 is the flagship processor from
Intel today. The first to hit the impressive
2 GHz, the Pentium 4, 2 GHz has a quad
pumped FSB of 400 MHz and a rapid exe-
cution engine for the ALU unit that
claims to run at double the core frequen-
cy of the processor. 

Pentium 4 has a feature set that gives
stiff competition to AMD, and now proud-

ly hosts 144 new SSE-2
instructions, whereas
AMD has only recently
caught up with SSE. And
with proposed speeds of
over 3000 MHz by the
end of 2002, it truly
would be tough to beat.
Nevertheless, it has its

shortcomings. With a 20-stage-deep
pipeline, an expensive memory interface
and quick transitions of packaging formats
(Socket 423 to 478), one should worry
about the longevity of its platform.
Rating: A
Verdict: The Pentium 4, 2 GHz is simply
the fastest processor out there in terms of
raw power. So if you want to buy the
‘fastest’ processor in town with the best-
of-class build quality, coupled with min-
imum platform incompatibilities, then
the Pentium 4 is your best bet.

The Celeron (Tualatin)
The newer Celeron utilises the 0.13
micron fabrication process, code-named
Tualatin, which is probably the most
unique and innovative step towards faster
speeds and lesser heat dissipation. The
Celeron 1.2 GHz performed
admirably in our tests. It
matched the Duron 1.1
GHz in terms of per-
formance by churning
out a score of 61.2 in Con-
tent Creation Winstone
2001. Finally, we see the
Celeron (Tualatin) maturing
to a viable value proposition.
Rating: B
Verdict: The Tualatin suffers from seri-
ous platform paucity. The older BX/815
class boards do not support the new volt-
age requirement that these processors
demand. We recommend that you wait
for cheaper Tualatin capable boards to
be available for the Celeron.

HATIM KANTAWALLA

The Greedy
Processor: The Athlon XP 1800+ (1.53 GHz) 

is the chip if you want maximum power. 
However, you have to back it up with the 

best components in the market. 
Motherboard: The ASUS A7V266-E. 

Nothing comes close to it in terms of pure
performance; it will let loose all the horses

that the Athlon XP 1800+ has to offer. 
RAM: Nothing less than 512 MB 

of DDR SDRAM will do. 
Hard drives: 80 GB (7,200 rpm) 

Monitor: 21-inch Sony CPD G520 
Graphics card: ASUS V8200 GeForce 3

Deluxe. This card is the fastest available to
date and will ensure that the Athlon XP

1800+ will not be bottlenecked.

The Needy
Processor: Unimpressed by raw speed and power?
Looking for value for money? Package the Duron 1.1
GHz with the components listed below and it will

take care of all your applications with relative ease. 
Motherboard: The KM133 based DFI AM36EC. 

This board gives decent onboard video and audio along
with the choice of adding an AGP card 
in the future. 
RAM: 256 MB of SDRAM. This is sufficient for
most applications and is reasonable consider-
ing the reasonable price of RAM.
Hard drives: 20 GB  (5,400 rpm)
Monitor: 15-inch Viewsonic E53
Graphics card: For most purposes, an
onboard graphics card will suffice, but if you
want a separate one, any TNT2 M64 16 MB
card will do.

GREEDY
vs

NEEDY

Decision Maker
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A
ll of us have our own
vision of the perfect
operating system, some-
thing that understands
us. What is it that 
we would wish for?

Stability? A more secure environment?
A slicker, friendlier interface, something
that Mac users have been enjoying for
years? What else? Windows XP,
Microsoft’s latest OS in the market, has
all this and more. Enter the friendlier
age of computing. 

Operating systems of the future are
going to be crash proof, we know that,
perhaps even more reliable than the
refrigerator. Same is the case with securi-
ty. They will anticipate your needs, shape
themselves according to your working
habits—basically, help you work better. 

XP, in this regard, is the first operat-
ing system in the market reflecting this
change. It is going to pave the way for
trends and technologies that will shape
the operating systems of tomorrow. 

Microsoft has studiously crafted XP
to give you an open, expansive feel. It is
clear that the software giant has spared
neither money nor effort this time. 

The versions
XP comes in two versions, XP Home and
XP Professional. The differences
between these two are clearly demarcat-
ed. In a nutshell, the Professional ver-
sion of XP is for those who place more
value on security, networking ability
and multi-processor support. In a Home
edition, you get pretty much everything
too—multimedia, networking, firewall
protection, the works. The Home edition
is meant for individuals; small business-
es can even set up a network using this
cheaper edition, but without the high-
end tools which only the Professional
edition boasts. 

The Pro
The Professional edition is expensive; it
does all that the Home edition does and
more, but with more elan. Using this
edition, your network is scalable, much
more secure than before, and handles
like it never has.  

Remember the Qualcomm CEO who
lost his laptop and all valuable company
data along with it? XP wasn’t there that
time, otherwise he could have used the
Encrypting File System to scramble 

sensitive data and keep his company’s
trade secrets the way they were meant to
be: secrets. 

Everything remote
Corporate networking ability and man-
agement is unique to XP Professional.
It’s roaming user profile lets users access
documents located on their own PC
from any computer on the network. Two
very nifty tools that do not figure in XP
Home are Remote Assistance and
Remote Desktop. If you’re stuck and
help isn’t locally available, your friend
or a tech support person can connect
directly to your PC over the Internet to
fix it. 

Similar to pcAnywhere (software that
allows remote access), Remote Desktop
provides a remote control service that
allows corporate workers to log in from a
remote computer over the Internet. Once
logged in, the user can take full control of
his computer as if he were right there in
front of it. Though you must have XP
Professional installed in the PC you wish
to access, the remote clients (the com-
puters you are connecting from) need to
have Windows 95 or later versions
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Advertising is glutted, hype is unprecedented, most potential users have heard something or the
other and Microsoft, after a long time, is smiling. XP is out and it is the best OS released by the

Redmond Goliath since 1995. Is it worth your hard-earned money?

The Truth 
about



installed. In addition, you must have the
Remote Desktop Connection software
installed on the client PC.

Rock steady
This is the first time in Windows history
that the rock-solid NT core has been
included in a consumer-level OS. This
itself is a major differentiator and
explains why the XP stability is so
hyped. 

Microsoft, with each OS revision,
goes further in integrating applications,
whether it’s a browser or a media player.
XP sports applications that highlight the
current market
trends, for example,
the addition of CD-
writing, movie mak-
ing, and so on. 

An integrated
CD-writer allows a
user to burn CDs
without third-party
software, while a per-
sonal firewall pro-
vides protection
against Internet
threats. Other bun-
dled perks include
Windows Messenger
and Windows Media Player, both of
which have incorporated more features
and functionality. In Messenger, there are
significant improvements in audio fideli-
ty which changes on-the-fly and thus
adapts better to changing bandwidth
conditions.  In appearance, Messenger
seems to have shed its older threads for
the new XP attire. Windows Media Play-
er innovates in its ability to playback
DVDs and write audio CDs.  

Compatibility
Even with its new enhancements, XP
tries to provide compatibility with the
previous versions. Older applications
which were too closely designed around
Windows 95 now have a chance at com-
ing to life in XP. All one has to do is
right-click on the application icon and
select the Compatibility tab under
Properties. Select the mode you want,
click OK, and run the application. 

We tested a few older applications to
check XP’s application supporting capa-
bility. There were programs such as Fold-
er Guard and SigmaPlot 5 which were not
executed even in the Windows 95 Com-
patibility Mode. However, older versions
of applications such as Ahead Software’s

Nero CD-Writing software operated just
splendidly—no errors, no coasters.

XP also offers the multi-boot option
in case you want your existing OS to
remain.

No more plug-and-pray
Windows 95 had it, Windows NT didn’t.
Plug-and-play saw a true breakthrough
in Windows 95; insert a video card or
plug in a fancy mouse in the USB port
and the operating system handles the
rest. Plug-and-play takes care of touchy
things like interrupts and IRQs. All you
have to do is supply the correct drivers.

But the system was-
n’t perfected—since
Windows 95 was so
unstable, you had to
plug in your devices
and pray that the 
system wouldn’t
crash while detecting
the device. With 
XP, you get the best
of both worlds—
hardware support
from Windows 95
and stability from
Windows NT.

Sharing, security, stability
XP is different, right from the moment
you log in. It has revamped the login
procedure and added a lot of flexibility
when dealing with users. The login is
friendly, and the interface friendlier. You
can set a password for each individual
user account or leave access open to any-
body who wants to enter. Features nor-
mally present only in a network operat-
ing system such as the concept of
administrator and different rights for
different users find a place in XP. The
administrator can also specify rights for
programs. 

Windows XP also bundles along an
Internet Connection Firewall and an
application-level firewall (this allows you
to filter applications that can use the
Internet) for protection from worms and
malicious code.  

Multi-level sharing and security fea-
tures have always been a part of Windows
since NT—the reason why NT/2000 has
been a stable OS. The same stability is
brought to XP based upon the core. All
versions were prone to crashes in some
way or the other after Windows 95. 

After torture testing the XP, we
noticed that during this time, we were

A pretty picture
Visually, no other Windows version
could be as appealing as this. It’s easi-
er to use and is sleeker and more
colourful than the predecessors. 
Easy does it
User friendliness is accented in the
Start menu that gives you quick access
to recently run applications and the
better organised taskbar. Icons give
the user a clearer understanding of
how to configure his or her PC.
Stability
For those tired of the Blue Screens
and Illegal Operations, Windows XP
Home edition leverages the stability
of Windows 2000 using the NT core,
to deliver a much more reliable com-
puting experience.
Quick starts
Considerably faster boot-up than
either Windows 2000 or Windows 98.
Media savvy
With Media Player 8, the Movie
Maker video editing software,
enhanced support for digital cameras
and FireWire support you have the
most multimedia friendly OS around.
Going backwards
Windows XP supports Compatibility
Modes which allow the user to
choose from Windows
95/98/NT/2000 emulation which lets
even older programs run with ease.
Network ready
A plethora of friendly setup wizards
assist you with basic steps such as set-
ting up a network and network
cabling. The Internet Connection
Firewall protects you from hackers on
the prowl.
A real family PC
XP’s user friendliness is given a boost
with support for multiple logins. Cre-
ate a separate profile for your kid sis-
ter so she can play around without
messing up your settings.
Getting a helping hand
Remote Assistance lets a friend help
you when you are facing problems on
your PC.
Safety net
A built-in rollback feature called Sys-
tem Restore allows you to go back to
an older system configuration in case
of a major problem.

Microsoft Recommends…

233 MHz or faster processor
You want 500 MHz + if you don’t

want to ruin the entire eXPerience.

128 MB of RAM
128 MB will get you by, but 256

MB is the sweet spot for XP.

1.5 GB of free hard disk space
The size of the current generation

of software will make an 8 GB drive

a bare necessity.

High Expectations

10 Explosive 
New 
Features
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not forced to reboot or turn off the PC
even once. Certain applications such as
Internet Explorer 6 and StarOffice did
manage to crash, but the problems were
isolated and didn’t have any effect on
the rest of the system. Since XP runs
each application in its own memory
space, the chances that a single applica-
tion will cause your machine to crash 
is reduced.

Exploring the Window
A typical Windows XP Explorer win-
dow—with the contents on the right
and an overview window on the left—is
intelligently crafted to let you jump to
other sections of the computer as soon
as you click.

The improved icons in XP compli-
ment Explorer quite well. You can now
change the icon of any file or folder at
the instruction; photographs can be 
used as well. 

For MP3 files, ID3 tags and
bit rates are displayed. When
you arrange your Explorer
window to show all file details,
information such as  song
name, artist, year, etc, is men-
tioned.

Explore through images in a
filmstrip manner. When you
highlight the image’s icon, a
preview pane opens up giving

you the bigger picture. You can also use
this to create a basic slide show. XP dis-
plays image file information (such as
photos and scanned objects) in detail—
everything from resolution to which
camera captured the image.

Windows Explorer now comes with
the ability to handle the .zip compres-
sion format. Compressed files can be
opened without additional software. If
you want to package a few files together,
just select what you want and right-click
your way through the correct option.

With Web integration features, you
can directly copy files to an online stor-
age service, order picture prints of your
images, and purchase and download
MP3s. You can disable this Web integra-
tion feature if you don’t have Net
access.

Multimedia militia
Windows XP has done a thorough job
in providing users with a complete mul-

timedia solution. As mentioned
before, one of the more obvious
components in XP’s multimedia
arsenal is Windows Media
Player (WMP) 8.0. It now adds
the ability to play from DVDs,
provided you have a DVD codec
installed. XP offers in-built sup-
port to make your own audio
CDs from WMA and MP3 files.

This is certainly useful but XP provides
only a fraction of functionality that
full-scale software offers. This would
mean anybody interested in ‘ripping’
audio CDs to the MP3 format will be
sorely disappointed—WMP does not
permit that. What it does permit is the
conversion of audio to WMA format.
Though WMA is gaining popularity, it’s
nowhere near MP3s in terms of popu-
larity. For those of you who need help
in playing back DVDs or encoding
MP3s, search for codecs and add-ons on
the Web.

Video time
Video plays a prominent role in XP. You
can run a slew of devices to capture
video, edit and make simple movies, and
XP now supports high-speed video inter-
faces such as FireWire. Picking up from
where Window Me left off, XP has
adopted Windows Movie Maker to make
the entire task of moviemaking easy.
However, this is far from a fully-featured
video studio and is not meant to be
taken seriously by professionals. Don’t
expect an Oscar yet!

Help 
If you’ve used Windows before, you’d
know how the help files are segregated
from one another. No more messy 
business in XP—all help files can be 
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Microsoft
and its part-
ners spent a
collective
amount of
about $1 bil-
lion on mar-
keting
Windows XP

Start menu is pre-
sented in two
columns. The left
pane remembers the
frequently accessed
applications and files
and positions them
for easy access. It is
visually more appeal-
ing than the earlier
versions. 
Desktop 
1. Bolder and more
colourful icons high-
light the desktop,
adequately describing
its function. 
2. The Quick Launch
icons can be con-
cealed, thus saving a
certain amount of
taskbar space.

3. Multiple windows of
a single application
can be grouped
together saving space
on the taskbar and
giving it an organised
look.
4. Icons in the system
tray can be hidden
from view. Clicking on
the arrow expands the
list, showing the inac-
tive icons.
5. The Recycle Bin is
the only icon XP
installs by default.
6. Various options help
you customise the
desktop. And if you
miss the icons of the
earlier versions, you
can get them back.

Easier to Explore

➜



centrally accessed with the Help and
Support centre. The standard Windows
Update is responsible for updating all
drivers and patches as soon as they 
are out.

Windows Update is ingrained into
the Help and Support centre which fea-
tures an assortment of practical features
such as pointing to the Hardware and

Software Compatibility page. Using this,
one can quickly research the hardware
that has been given XP approval. If local
help will not suffice, the Help and Sup-
port centre blends seamlessly
with Microsoft’s Knowledge
Base where users can access a
vast pool of support online.

System Restore is an excel-
lent tool to recover an XP envi-
ronment if something goes
wrong with its system files.
This function automatically
takes snapshots of a computer’s
state which you can revert back

to. Since it only keeps a check on the sys-
tem files, you needn’t worry about los-
ing personal data when bringing a dam-
aged installation back to life.

In XP Professional, the Device Driver
Rollback function maintains a copy of an
older driver when installing the new one.
The old driver can be recalled if the
installed driver gives problems.

Linguistic XP?
XP has you covered in India. It now
speaks nine different regional Indian
languages while Windows 2000 sup-
ported just Hindi and Tamil initially.
Hindi, Marathi, Gujarati, Tamil, Telugu,

Sanskrit, Konkani, Kannada and
Punjabi can now be called
mother tongues in XP. None of
the previous home versions of
the Windows operating system
offered local language support.
Users can now access all 
the nine languages using
Microsoft’s Office XP suite. You

have the option to install the language
settings during installation itself, or
after installation.

Indian language fonts in Windows
XP are based on the TrueType format
which means that you can easily down-
load and install these scripts on your
computer, and while you type, a key-
board layout on-screen helps identify
the characters.

Product activation
This has been the hottest topic amongst
technology conversationalists. Microsoft’s
latest attempt to curb the reach of the
long, sinewy fingers of pirates comes in
the shape of Product Activation. When a
user purchases a copy of Windows XP,
Home or Professional edition, a 30-day
time day limit is set to ‘activate’ the OS.
If within that time XP isn’t activated, it
ceases all function until and unless acti-
vation is done. 

Activation involves connecting to the
Internet after which your configuration
details are scanned by XP and sent to a
Microsoft server. The reason Microsoft
stores information about what’s inside
your PC is that if a copy of XP is installed
on another computer, details about that
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The pre-
release to XP
contained
Smart Tags
which, due to
consumer
protest and
cries from the
competition,
was taken out.

A Personal Truth
Don’t just take it from us. Listen to what
others have to say about XP. Sure, it might
be easy for experienced users to jive well
with it, but how does XP figure in the hands
of a newcomer?

To test this question, we put a comput-
er system in front of a person who isn’t the
geeky, system administrator type. We sat
with our trusty test subject, who calls him-
self ‘Soggy’, and made him install, use and
abuse Windows Me, Windows XP, and then
compare the two. 

At the end of it all, this turned out to
be a fresh, new experience. Everyone sur-
vived and there were no frayed nerves.
Even the system was fine. Here’s the 
experience:

Installing
Getting Windows Me running wasn’t so
hard. I was just asked a few questions
before the program took over. I used to
wonder anyways what that millennium
moniker was all about. Now I know, but this
XP is much better—you know, the entire

process seems simpli-
fied. And it looks so
cool too!  

Setting up
Honestly, I really didn’t
notice the time. I just
did the set up! Howev-
er, this XP, surprisingly,
took more time overall
to install. Why does the
process take longer in
XP? It seems to me as if there are many
more files here to install. XP sure is thick! 
TIME TAKEN: Installing and setting up — 
47 minutes for Me and 
62 minutes for XP

Configuring
Talk about being totally confused! Just as I
was getting used to setting up things in
Me, XP comes and bewilders me with its
simplicity. I am not used to software so sim-
ple. I mean, what’s wrong with Microsoft?!
Just look at the Control Panel! It has REALLY
changed and I think I will stick to the old

look till I get somewhat adjusted
to this XP. The change in location
and layout of icons really threw
me off. 

There’s one thing though:
adding hardware such as mouse
and external drives is much easier
in XP. Me sucks in this regard.
TIME TAKEN: Configuring — 
8 minutes for Me and 
7 minutes for XP

Using
I’ve been hearing a bit too much about
how XP makes things easy, how XP is faster
and all that jazz. While I really feel that both
XP and Me are pretty much the same as far
as using them goes, XP seems to be a lot
more organised in its layout and presenta-
tion. The Help is better than in Me, and
basically, XP seems to walk you through the
computer better than Me. Frankly, apart
from this, I really don’t see any other ‘meth-
ods’ that XP has applied to make your task
simpler. It just seems better marketing and
design to me! 

The Experiment

Sougat ‘sOgster’ Garai

The great thing is there are no booting blues. It’s a bliss for
small customers who operate on hardware provided by
assemblers
Tripti Awade, CEO, Alnisha Software



machine can be cross-checked with the
details from the previous installation
when it goes through activation. If the
two machines differ greatly, XP won’t
receive the activation code it needs to run
beyond the 30-day deadline. 

In short, Microsoft is enforcing the
rule of ‘one PC for one OS’. So does this
mean that changing your configuration
around a bit or adding new hardware is
going to make XP think it’s a totally 
different machine? Not necessarily.
Microsoft says that you can make a 
maximum of six hardware changes at 
a time without needing XP to re-activate.
Needless to say, as with every attempt at
curbing piracy, the cracks for product acti-
vation have already started appearing.

XP+ 
Can we please be spared the hidden
expenses? In case you haven’t been
observing the way Microsoft ‘follows-up’
with their consumer level OSes, a Plus!
Pack usually rears its expensive head

with each upgrade of Windows.
Essentially, a Plus! Pack is nothing more
than a few enhancements that effective-
ly turn Windows XP into TP (time pass).

Wallpapers, themes, media add-ons
and things of this nature will end up
costing you money, that too for some-
thing you could get for free on the Net.
A few games are featured as well but they
really don’t hold any ground against
what you can download. Plus, the fea-
tured games are trial versions only, usu-
ally put there in the hope that maybe
somebody would be gullible enough to
pay and get fully functional versions!

Instead of wasting your money on
this, be smart and invest in upgrading
that memory in your machine which XP
is going to hog.

Actual additions
As a true value addition, XP’s integration
for basic applications comes as a definite
plus for home and business users alike.
Among the bundled perks is Windows
Messenger, the instant messaging client
that competes with the likes of Yahoo!
and ICQ. 

Windows Media Player has been a
regular with Windows since the release
of Windows 95. However, Microsoft
chose to integrate more functionality
into Media Player, making redundant
alternative solutions look too expensive
and not purchase-worthy. 

64-bit
Looking beyond the realm of personal
and business PCs, Microsoft also features
a 64-bit edition of the XP operating sys-
tem. It’s designed for extremely powerful
machines with a 64-bit processor, specif-
ically the Intel Itanium. This version is
exclusively written and optimised for

Exposed

Windows XP continues the trend of incor-
porating new applications into the OS. It
includes several new applications such as
compression software, a firewall, movie
making software, a media player and CD
writing software. Does that mean we are
seeing the death of the application market
with all software being integrated into the
OS itself? Not really. The integrated appli-
cations are not very feature rich. The CD-
writing feature, for instance, doesn’t allow

you to work with different file formats and
other advanced options. The media player
does not allow the digital audio encoding
in the MP3 format. 

The claim of damage done to software
makers is slightly exaggerated. The appli-
cation package with XP does provide
enough functionality for most users, but
for those who want more control over
what they do, the free market is the 
only place.

Too Expansive?

Place frequently used application on
the top of your Start menu by right-
clicking the link and selecting Pin to

Start Menu.
If your mouse has a scroll wheel, you
can change the size of fonts in Web
pages on the fly by scrolling up to

enlarge the text and scrolling down to
decrease the size, while holding down
the [Ctrl] key.

Windows XP has support for
ClearType—Microsoft’s anti-aliasing
font display technology—but doesn’t

have it enabled by default. It’s worth
trying as it makes reading easier. To
enable ClearType, right-click on the
desktop, select Properties, Appearance,
Effects, select ClearType from the sec-
ond drop-down menu and enable the
selection. Expect best results on laptop
displays.

By default, Windows Explorer opens
up showing the contents in the My
Documents folder. To change the

default folder, click Start > Programs >
Accessories.  Right-click on Windows
Explorer and click Properties. Under the
Target field, change
%SystemRoot%\explorer.exe to %Sys-
temRoot%\explorer.exe /n,/e,/select,C:\
This allows you to view all the folders
and files in the C root directory.

If running older applications is a
problem in Windows XP, invoke Com-
patibility Mode for that particular pro-

gram. Right-click on its .exe file and
select Properties > Compatibility and
select the OS and display settings that
you want. Clicking on OK will ensure
that the program works as intended.

You can revert to the default look of
Windows. Right-click on the desktop
and go to the Themes tab. Select the

Windows classic theme and click on
OK. To change the appearance of the
Start Menu, right-click on the Taskbar
and select Properties. Select the Start
Menu tab, and check the option for the
Classic Start Menu. Click on OK for the
settings to take effect.

Remove all the icons from your desk-
top. Right-click on the desktop and
select Properties. Go to the Desktop

tab and uncheck the options for dis-
playing the regular desktop icons such
as Recycle Bin. 

Exploit to the Max
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Test Bench: Duron 600 MHz, 512 MB RAM, 40
GB, 7,200-rpm HDD, GeForce2 Ultra graphics card  



the 64-bit platform; obviously this 
XP won’t run on that Pentium 4. The
vital difference between the 32-bit and
64-bit versions lies in the latter’s ability
to access and use much more system
memory. XP 64-bit can handle 16 GB of
RAM and 8 TB of virtual memory space.
Since memory access is much quicker
than, say, fetching data from a hard disk,
high-end workstations with loads of
memory are better suited to make use
from XP 64-bit.

.NET
The IT industry sees gold in the area of
Web services. Companies such as Sun,
IBM and Oracle are developing their own
strategies and implementations to
accommodate this future technology.
.Net is the fundamental framework on
which Web service applications will be
used. Though it’s not exactly going full
steam ahead, Microsoft has decided a
home and place for their upcoming serv-
ices standard. The Microsoft .Net Server
will be the foundation on which applica-
tions using the .Net framework
will be created.

And now, the price
If you have an older version of
Windows, you can buy
Microsoft’s upgrade version of
XP Home or Professional, or you
can buy the full version if you
do not use Windows. The
upgrade version isn’t available
for users of Windows 95, and

costs Rs 4,200, while the new version
costs Rs 7,100. The Windows XP
Professional version is much more
expensive at Rs 12,400 for the full ver-
sion and Rs 6,100 for the upgrade. The
prices for the Home version aren’t that
much higher if you compare it to
Windows Me which retailed at Rs 6,500
for the full version. 

The ride ends
XP has been released after a lot of effort.
In many aspects, this OS is a much need-
ed, if not drastic, improvement over its
predecessors. It is more stable than the
Windows 9x/Me line and sports a horde
of new features and enhancements. Now
you have to make the decision between
buying and not buying. You’ll be a tough
nut if you have the money, read this
entire article, remain content, and not
buy XP! 

If you’re in the market to purchase a
new PC, don’t look beyond XP. This ver-
sion is by far the easiest one to use, as we
have taken pains to explain. But if you’re
the kind of user who fits the profile of a
Windows 98/Me user, there really isn’t

much reason to upgrade—unless
you have a serious problem with
stability and keeping your current
OS intact. There is a lot of room
for improvement still. But we
wouldn’t ask you to waste your
time scouting for other options.
Put your money where the 
experience is.

PRASHANT MASRANI
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XP sold
over 300,000
units in its
first 3 days in
the US alone.
Win 98 did
400,000
units three
days after its
launch. 

The Roll Back feature can eliminate
stability problems that could arise due
to a newly installed device driver. This

lets you revert to a previous working
version by right-clicking on the device
and then clicking Properties. On the
Driver tab of the window, just click Roll
Back Driver and follow instructions. 

To create a bootable floppy disk first
place a blank disk in the floppy disk
drive. Then click Start > My

Computer. Right-click the floppy disk
drive icon, and then click Format on
the shortcut menu. Lastly select the
‘Create an MS-DOS startup disk’ option

and click Start.
Create a shortcut to Computer Man-
agement on your desktop which gives
access to important tools such as Disk

Management and Device Manager,
click Start > Control Panel > Perfor-
mance and Maintenance > Administra-
tive Tools. Right-click Computer Man-
agement and select Copy. Right-click
on an empty portion of the desktop
and select Paste Shortcut. The same
method works for other icons as well.

The fastest way to lock your worksta-
tion is by pressing [Windows] + [L]. If
you want to create a shortcut on

your desktop instead, just right-click
with your mouse and enter
rundll32.exe user32.dll, LockWorkSta-
tion in the location field. Give the
shortcut a name you like. That’s it—
just double-click on it and your com-
puter will be locked.

You can at last get rid of tasks on the
computer from the command line by
using taskkill /pid and the task num-

ber, or just tskill and the process num-
ber. Find out the task numbers and
process numbers by typing tasklist,
which will also tell you a lot about
what’s going on in your system.

MSConfig, the nifty utility which was
absent in Windows 2000, makes its
presence felt again. Click on the Start

menu and in the Run option, type
msconfig. You now have options to
start or stop services. 

Windows XP comes with a more pow-
erful and informative tool for editing
the registry entries in addition to

Regedit. Use gpedit for this option. This
option is only available for those with
administrator rights. 

Expert Tips
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This souped up machine
highlights the differences

between a ‘powerful PC’ and a
graphics workstation. It has a
dual 1.7 GHz Xeon P4 proces-
sors, 2 GB RDRAM, four 18-
GB 15,000-rpm SCSI hard
drives configured in RAID-0
configuration and a  high res-
olution 17-inch TFT monitor
whose display area is coma-
parable to  a 19-inch CRT
monitor. The custom mother-
board is based on the Intel
860 chipset and came with
two IEEE 1394 (FireWire)
ports and the optional Sound-
Blaster Live! Value PCI card
and a Broadcom Copper Giga-
bit Ethernet Adapter. 

All this luscious  hard-
ware fits into a neatly
designed black plastic/alu-

minium casing, which uses a
‘no-screwdriver-needed’
design. Well placed fans pro-
vide excellent cooling while
CPU noise levels are kept
pretty low despite high air-
flows within the cabinet.

However, the price of this
top-of-the-line workstation
might burn a hole in your
pocket. The workstation is
great for designers working
on 3D authoring tools and
movie animations.

SPECIFICATIONS:
Dual Pentium 4 1.7 GHz Xeon
processor, 2 GB ECC PC800
RDRAM, four 18-GB Ultra160 SCSI
hard disks, Intel 860 chipset-based
motherboard, Wildcat 5110 graph-
ics sub-system, 17-inch TFT monitor

Though expensive, it deliv-
ers amazing perform-

ance and has a good
overall bundle.
However, you need
a powerful system
to  realise the full
potential of this
card. In 3DMark 2001 the card
scored an index of 6975, put-
ting it on par with other
GeForce3-based graphics cards.
In Quake III Arena, it delivered
an amazing 268 fps in high
quality mode on our test

machine (1.7 GHz
P4, 512 MB
RDRAM). The card
exhibited breathtak-
ing Full Screen Anti

Aliasing and per-
pixel lighting effects.

Price: Rs 6,83,698 + taxes
Contact: DELL India
Phone: 080-5586110
Web site: www.dell.co.in

The samsung
Samtron 56V

gave acceptable
results in the
screen regularity
test but the red hue
appeared slightly
more intense in the
middle of the screen. In
the geometry test, the hori-
zontal and vertical lines were
found to be slightly askew,
but within an acceptable
range. In the screen regula-
tion test, the raster expanded
by just about 1 mm horizon-
tally and vertically when the
screen turned bright. In the
symmetrical regulation tests

there was a
slight white
and black level
shift near the
edge of the
white and
black bands,

which made the
edge of the block

appear blurry. This could
result in a fuzzy image, espe-
cially when running the
monitor at a resolution of
1024x768. 

Price: Rs 6,500
Contact: Samsung Electronics
Phone: 011-6322517
E-mail: marketing@samsungindia.com 
Web site: www.samsungindia.com

SPECIFICATIONS:
Maximum resolution: 1024 x 768 at
60 Hz, viewable area 13.9-inch

Samsung Samtron 56V
Performance 1/2

Build Quality 1/2

Value for Money 1/2

Features
OOVVEERRAALLLL 1/2

B++B++

Samsung Samtron 56V
Fit for display

Price: Rs 22,000
Contact: Priya Limited
Phone: 022-2663611
E-mail: priyabom@priyagroup.com
Web site: www.priyagroup.com

SPECIFICATIONS:
GeForce3 64 MB DDR, 200 MHz core
speed, 460 MHz memory speed, 

MSI Starforce GeForce3

Performance
Build Quality
Value for Money
Features
OOVVEERRAALLLL 1/2

B++B++DELL Precision 530
Performance 1/2

Build Quality 1/2

Value for Money
Features 1/2

OOVVEERRAALLLL

AA

MSI Starforce GeForce3 MS-8822
Gaming performance to die for

The ripper, the space searcher, the WebRazor, the chain mail
armour and some other outstanding performers...

Bazaar
DELL Precision 530
Outstanding performer
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This 16x DVD drive fea-
tures a proprietary tech-

nology called ‘Sony Advanced
Spindle’ that enhances the
ability of the laser to reliably
read information from unbal-
anced or uneven disks. In the
tests, the drive was very fast at
ripping an audio CD track to a
wave file: it extracted a 50 MB
audio track to the hard disk in
just 29 seconds and reached
the maximum speed of 12x.
The scores faltered to 1990 in
CD Winbench 99 test—other
16x DVD drives usually score
about 2100 in this test. This
would reflect in real-world
tasks such as installing large
amounts of software from the
CD or while copying data from
a CD or DVD media. It also
logged a slightly high access
time of 119 ms, which would

lead to longer
times at detecting  and reading
from CDs. The drive is priced
reasonably and is particularly
good at reading used and
slightly scarred media because
of the built-in error correcting
technology.

Price: Rs 5,300
Contact: Rashi Peripherals
Phone: 022-8260256
E-mail: ho@rptechindia.com
Web site: www .rptechindia.com

SPECIFICATIONS:
16x DVD speed, 40x CD speed, 512 KB
onboard buffer, Sony Advanced Spindle
technology for increased stability
Benchmarks: 1990 in CD Winbench
99, 119 ms access time in SiSoft
Sandra 2001te, 29 seconds for Digital
Audio Extraction (DAE) of a 50 MB
audio track 

Sony DDU1621 
The ripper

Sony DDU1621
Performance 1/2

Build Quality 1/2

Value for Money 1/2

Features 1/2

OOVVEERRAALLLL 1/2

B++B++

ASUS A7V266-E is a well
laid out and roomy  board

that comes with an excellent
manual. The board was very

stable in our tests and
returned great results. It
blazed through the Photo-
shop 6.1 test where it took a
total average time of just 63.1
seconds to crunch through
the 21 filters it was subjected
to—that’s about 30 per cent
faster than its predecessors,
the KT133A-based boards. In
our other tests, encoding a 50

MB wave file took just 20 sec-
onds while converting a 53
MB MPEG file to AVI took just
99 seconds. In the Content
Creation test too we logged a
score of 81.6, which was
among the highest we have
ever logged.

The excellent results in
the Content Creation test sug-
gest good performance in
most business and office
applications. It has a very
good layout, documentation
and construction.  The only
negative is the high price tag.

Price: Rs 13,000
Contact: Rashi Peripherals
Phone: 022-8260258
E-mail: ho@rptechindia.com
Web site: www.rptechindia.com

SPECIFICATIONS:
Supports socket A (462) processors
from AMD Athlon Thunderbird, Athlon
XP and Duron, Slots: five PCI, one ACR,
one AGP Pro, three DIMM, Onboard
audio and Promise RAID Controller

ASUS A7V266-E
Good performance but at a price

ASUS A7V266-E
Performance
Build Quality
Value for Money
Features 1/2

OOVVEERRAALLLL

A-A-

The HP Scanjet 2200C
scanner is up and run-

ning the moment you plug it
in the USB port. The bundled
Adobe ActiveShare 1.5 offers
entry-level image-editing
features. The scanner is pret-
ty slow to start up and failed
to pick up subtle variations
in the brightness of images.
The results in the image
quality tests were good and

it picked up little details
present in different areas of
the photograph. 

This slim and light device
features a 42-bit scanning
engine and the bundled
TWAIN driver has built-in
optical character recognition
capability. A separate OCR
software would, however,
have been better.

Price: Rs 5,999
Contact: Hewlett-Packard India 
Phone: 011-6826000
Web site: www.hpindia.com

Hewlett-Packard Scanjet 2200C
Slow on the scan

HP Scanjet 2200C
Performance
Build Quality 1/2

Value for Money 1/2

Features 1/2

OOVVEERRAALLLL 1/2

B++B++

SPECIFICATIONS:
600x1200 dpi, 8.5x11.7 inch scanning
area, scan to Web capability, USB inter-
face, Benchmarks: 18.65 seconds pre-
view time, 8 seconds warm-up time, 
20 seconds to test and scan image at
300 dpi 

With top-notch build quality
and every imaginable tweak
in the BIOS, the ASUS
A7V266-E is the most fine-
tuned board of the lot

“
Marco D’Souza
Head, Test Centre ”
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WebRazor provides great
Web authoring features

at a very affordable price. This
software comes bundled with
a set of tools, which include
Cool 3D, Photo Explorer and
SmartSaver. Cool 3D helps you
create 3D objects and text for
advertisement banners or GIF
animations. You can also use
the built-in textures and
choose from a range of cus-
tomisable hues and colours.
The Photo Explorer utility lets
you organise photographs for
use in Web pages. A short key-
word can be assigned to
thumbnails to get quick access
to them. The SmartSaver lets
you optimise images created in
Cool 3D or any other utility
and convert them to a format
that is optimised for viewing
on Web pages. The image map

function in the Smart Saver
lets you create a clickable spot
on the image or text, com-
monly found on Web pages,
which take you to another
page or link. WebRazor is great
for amateur Web designers.

Price: Rs 1,250
Contact: Microware Computer Services
Phone: 022-8729725
E-mail: sales@mwcdrom.com
Web site: www.ulead.com

Ulead WebRazor Pro 2.0
For the beginner

Ulead WebRazor Pro 2.0
Performance 1/2

Build Quality
Value for Money
Features 1/2

OOVVEERRAALLLL 1/2

B++B++

SPECIFICATIONS:
Good in-built 3D textures and images,
ready for use with the text 
Images can be optimised for faster
download on Web pages

PGP Desktop Security con-
sists of a firewall, personal

intrusion detection, VPN (Vir-
tual Private Network), disk 
e-mail and message encryp-
tion. It uses public key encryp-
tion and is available in two
variants—one with 128-bit
encryption strength and the
other with a 256-bit strength.
PGP Disk lets you assign a
fixed amount of disk space on
your hard drive where your
valuable data can be encrypted

and saved. PGPNet is another
utility included, which fea-
tures a built-in firewall, VPN
and an intrusion detection sys-
tem. This helps in imparting
security to the data transmit-
ted and received over the net-
work, where intrusion detec-
tion guards your computer
from a variety of network-
based threats such as Trojans,
port scanners, etc.

This application is a good
all-in-one package for protect-
ing your computer from a
range of network threats and
securing your sensitive files.

Price: Rs 11,180 for 25 nodes (two year
validity)
Contact: Network Associates
Phone: 022-6935278
E-mail: annette_castelino@nai.com
Web site: www.nai.com

SPECIFICATIONS:
Consists of a firewall, VPN, disk e-mail
and message encryption, available in
128-bit and 256-bit encryption
strength

PGP Desktop Security 7.0.3
All the protection you need

PGP Desktop Security
Performance
Ease of use 1/2

Value for money
Features
OOVVEERRAALLLL 1/2

B+B+

This software increases the
efficiency of the network

by automatically compressing
attachments before sending
them by e-mail installs on
your network. On the net-
work, it creates a console from
where various aspects of the
software can be logged and
monitored, such as the num-
ber of viruses detected and
suspect files, reports on the
type of information and 

content flowing within the
network, etc. The logging
facilities can be used to mon-
itor Internet usage patterns.
The management console also
features security policies that
can be created and applied in
the enterprise, where the
download and deployment of
updates can be scheduled cen-
trally on all servers across  an
organisation. For a low-priced
comprehensive network secu-
rity solution, eScan Pro Edi-
tion is just right.

Price: Rs 1,880 per year (single user)
Contact: Microworld Software's Services
Tel: 022-8265701
Email: supports@mspl.net 
Web site: www.mspl.net

eScan Pro
Chain mail armour

eScan Pro
Performance 1/2

Ease of use 1/2

Value for Money 1/2

Features 1/2

OOVVEERRAALLLL 1/2

B+B+

SPECIFICATIONS:
Checks for restricted content and
defects viruses on the fly

This affordable joystick
is recommended for

newbies and can be con-
figured without any special
drivers. After plugging it into
the game port, it
worked perfectly
as a three-axis,
four-button joy-
stick. At first the
joystick felt rather
chunky. A rubberised
grip would have been better
for extended play. The wide
base fails to hold its position
on the desk if jerked hard. 

A left-handed user is likely

to find  the top left corner
action buttons uncomfort-
able to use. While the but-
tons can be configured well
for simulations, you might

need to use a couple of
keyboard buttons

while playing action
games. An easy-to-
understand manual
accompanies this joy-

stick. 

Price: Rs 1,350 + taxes
Contact: Aditya Infotech
Phone: 022-6338555
Fax: 022-6338554
E-Mail: applmmb@bom4.vsnl.net.in 
Web site: www.logitech.com

SPECIFICATIONS:
Three-axis joystick with throttle level,
four buttons, System Requirements:
Win 95/98/2000/Me, gameport 

Logitech Wingman
Performance 1/2

Build Quality
Value for Money
Features
OOVVEERRAALLLL

BB

Logitech Wingman Attack
Your first wings
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The Canon S600 bubble
jet printer has separate

CMYK ink tanks, so you save
on refill cartridges. The driv-
er shows you the level of ink
in each tank and alerts you
when the level falls too low.
Setting up this printer was
very easy due to its parallel
and USB interfaces. We used
the USB port because of the
hot plugability feature. Mostly
silent, it does get a bit noisy
while the paper feed mecha-
nism is in operation. A
2400x1200 dpi resolution
delivers near-photo quality
images. The S600 took a little
over 2 minutes to print text on
10 A4 size sheets, whereas the
combi document of text and
graphics elements took 13 min-
utes 48 seconds to complete
printing the 10 copies. It also

supports printing on glossy
paper. Though slightly expen-
sive, this printer is ideal for DTP
and design professionals.

Price: Rs 17,995
Contact: Canon India.
Phone: 011-6806572
E-mail: brijesh@canon.co.in
Web site: www.canon-asia.com

Canon S600
The right image

Canon S600
Performance 1/2

Build Quality 1/2

Value for Money
Features 1/2

OOVVEERRAALLLL
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The IBM NetVista packs great
functionality in a small pack-
age. It has a 1 GHz Pentium III
processor, 256 MB of SDRAM,
and an integrated 15-inch TFT
display. The CD-ROM and
floppy drives are integrated
into the body and remain out
of sight when not required.
The graphics capabilities are
limited by the SiS 630 chipset
that has integrated graphics

and an onboard sound con-
troller. The machine churned
out a low score of 26 in Con-
tent Creation Winstone 2001,
which can be attributed to the
5,400-rpm, 40-GB drive, the
weak graphics sub-system and
the low bandwidth of the SiS
630 chipset. At a price that’s
not compelling, you can defi-
nitely give this PC a miss.

Price: Rs 1,25,000
Contact: IBM
Phone: 080-2079999
E-mail: mittala@in.ibm.com
Web site: www.ibm.com/in

IBM NetVista X40
Compact and functional

IBM NetVista X40
Performance
Build Quality 1/2

Value for Money
Features
OOVVEERRAALLLL

BB

SPECIFICATIONS:
Pentium III 1 GHz, 256 MB SDRAM, 40
GB IDE hard disk, integrated 15-inch
TFT monitor, SiS 630 chipset with inte-
grated video and sound
Benchmarks: Ziff-Davis Content Cre-
ation Winstone: 26

PowerDVD XP
4.0 provides

support for Win-
dows XP and fea-
tures a host of fea-
tures that will take
your movie-watching experi-
ence to a new level. This soft-
ware can simulate multi-
channel sound from a simple
stereo speaker system or even
headphones. It includes sup-
port for Dolby Digital,
TruSurroundXT, Dolby Head-
phone, Dolby Surround and
DirectSound3D/A3D. It also
supports Dolby Pro Logic II
technology, which can simu-
late a surround sound envi-
ronment from regular audio
sources like Audio CDs. The
software can merge the LFE
(Low Frequency Effects) chan-
nel of the Dolby Digital
soundtrack into the front
speakers which lets you actu-
ally experience the low 

frequencies dur-
ing gunfire or
bombs explod-
ing in movies.
CPU utilisation
was about 25-30

per cent on a 1.5 GHz P 4 and
memory usage was around
13-15 per cent. You can down-
load additional skins from the
Internet and change the look.

This software is one of the
best applications that you can
use for DVD playback. Its
power lies in the fact that you
can experience multi-channel
sound even though you do
not have the expensive sur-
round sound hardware.

Price: $49.95 (shareware)
Web site: www.gocyberlink.com/eng-
lish/

Cyberlink PowerDVD
Performance
Ease of Use 1/2

Value for Money
Features
OOVVEERRAALLLL 1/2

B++B++

SPECIFICATIONS:
Supports Windows XP, supports Dolby
Digital, TruSurroundXT, Dolby Head-
phone, Dolby Surround and Direct-
Sound3D/A3D

CyberLink PowerDVD XP 4.0
Great sound for less

Support for virtually every
surround sound format and
stunning picture quality
puts the CyberLink
PowerDVD bang in the
middle of the action!

“
Mitul Mehta
Reviewer

SPECIFICATIONS: 
2400x1200 dpi colour resolution,
max document size 8.5 inch x 14
inch (legal) Benchmarks: 1 minute
39 seconds for full colour A4 size
print, 2 minutes 2 seconds to print
text document (10 prints)

”
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Want to know the exact
amount of space that’s

been eaten up by different
files and folders or what’s the
largest file on your computer?
Space Searcher is the tool for
you. This utility scans the hard
drive and gives you informa-
tion such as the amount of
space occupied by each file,
folder and document. It also
displays information such as

cluster size and percentage of
space occupied by each folder
on the disk, for example,
space occupied by the Win-
dows folder and the Program
files folder. The interface is
very easy to understand with
big self-explanatory icons and
the Help menu is short but
very informative. The report
generated at the end of analy-
sis can be either exported in
Excel or HTML format and
can even be printed for fur-
ther analysis.

Price: $17.90 (shareware)
E-mail: sales@winFrigate.com
Web site: www.winfrigate.com

SPECIFICATIONS:
1.3 MB download size, report can be
saved as XLS and HTML format

Space Searcher 1.01
Tidying your hard disk

Space Searcher 1.01
Performance 1/2

Ease of use
Value for money
Features
OOVVEERRAALLLL 1/2

B+B+

If you need to download
many images from the

Internet, this little tool lets
you automate the entire pro-
cedure without having to
specifically download each
and every image. Using this
software, you can download
all the pictures on a Web page
and even specify parameters,
such as the minimum size of
these images, so that thumb-
nails and page elements are
not downloaded along with
the actual images. Having
done this, you can download
all the images on a Web page
in a single shot. All you have

to do is drag-and-drop the
URL on the program’s icon
and start the task. You can
also configure the program to
explore the entire site and
download pictures that you
would need without having
to manually search for all of
them. The software even
works through a proxy. There
is also an image viewer that
lets you view the downloaded
image in the form of a
slideshow, where you can
scale larger images to fit the
viewing window.

However, the software is
rather high priced.

Price: $39.95 for single user (share-
ware)
E-mail: support@express-soft.com 
Web page: www.express-soft.com

Express WebPictures
It’s all about the image

Express WebPictures
Performance
Ease of use
Value for Money
Features
OOVVEERRAALLLL

BB

SPECIFICATIONS:
Can work through a proxy, includes an
image viewer

This compact laptop sports
a separate hot-pluggable

USB floppy drive and a 20 GB
hard disk for storage. In the
performance tests, however,
this machine did not impress
much. 

The most disappointing
was the Battery Mark test

where the laptop clocked
about 30 minutes lesser than
its counterparts. The Content
Creation 2001 score was 29.2,
which is average for note-
books of its category. 

However the notebook
displayed a good processing
subsystem, and has a DVD-
ROM drive, three USB ports,
one FireWire port, one PCM-
CIA slot and an integrated 
56 K modem. 

Price: Rs 99,990
Contact: Allied Computer Industries 
Phone: 022-2814359   
E-mail: sales@aci-india.com   
Web page: www.aci-india.com

SPECIFICATIONS:
Pentium-III 1 GHz processor, 192 MB
RAM (64 MB shared)

ACi Acclaim
Not so much raw power

ACi Acclaim
Performance
Build Quality 1/2

Value for Money
Features
OOVVEERRAALLLL

BB
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Asecret agent’s life is tough. The
secret assignments, the gadgets,
the deals…So I decide to put some

jazz into my assignments. Music! That’s
what I need. An MP3 player is the perfect
thing to keep me company as I travel
from city to city and shop to shop to hunt
for the best deals available.

I ask my colleague, Agent Audio, from
the Digit Test Centre for help. He brings
along special headphones (reference
headphones that he uses for various audio
experiments) and his audio test CD with
some ear-shattering MP3s. 

Lamington road, Mumbai, is our first
stop. But none of the shops have
portable MP3 players, although
most of them have a desktop
version of a VCD player—
a small device, about 
the size of an
ordinary VCP,
that can play
VCDs, MP3s
and audio CDs.
It costs less than
Rs 3,000, but the
build quality is suspi-
cious and the brand
names look like rip-offs
of well-known compa-
nies. The vendor isn’t
certain whether it’ll play
CD-RWs. Yet these play-
ers deliver. They play
MP3s, support variable bit
rate (VBR) and have a spec-
trum analyser (dot matrix) to
boot. Not bad, considering
the dealer is willing to give
a three-month standing
replacement warranty. It’s too
bulky to carry along, but I could con-
vert it and give my old Hi-Fi system a
new lease of life. But that’s not for now.
I’ll move on to another location. I am
told that I’ll find MP3 players only in
Customs-notified shops.

Heera Panna, Mumbai, looks like a

good place to get imported goods. Agent
Audio and I enter a shop. The shopkeeper
shows us an unbranded CompactFlash

memory-based 32 MB MP3 player,
which  costs Rs 7,500. Agent

Audio asks for a
demo. He fid-
dles with the
equaliser set-
tings and

finds that the
player has less

than optimal out-
put. With only 32

MB storage space, it
allows for only six

songs of five
minutes each.
Another dealer
shows us the

impressive Creative
Nomad Jukebox pegged
at Rs 23,500. It has 6 GB
of hard drive space
(which can store around
150 music albums or

1,500 songs), EAX
surround sound
output, a nice

playlist manager and
a cool display. But the price…. Maybe we
can get the Big Boss to buy this as standard
equipment for undercover assignments. If
only wishes were horses.

He then shows us the Philips Expani-
um, which costs Rs 9,000. Agent Audio’s
eyes shine with pleasure when he sees this
beauty—a good build quality and almost
zero problems when it came to skipping. 

We ask for cheaper alternatives. We
are shown MP3 players priced between Rs
6,500 and Rs 10,000. One brand, King-
wood, looks interesting, but Agent Audio
shakes his head. Though it’s portable and
plays VCDs, MP3s and audio CDs and it
costs just Rs 6,500, it has no buffer to pro-
tect against skipping—it skips and then
takes a long time to play again if jostled
even slightly.

The dealer also tells us about
unbranded ‘Chinese’ MP3 CD players, but
says: “Most of them don’t come with any
warranty or skip protection buffer. Sever-
al users have complained of irregular
playback and random skipping in tracks.” 

We move to Vile Parle, Mumbai,
where a vendor shows us an MP3 player.
It’s a small (and cute) solid-state MP3
player with 32 MB of memory from 
D-Link. He adds that the demand for
these players is low, even though they
have a wealth of features. “It is 100 per
cent skip free and costs only Rs 9,500.”
Agent Audio nods in agreement.

The mission’s come to an end. Now I
must select from among the variety of
choices available. On the one hand are the
foreign brands—great beauties—and on
the other are the cheaper but less feature-
rich models. But then Customs-notified
shops generally do not give you any kind
of warranty or support. The only MP3 CD
player that is available through the offi-
cial channel with warranty and support is
the Philips series of MP3 CD players. Ah,
well, what’s life without a little risk?

■ To test audio quality of the MP3
player, carry along an MP3 test
CD with your favourite tracks and

a set of audio CDs to the shop.
■ Prefer models with at least a 64 MB
memory device to store and play more
songs. Check if there is a possibility of
adding extra flash memory modules.
■ Look for the ability to play VBR (Vari-
able Bit Rate) MP3 files, files with a
bitrate 128-320 Kbps .
■ Look for support for additional formats
such as WMA, Liquid Audio or Windows
Media 8. WMA files are smaller, enabling
you to store more content on the player. 
■ CompactFlash-based MP3 players are
better as they have the ability to
upgrade their firmware.

MP3players

RAM chips

Want to upgrade? Now’s the right
time to go in for SDRAM. Over
November and December, RAM

prices fluctuated from a record low
of Rs 1,100 for 256 MB SDRAM to 
Rs 2,350 per stick. You now pay 
Rs 1,650 for a single stick of PC 133 256
MB SDRAM. So go ahead, upgrade.

Secret notes

ILLUSTRATION: Mahesh Benkar



insight ■
■ X-box

Gaming enthusiasts have a lot to
look forward to. The recently
launched Microsoft Xbox
proves that the PC components

have entered the computer gaming world
for the better. 

Xbox is built around a collection of PC
parts and runs DirectX8 on a stripped
down Windows 2000 core, which means
that game developers can get games for
Xbox up and running quickly. What
might bring even more gamers to Xbox
initially is that it has enough features of
both, a gaming console and a PC, to
attract both the market segments. 

The Xbox is feature-packed and state-
of-the-art. The black box with the signa-
ture green Xbox ‘jewel’ positioned in its
centre gives it an imposing profile. With
an 8 GB hard drive (a first in any game
console), it is now possible to ‘save to disk’
game-related information, as well as
enable virtual memory that will speed up

the performance. You don’t have to install
games—they play off the disk. The con-
troller’s buttons and triggers are pressure-
sensitive, and when you consider the two
analog sticks plus a digital direction pad
provided, you have plenty of control
options. The hardware can push some seri-
ous numbers: 300 million pixels per sec-
ond, 150 million transform and lighting
polygons per second, and 100+ million
shaded and textured polygons. Proprietary
algorithms allow for a whopping 8:1 tex-
ture compression rate and four simultane-
ous textures per polygon. Not impressed?
Well, how about Full Screen Anti-Aliasing
(FSAA), DVD playback, HDTV support and
a maximum resolution of 1920x1080? All
this should translate into visual realism
way beyond anything that has ever been
seen in a gaming console before. 

A sampler, if you want, can be seen in
Dead or Alive III in which large, detailed
characters make their way fighting
through multi-tiered arenas. Visual effects
such as the tracks left by the characters on
the snow or the moving leaves in the for-
est with their rustling sound leave you
spellbound. Another game, Halo, is remi-
niscent of first person shoot-outs such as
Quake, and includes gameplay styles such

It’s black and mean-looking. But it is the
technology inside that makes the Xbox an

irresistible gaming console

xThe 8 GB
internal hard
disk drive is a

first for gaming
consoles

xA derivative of
the 733 MHz

Pentium III 
on the nVidia 

chipset

xA versatile
controller for
enhanced 
flexibility 

xA 233 MHz
GeForce3-class

graphics
processor
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as a hybrid of first person shooters and
third person shooters on the PC. Accord-
ing to Microsoft, the new games with
Xbox will see massive realms, new 
realities, dynamic worlds and detailed
characters.    

More than a console at heart
The Xbox is not just a gaming console, but
also a home entertainment system that
can play movies and music. You can copy
audio CDs to the hard drive and use the
console to play your music in resounding
5.1 Dolby surround sound.

In addition to working on standard
televisions, the Xbox will work with newer
HDTV models as well, both in the normal
and widescreen views. The full capabilities
of the Xbox will truly be exploited only at
16:9 viewing resolutions on HDTV
screens. Couple that with Dolby 5.1 sur-
round and 256 sound channels and you
have the richest gaming experiences pos-
sible. Adding the optional DVD movie
playback kit will let you play DVDs like
the Sony PlayStation 2. (See table, ‘The X vs
the Ex’).

The Xbox’ Ethernet connection,
which is designed for cable and DSL
modem hookups, will allow console
gamers to experience the thrill of multi-
player gaming which has so far remained
the preserve of PC gamers. You will also
have the ability to download new charac-
ters and missions for the games you own.
Its Ethernet adapter sets it up as the back-
bone for any future multiplayer services
that might arise. Although there are no
online gaming services yet, people are
already jumping in and setting up vicious
Halo deathmatches using GameSpy Tun-
nel, a service that allows you to play Xbox
games over the Internet with  the help of
a PC. 

Deathmatch 
Console gaming, a Japanese domain right
from its inception, is now being chal-
lenged on its own turf by the Xbox. The
PlayStation2 from Sony already has a

year’s lead in the US and an 18-month
lead in Japan. Although earlier it had a
none-too-great opening line-up of games,
currently it has some trailblazing titles—
Metal Gear Solid II, Gran Tourismo III and
Devil May Cry. Final Fantasy from Square
has often turned out to be the reason for
many gamers to buy the Sony PlayStation. 

Microsoft has a tough road ahead. Its
opponents in the gaming field, Sony and
Nintendo, have been in this industry for
over a decade now and have strong
alliances with developers and partners,
while Microsoft has no prior experience in
this arena. It now has to prove itself on
various unfamiliar fronts. 

Microsoft has the money, time and
skills to make things happen. With the
Xbox, it has marked itself an entrant to
the console industry, and by the time 
the Xbox 2 is released, it would have a 
significantly higher leverage in the 
console market.

Keeping the promise
About $55 to $60 million next-generation
consoles are expected to sell over the next
half-decade. 

However, the Indian subcontinent is
not on the roadmap of any of these con-
sole manufacturers. Xbox will hit Korea
and South Africa by November 2002. The
Xbox will not be released in China
because of the severe piracy situation
there, which makes it a bad proposition. 

If the same analogy applies to India,
then perhaps we may see the Xbox only in
the grey market.

SRIRAM SHARMA

Console gamers have traditionally been a
breed apart from PC gamers. However, the
Xbox bridges the gap between the two.
In addition to Windows 2000 and DirectX
API, Microsoft has used components from
some of the leading manufacturers. The
Intel motherboard uses an Intel Pentium III
processor, 64 MB of RAM and an nVidia
graphics card. Several additional signs of
the PC’s architecture can be seen such as
the Dolby Digital compatible soundcard, a
conventional PC hard drive, the DVD-ROM

drive and an Ethernet card that will allow
you to connect several computers together
on a network.

Traditional PC favourites such as
Giants: Citizen Kabuto, Max Payne, Black
and White, and NBA Live 2002 will soon be
available on the Xbox. In addition to this
will be all new titles such as Unreal Champi-
onship, which will be the next generation
of the popular Unreal Tournament series.
Other Xbox titles will include WWF Raw is
War and Star Wars: Obi-Wan Back.

The PC Connection

The launch of the Xbox is a continuation
of Microsoft’s acceleration into greener
pastures. The booming popularity of
video game consoles will help Microsoft
get a firmer foothold in the entertain-
ment arena, which it has previously
entered via its Interactive TV, gaming
software and online gaming services.
The video game consoles will help
Microsoft reach out to the masses right
where they play—in their homes. No
wonder Microsoft is spending half a bil-
lion dollars on a product that will not be
even remotely profitable before 2004.

The Bigger Game Powerplay—The X vs the Ex: A Hardware and Feature Comparison
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W
hy on earth would an anti-
virus tool become the world’s
second most widely used
class of software after an
operating system? Why is it
that more than 10 per cent of

the data losses worldwide occur because of only a
hundred lines of code? Why are networks that were
supposed to help us communicate with each other
now turning into ‘virus streams’ and infection medi-
ums? Why is it that the word ‘Nimda’ is a more
familiar word than ‘Linux’ in a not-so-actively-com-
puting-lifeform’s dictionary? Why has the media
started giving so much attention to all the virus
attacks nowadays? 

This is just a short list of whys that we want
answered, but since we not-so-powerful beings are
not capable of mass communication and mind con-
trol, we opted for introspection. All we found during
that introspection was the word this article starts off
with—ignorance!

Yes! Believe us, that’s the answer to all those

whys. That is the cause of losses amounting to mil-
lions of dollars due to data/network usage loss, or
even those wasted CPU cycles on your PC that you
think don’t count for any money. No virus, no Tro-
jan, no worm, no matter how powerful, can get to
you if you know how they work and squish them
right at the entry point. Or even better, never let the
entry point be insecure. 

Now it’s time to see how these intelligently
designed but extremely malicious pieces of code work.

The virus
In a lay person’s language, a computer virus would
be best described as a small program that is specifi-
cally written to subvert the normal operations of a
computer, thereby making it malfunction. Worms
use exploits or loopholes in operating systems or
other programs (e-mail clients and Internet browsers,
for instance) to propagate or harm systems. Worms
are quite similar to viruses when it comes to spread-
ing, except that they’re a lot more intelligent and
sophisticated. Depending on how a worm is 

ignorance \Ig”no*rance\, n. [F., fr. L. ignorantia.] 1. The condition of being ignorant; 
the want of knowledge in general, or in relation to a particular subject; 

the state of being uneducated or uninformed.
(Source: Webster’s Revised Unabridged Dictionary, © 1996, 1998 MICRA, Inc.)

All you need to know about catching viruses and keeping your PC bug free

ILLUSTRATION: Mahesh Benkar
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programmed, it can or cannot damage
data, but can always be used to sniff out
data such as a credit card number or a
password. Trojans come disguised as use-
ful utilities or applications but turn out
to be harmful. 

The sole aim of a virus or a worm is to
cause destruction depending on the ‘pay-
load’ (the effects of the actions taken by
a virus). They are intentionally pro-
grammed to infect files, corrupt the
installed programs on one’s system and
some even go to the extent of destroying
a hard drive’s File Allocation Table. Infect-
ed systems are also prone to frequent
crashes and slow down significantly. This
happens when a virus randomly occupies
a memory location that is currently in use
by an existing program.

Largely, there are five kinds of virus-
es: Boot sector, File Infecting, Polymor-
phic, Stealth and Multi-partite.

Boot sector viruses infect the boot
sector (an area that forms the first track of
the disk and contains information that is
required to boot the computer) of your
logical disk (hard disk) or floppy disk,
whereas File viruses infect executable files
(such as .com, .exe, .ole, etc). One exam-
ple of a boot sector virus is the Yankee
virus, which triggers off at 5 pm, or when
[Ctrl] + [Alt] + [Del] is pressed, and plays
the tune ‘Yankee Doodle Dandy’.

Stealth viruses attempt to hide not
only from the operating system but also
from the anti-virus software, which
makes them extremely difficult to identi-
fy. Polymorphic viruses not only hide
from the anti-virus software but also keep
changing their appearance. In order to
detect them, the anti-virus scanner
should be able to conduct algorithmic
scanning, besides just string-based scan-
ning. Multi-partite viruses are the worst
as they can infect the boot sector as well

as executable files. They also possess char-
acteristics of Polymorphic viruses, which
makes them extremely lethal. One very
popular virus of this kind is Natas. It is a
multi-partite polymorphic virus that adds
4,744 bytes to every file it infects. 

Just like viruses, worms can be lethal
too. A worm is a piece of code that tries
to infiltrate another program and then
attempts to either destroy the data of
the program or keep infecting more files

and programs on the sly. Because of
their small size and, nowadays, depend-
ency on JavaScript/Active-X exploits,
they can also be embedded in Web
pages so that they launch themselves
whenever you visit such sites. One
example of a worm like this is the pop-
ular Nimda (‘admin’ spelled backwards)
worm which spread like wildfire a few
months ago and created havoc by crip-
pling a lot of systems  worldwide.
Nimda took advantage of the loopholes
in the Microsoft server, browser and 
e-mail software to infiltrate PCs.

This new-generation virus can spread
in four different ways—via server, via 
e-mail, through Web pages and by shared
folders on the local network. 

Trojans
If in the middle of a strenuous task you
find that your CD-ROM drive opens and
closes by itself at regular intervals, you
can bet that you are infected by the Back 
Orifice Trojan. This is just one of the pop-
ular Trojans, and usually most of them go
beyond such pranks in order to act as 

■ Data, such as a spread-
sheet or word processor
document, gets corrupt-
ed, altered or unreadable. 

■ Programs that you use regularly won’t
start or operate significantly slower. 
■ The amount of free hard disk space or
free memory is mysteriously disappearing. 
■ Error messages pop up on your screen. 
■ The time-date stamp or size of a program
file change automatically.
■ Your computer becomes extremely slow

even while executing normal tasks.
■ You find that numerous copies of your
files have been created automatically. 
■ Your computer hangs frequently.  
■ Your floppies go corrupt quite frequently
and you get the message, ‘track 0 bad’. 
■ Your BIOS gives you a message that
something is trying to write to your boot
sector, and whether it should allow it.
■ Any other behaviour that corresponds to
your computer not working as it should in
normal circumstances.

Your Machine is Infected when...

■ Do not panic. It doesn’t solve the 
problem 
■ Try identifying the virus that you are
infected with. Some Trojans and worms
can be removed by editing the registry
and the Windows startup files. If the virus
has come from an e-mail message, delete
the e-mail message
and the attachments. 
■ Close all the running
programs 
■ If you are on a net-
work, disconnect
yourself from the net-
work. You can log off
the network in Win-
dows 98 by pressing [Esc] during the log
on process. Pulling off the network cable
also helps.
■ Try running your anti-virus software. It is
likely that even that will be infected.
■ In Windows 98 and prior versions you
can restart to DOS mode. Try running the
command line version of the virus scanner
with the clean option.  
■ Take out the emergency disk/CD that
you created from the safe store. Write-
protect the emergency disk and boot to
DOS using the floppy/CD (make the
appropriate changes in the BIOS setup to

enable that). Run the command line ver-
sion of the virus scanner with the clean
option. Use the delete option if the clean
option fails.
■ If you are unable to use the virus scan-
ner, but manage to identify the virus,
search the Internet for a specific fix for

that virus. Download
that fix and run it on
your system. 
■ If this also fails, take
out the hard disk and
attach it to your
friend’s system that
has an anti-virus soft-
ware (hope he’s your

best friend). Run the anti-virus software
from your friend’s system.
■ As a last alternative, copy the data that
you have to an alternative partition or
another hard disk. Format the hard disk
and then load the operating system and
the latest version of the anti-virus software
with the updates installed. Keep the anti-
virus software running in the background
and copy the data back selectively. If the
virus has infected any of your data files, the
anti-virus software should detect it. You
will probably only lose data pertaining to
that file. 

‘Oh no, I’ve got a Virus! What do I do?’

➜
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key-loggers to trap passwords or transfer
files from your hard disk. 

The name Trojan harks back to the
famous Trojan War, in which the Greeks
successfully invaded Troy by hiding some
of their soldiers in a huge wooden horse.
In computer lingo, a Trojan is a malicious
security-violating program,
which claims to do something
useful but in reality is inten-
tionally programmed to cause
destruction to a computer
without the user’s knowledge.
Trojans are executable pro-
grams, which automatically
run themselves when opened
and perform a function that
they are programmed to do.
These executable files usually
have file extensions such as
.exe, .vbs, .com, .scr, .bat or .js. 

Trojans can spread in the
guise of just about anything.
They could reach you in the
form of a screensaver, a pic-
ture file, a Flash greeting card or even
games. IRC (Internet Relay Chat) chan-
nels and P2P programs such as Gnutella
are a major source for spreading Trojans.
A person can also specifically target you
by sending a Trojan or a Web link with
a Trojan activator embedded in the page
script through e-mail.

So are Trojans more harmful than
viruses? Well, Trojans do cause more
damage as they can steal your password
and mail it to the sender. And more

importantly, they allow hackers to gain
complete control over your computer
and perform actions such as DoS (Denial
of Service) attacks. Hackers break into
computers by using a Trojan horse and
take advantage of human carelessness to
steal your passwords and other confiden-

tial information. 
Similar to Trojans is

something called a Logic
Bomb. These are programs
that lie dormant until a cer-
tain event triggers them to
perform a pre-programmed
action. They are often used as
a tool of revenge. For exam-
ple, a student who has fared
miserably in his examina-
tions could program a Logic
Bomb, which when triggered,
could wipe out all the data
stored by his college server.

Some popular Trojans are
BackOrifice, Netbus, Sub7,
The Thing, Spyman and Girl-

friend. Most of these are used as stealth
spy tools. There are milder versions for
playing pranks too.

Declaring war
When your PC is under a virus or Trojan
attack, your anti-virus software plays
hero. These tools are mostly ‘search and
destroy’ tools that scan your hard drive
for viruses and disinfect or remove the
infected files. Over time, anti-virus tools
have evolved to prevent virus infection
by continuously running in the back-
ground and keeping a lookout for virus
signatures in any files being read from
almost any medium, be it the 
network, the Internet, or a floppy. 
On detecting a malicious code, they
immediately alert the user.

As viruses get advanced, they rely
more and more on system repositories
such as registry entries and configura-
tion files while using the network con-
nections to spread. This in turn calls for
the anti-virus software to expand and be
able to detect and clean these infections
as well. Most anti-virus software today
are capable of doing this since this is
very essential in case of new Trojans and
worms, and the more advanced script-
based viruses. 

An anti-virus program works a lot like
a text editor, except that instead of
ASCII/ANSI text, it edits hex code (which
is a way to display data using characters
instead of binary code). The anti-virus

Trojan attacks allow hackers to control
another comput-
er, read the per-
son’s hard drive
and acquire per-
sonal information
such as passwords
and bank account
details or worse,
erase data from
the hard disk. Be
wary of receiving
these malicious
programs on IRC
channels or via e-mail in the form of a
screensaver, game or a hack. Though
today’s anti-virus software have become
sophisticated and efficient enough to
handle Trojans, none of them can guar-
antee you complete protection.

The following signs indicate that
your machine is infected with a Trojan: 
■ An unknown program running in the
background
■ An error message pops up either on
start up or while running programs
■ Random application crashes
■ Extremely slow Internet connection
speed in spite of your settings being
appropriate 
■ Extremely slow start up

A Trojan is a program and it needs to
start up when your machine boots.
Once you are sure you have a Trojan on
your machine, you should look for any
unusual programs in your startup set-
tings. In Windows 98, you can use the
system configuration tool (msconfig) to
check for these, and the services manag-
er in Win NT/2K. Once you have identi-
fied the stray program, remove it from
the startup and reboot your machine.
Now delete the program that was start-
ing up and you’ve removed the Trojan.

Although it seems like an easy task,
figuring out which program is a Trojan
amongst a dozen or so entries can be a
real pain. Instead, it would be better to
use a software such as ‘Cleaner’ or other
Trojan removal tools which scan systems
for Trojans, stop them from activating,
and then remove them from the infect-
ed system. 

For more information about Trojans,
visit: 
www.moosoft.com, The Cleaner; 
www.sniff-em.com, Purgeit!

Removing a Trojan

What to Look for in 
Anti-virus Software 

■ Weekly updates to
free virus definitions
made available on the
Internet
■ Integration with

your e-mail client so that each e-mail
gets scanned for viruses, Trojans and
harmful scripts
■ Automatic scanning of every file you
execute to minimise chances of infection
■ Scheduling of scans so you needn’t
worry about your weekly checkup
■ The ability to create a Rescue disk
which will come in handy if you aren’t
able to get Windows to boot
■ Integration with Windows Explorer
will allow you to quickly scan a 
suspicious file

80 per
cent of
all viruses
spread
through
unsolicited
mail attach-
ments.
PC Magazine 
June 2001
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database, commonly known as ‘virus def-
initions’, is nothing but a collection of
‘hex data’ that the anti-virus engine uses
to perform searches on a file, and if
found, it tries to repair the file without
destroying the original data.

As viruses have numerous variants
and many new viruses are developed
everyday, it becomes very hard to keep
track of each and every virus signature.
That’s why anti-virus tools started using
a new method, in conjunction with the
existing method of using anti-virus def-
initions. This method is called heuristic
scanning. An anti-virus takes a piece of
code and runs it in a virtual environ-
ment called a sandbox and observes its
behaviour. If it finds any malicious activ-
ity, it declares the piece of code a virus
and prompts the user for the necessary
action to be taken. Generally, if the user
allows, the sample code is quarantined
and sent to the anti-virus company 
for classification and categorisation. 
However, just installing an anti-virus is
not enough. 

Here are a few steps that are essential
even with anti-virus software installed. 
■ Create an emergency disk which will
contain the DOS version of the anti-
virus software along with the ability to
clean viruses. The emergency disk
should be a bootable CD or a bootable
floppy. Write-protect the floppy and
keep it in a safe store.
■ Set your anti-virus software to auto-
matically download the updates. If
automatic updates are not available,
check for updates at least once a week.

■ Set up the anti-virus software to auto-
matically scan downloads and e-mail.
■ Set up the anti-virus software to auto-
matically scan any removable media,
especially if you copy files from the
removable media.
■ Do not disable the anti-virus software
that is residing in the taskbar and moni-
toring all files.
■ Schedule a virus scan once every
week.
■ In the settings for the anti-virus soft-
ware, enable the highest protection pos-
sible. Keep it to scan all files by default
(as opposed to only program files).
■ Set the setting to automatically clean
the file if a virus is found and, if clean-
ing is not possible, to isolate the file or

delete it. This will allow you to schedule
automated scanning without your inter-
vention in case a virus is found. 
■ Do not disable logging for any virus
scans. Make it a point to view the logs
after every scheduled scan or a full-sys-
tem scan.

Under siege
How exactly does a virus spread? When-
ever a computer starts or boots up, it first
accesses the boot sector and then starts
loading the operating system. Boot sector
viruses infect the boot sector by attach-
ing themselves to this area. As soon as the
computer starts the virus lodges itself in
the memory and from there on slowly
extends its presence by entering other
areas of the computer. Once it enters the
system, it tries to enter other computers,
for which it needs a medium whereby it
can carry itself to other PCs. The normal
medium of transfer can be e-mail, Web
sites, instant messengers and P2P net-
works, storage media (floppies, zip car-
tridges, CDs, hard disks, etc) and also
through LAN connections.

E-mail
If sentences like ‘I love you’ and ‘Hi, I
need your advice’ have become com-
monplace among techies, you know what
to blame—e-mail. The most common
Internet function is also the most dan-
gerous one as evident from the way
worms such as ‘Iloveyou’ or Sircam
spread throughout the world. As per a PC
Magazine study, almost 80 per cent of all
viruses spread through e-mail, that is 
e-mail attachments, and especially

What makes Heuristic Scan better than Regular Scan

■ Don’t open an attach-
ment from a stranger.
■ Think before you click
on an attachment. Just

because the attachment doesn’t have a
.exe extension or is not a Word file doesn’t
mean it cannot be a virus. Compressed
files and executable files can have viruses
within them renamed with .gif or .jpg
extensions. These viruses get executed the
moment you open the file. As a principle,
scan all attachments irrespective of file
type before opening. 
■ Look out for suspicious subject lines—
’I Love You’ and ‘Hi, I need your advice’
are already famous. The next one might
be ‘Mama wants you back!’ 

■ Use e-mail filters to block senders or
remove e-mail from the server directly. 
■ Use an anti-virus software to directly
scan e-mail before downloading.
■ Apply security updates to your e-mail
client and browser on a regular basis. You
can keep track of bugs in the software and
the available updates at www.securityfo-
cus.com.
■ Disable options for ActiveX scripts.
■ Work without a preview pane. 
■ Keep your address book to a minimum.
That way, even if you get infected, you
spread the virus to a few people. 
■ Look out for messages that start with ‘An
ActiveX script prevents the message from
being disabled properly.’

E-mail Safety Rules

Regular scan Heuristic scan

Heuristic scanning finds and quarantines even the latest, undetected virus. In Heuristic 
scanning, the anti-virus executes the infected file in a sandbox, checks for malicious activity,
and quarantines the file if any such activity is detected. It is not just based on signatures. 

INFOGRAPHICS: Solomon Lewis
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through unsolicited mail which are
accompanied by attachments. 

The Melissa worm which struck in
1999 dispelled any notions of e-mail being
a secure environment. Melissa exploited
Microsoft’s scripting language (Visual
Basic for Applications) to send a copy of
the e-mail to very person in the recipient’s
address book. Later worms such as Ilovey-
ou and Sircam followed in the same fash-
ion. E-mail viruses are thus able to propa-
gate themselves at a pace that anti-virus
software developers just can’t match up
with. 

The vulnerability of certain e-mail
clients just adds to the misery. For
instance, one of the worms spread by
exploiting the preview pane option in Out-
look Express, while another used the Sig-
natures tab. In both instances, if you dis-
abled the preview pane or signature attach-

ments, the worm did not
spread. ActiveX scripts and
exploits based on these
became another source of
worry soon afterwards. 

While a simple pre-
caution against viruses
can be that you make sure
to scan all attachments
before opening them, the
spread of Nimda virus has
raised new issues as it uses
exploits in such a fashion
that it does away with the
concept of opening
attachments—just reading
the e-mail is enough for
the virus to start on its
destructive path.

Some anti-virus software such as AVG,
Norton AntiVirus, QuickHeal, etc, allow
for automatically scanning an 
e-mail before you read it, and thus ensure
one level of protection. Web-based e-mail
services such as Hotmail also scan all
attachments, thereby adding to the level
of protection for people who do not use
local e-mail clients.

Internet
As the Nimda virus proved, just visiting a
Web site may often be enough for the
virus to spread. Even otherwise, Web sites
with ActiveX scripting and Java applets
can prove to be dangerous. Anti-virus soft-
ware such as McAfee have a list of mali-
cious sites that it keeps track off and you
can also add sites to this list.  

Chatting using your Instant Messen-
ger clients may seem a totally innocuous
function, but one virus was known to
spread through MSN Messenger. Again,

most of us send and receive files using
instant messenger and are quite careless
about it. We don’t realise that these files
have to be treated with the same degree
of apprehension as an e-mail attach-
ment—that is, you need to scan these files
before opening them.

Likewise, scripts and bots on many of
the IRC sites act as Trojans to infect your
system. Even the newer P2P programs
such as Morpheus, eDonkey 2000 or
Gnutella are becoming one of the major
sources of viruses. It’s quite possible in P2P
programs to have an executable renamed
with an MP3 extension. It’s not tough to
lure you into downloading the file, is it? 

Storage media
The usual modes of transfer are through
infected files that are transferred and
opened on other PCs and infected 
floppies. Thus, from one computer it
extends its residency to many others,
without the user’s knowledge. At one

insight ■
■ anti-virus
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Most anti-virus soft-
ware use a mail proxy
to scan your incoming
and outgoing mail.

The software re-routes your mail through its
own internal engine before it reaches the 
e-mail client, which gives it a chance to
clean up, or stop the mail there if it’s infect-
ed. You can use just about any POP3 client
to access mail through one of these anti-
virus proxies.

Most of these tools leave the entire con-
figuration to the mail client side without
needing any configuration on the software,
since they act as a proxy that can be turned

on or off. Let’s see how this works. You have
an account from ISP1, the POP3 mail server
name is pop.isp1.net.in, your login name is
‘user1’, and password is ‘anypassword’. This
is your configuration for your ISP when you
connect directly. 

When you use a proxy, the settings men-
tioned above change to this format:

1. POP3 Server name changes to ‘local-
host’ or ‘127.0.0.1’ which is a loop back IP
to your own machine. As the proxy runs on
your own machine, it attaches itself to the
local loop back IP.

2. Your username changes to
‘user1#pop.isp1.net.in’, where ‘#’ is a 

separator character that separates the user-
name from the server name. This is different
in case of every anti-virus software (Norton
AntiVirus uses ‘/’ as a separator). This is how
your anti-virus proxy gets the path from
where it retrieves mail. 

3. Password remains unchanged; it’s the
same as the password you use on the server.
Every time you change your password on
the server, remember to enter the new pass-
word in your mail client.

That’s it! You’re done! If your anti-virus
supports an outgoing mail proxy as well,
you will set your outgoing SMTP server to
‘localhost’ or ‘127.0.0.1’. 

Anti-virus for E-mail

Internet Safety Rules 
■ Disable ActiveX and
Java Virtual Machine
unless you really need it
■ Do not keep the set-
tings in your Instant

Messenger or IRC client for auto-down-
load. It should prompt you before
downloading. If you don’t normally
transfer files, you can disable this
option
■ Any setting that allows a stranger to
contact you over chat and send files to
you should be disabled
■ Integrate your download managers
with an anti-virus utility so that the
moment the download is complete, the
files get automatically scanned

If your ISP’s mail server has anti-virus support, all incoming
mail will be automatically scanned for malicious code. If any
viruses are found, the mail would be deleted/quarantined and
a notice would be sent to you

Anti-virus Mail Server



time, floppies were the most common
methods by which viruses used to get
transferred as it was one of the most con-
venient and popular methods of backing
up data and exchanging files amongst
most PC users. While floppies have
dipped in the popularity charts, they still
are a source of worry. Especially when you
are in cyber cafes and are transferring files
that you have downloaded, you end up
using a floppy which becomes a poten-
tial infector. Other storage media,
whether CDs or CD-Rs or zip cartridges
(and even hard disks when used for hard
disk to hard disk transfer) become poten-
tial sources for a virus to enter your sys-
tem. Just because you cannot write to a
CD doesn’t mean the CD cannot contain
a virus (you will not be able to clean the
virus from the CD, that’s all).

Network Scanning
All network administrators know the
FunLove virus. It took just one computer
to get affected with it, and everyone in
the network with some folders shared
found themselves infected with the virus-
es or their anti-virus software popping up
screens warning them about the virus. 

It’s a trend viruses have always fol-
lowed; they move with the data. As net-
works become the predominant method
of data transfer and floppies/other exter-
nal storage mediums lose ground, many
advanced viruses adopt networks as their
transport medium. 

In order to do so, they make use of
network file shares and exploits in net-
work services. As most networks have
migrated to TCP/IP in order to connect
to the Internet, it has become far easier
for virus writers to write a simple code
that allows the virus to hop from place to
place making full use of the TCP/IP serv-
ices. Most popular viruses and worms
nowadays use a combination of Internet
Information Server (IIS) exploits, VBScript
exploits, e-mail and simple Windows file
sharing to spread from one machine to
another. 

Keeping your software updated and
having the latest exploit code patches is
the only way to prevent these viruses as
they operate at the service level, where an
anti-virus can’t detect them until the
infection has actually happened.
In case of e-mail, an anti-virus
mail server or a proxy would
first download the mail,
scan it for regular virus-
es as well as mali-
cious code in the
mail body, and

delete/quarantine it if any virus is found,
and after that send a confirmation report
to the recipient.

Most enterprise anti-virus packages
also include a central console that mon-
itors virus infections all around the net-
work and generates alerts at a single
place, from where updates can be pushed
down to the individual PCs. This is also
helpful in tracking down and preventing
viruses that spread using the network,
and prevent a full scale epidemic from
happening.

As we said in the beginning, igno-
rance is what makes you vulnerable to
viruses. Now that you have knowledge on
your side, you can take the necessary 
precautions and go about your work with 
confidence.

MITUL MEHTA AND VARUN SINGH

Storage Media Safety 

■ Always scan flop-
pies before you
access their con-
tents.
■ Do not keep a

floppy in the floppy drive with the
drive closed before booting up. If the
floppy has a boot sector virus, it will
automatically spread. Better still,
change the BIOS setup to boot from
hard disk first.
■ If you are using your floppy on some
other machine to transfer data, write-
protect the floppy. This will prevent
your floppy from getting infected if the
other system has a virus.
■ Likewise, you can also write-protect
hard disks if you have taken it to your
friend’s place to transfer data. You can
write-protect from the BIOS (which is
much safer) as well as through the
operating system.
■ Enable boot sector protection
through the BIOS after you have fin-
ished partitioning your hard disk. This
will prevent certain viruses from writing
to the master boot record.

Some software tools we
use act as a way for
viruses or malicious
worms to spread. They

allow viruses to enter the system and exe-
cute without the user’s permission by
using an exploit. Some of these tools are: 
■ Microsoft Outlook (all versions prior to
2002 or 6.0)
■ Microsoft Excel and Word 
■ Microsoft IIS 4, 5 
■ Sun Java Runtime Environments (old 1.0x
series versions)

Mostly, any software that uses data
from outside sources and has a
scripting/execution part can be vulnerable
to such attacks. A worm that used the
Word macro feature was Melissa. Once it
infected your machine, it sent an e-mail to

the first 50 addresses in your Outlook
address book. This message had the sub-
ject line ‘Important Message From <user-
name>’ and an attachment of the infected
document from which the virus was
launched.

Software which are more secure, or
those which use a much lower degree of
scripting unlinked to the core system
(preferably none at all), are far less suscep-
tible. So replacing these common utilities
with more secure alternatives can prevent
a possible virus attack. For e-mail, using
Eudora, Netscape or other similar mailing
tools that use a very limited amount of sys-
tem level scripting will be a good replace-
ment for Outlook. Disabling macro sup-
port or shifting to StarOffice can prevent
Word Macro viruses from spreading.

Danger Zone: Software More Prone to Attacks
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My mom never liked uncer-
tainty. Just like I hated crash-
ing operating systems, she
hated uncertainty. I knew I

had to make her life smoother and get her
hooked to the non-crashing, reliable Tux
who comes with no frills, is extremely
cheap, and stays fit thanks to its develop-
er friends the world over. Later, she told
me that what she loved best was the free-
dom to not ‘restart the relationship’ 
anymore! 

How it all began
The first thing I had to do was shift my
mom’s focus from the utilitarian, grey
Windows world to the spunkier, friendlier
realm of the Penguinista. Appearances
make all the difference. To get her to work

with Linux, I had to create the perfect
environment. Knowing the Tux’ strong
preferences and pickiness about the hard-
ware that it ran on, I first ensured that my
install would not be rudely surprised. A
quick check of mom’s machine was reas-
suring. Everything she had—from the
ubiquitous i815 motherboard to the stan-
dard issue Samsung monitor—were all well
supported. I had a choice between KDE
and Gnome. I chose KDE since it’s the eas-
ier interface to use and would appeal more
to my mother’s aesthetic eye. When
installing Linux, I installed both KDE and
Gnome. This would later help my mom
use applications of both shells and also
give her the flexibility to shift
between GUIs.

My mother is fussy, she needs a

separate user account (which can be set up
while installing), and I appeased this need
of hers by going to Start Application > Sys-
tem User Manager in KDE (you can do it
from the shell also) and creating a home
directory where she could store all her
files. I also knew that she would get uneasy
if things weren’t close at hand and organ-
ised; it made sense to put shortcuts to all
the applications she used on the desktop. 

Connecting to the world
While deciding the right browser for Tux,
I had a choice between Netscape Naviga-
tor, Mozilla and Konqueror. I could have
thrown in Opera as well except that it

meant another 5 MB download—an
hour’s waiting time—so I skipped that
one. Amongst these, I found Netscape

>> My mom is finally smitten by
the tux. 
>> Here’s how it happened…

>Look Mom,
no command lines!

ILLUSTRATION: Mahesh Benkar
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Navigator the most suitable for my mom
for the simple reason that it is the easiest
to use. Moreover, her little experience in
using Netscape on Windows would come
in handy here. 

Setting up Netscape Navigator is a
breeze. Just go to Edit > Preferences in
Netscape Navigator. Later, I accessed
Netscape Communicator from the Navi-
gator menu (Communicator > Messenger)
to configure it as her e-mail client. It is
pretty simple to use and set up, and I
entered the e-mail address, POP3 and
SMTP settings for her account. I also con-
figured Netscape to dial on demand (by
writing a script using the diald daemon—
a script that I would be happy to share
with your mom if she sends me her e-mail
ID) the Internet connection whenever my
mom tried to browse a site or

send/receive a message. I also cus-
tomised some applets using the
KDE Panel to notify my mom with
a sound whenever a new message
came for her. After some time, I had

to make do with the visual notification
as she got quite irritated with the beep
every 3 minutes. Even otherwise, I set up
a dial-up icon on her desktop using 
KPPP, the GUI dialler in KDE (made it
easy for my mom—all she has to do is
click on the icon and the
modem dials out on its own, and
using scripts, sends out the login
and password and connects. No
need to remember and type in
passwords.  

Cluttering the desktop
It’s easy to create shortcuts in
KDE. Right-click on the desktop
and select Create New > Link to
Application. Click on the KDE
icon in the ‘Properties for Pro-
gram’ desktop dialog box that
opens to select the icon you

want for the link. Now give a
name for the link in the Program
desktop’s text box, click on Exe-
cute tab, and give the path for the
application if you know it, else use the
Browse button to find its location. Usual-
ly, you should find the application in the
directory /usr/bin. Click OK and you’re
done. Easy, isn’t it?

I find Konqueror, the default browser
that comes with KDE, a good file manag-
er and it is again very easy to use. When
Konqueror opens it directly takes my
mom to her home directory, so she also
doesn’t have much of a problem with
directories. 

My mother usually has problems

opening different types of files. 
I normally give her a small briefing
when it comes to this. She knows
most of the files will be opened

with the application with which it is asso-
ciated. In case of files that cannot be
opened by default, she right-clicks on the
file and selects the Open with...option
from the menu that pops up. I gave her a
small tutorial on how to identify the type
of application by looking at the file exten-
sions, which she understood quickly.
Very soon, she was off making her own
associations.

Chatting and opening up
My mom loves to chat, and it makes no

difference if she
can’t see her part-
ners physically.
She’s familiar with
the instant messag-
ing phenomenon
and has used MSN
Messenger. There
are instant messen-
ger (IM) clients
available for Linux
that allow you to
use MSN Messenger

and other IMs like
Yahoo! and ICQ.
Licq is the Linux
version of ICQ. 

In case of other
services such as
MSN, Yahoo!, AOL,
etc, Gaim is the
messenger client to
use. This messenger

for Linux has plugins which help
log on to MSN, Yahoo!, ICQ, IRC,
etc. The default Gaim configura-
tion allows you to use only AOL. To
use the other services, you have to
add plugins. I added a plugin to log
on to MSN by clicking on the Plugins but-
ton in Gaim to get the Gaim-Plugins 
dialog box. 

Click on the Load button. This brings
up the Gaim-Plugin List. 

In the list, select libmsn.so and click
OK. The MSN plugin will be added in
Gaim. Enter the MSN user ID and 
password in the main window to log on
to MSN. For example, I had created 
my mom’s Hotmail ID as Mother-
goose@hotmail.com. I entered Mother-
goose as screen name in the Gaim-Login
dialog box. She wasn’t too happy and put
her password as ‘mysonisanidiot’.

1. Create a shortcut
on your desktop

2. Use the Gaim Mes-
senger to access
the MSN network

3. Configure
Netscape Messen-
ger to access your
e-mail account

The best thing about Linux is that almost
all the programs are available for free. If
you need more programs, just download
them off the Net. www.freshmeat.net,
www.sourceforge.net and www.
rpmfind.net are great places to get started
with some really cool programs. Just type
in a few words about the kind of applica-
tion you need in the search area of
SourceForge or any of the other sites men-
tioned here. Or you can use the software

map link in the SourceForge main page to
find the kind of application you need. 
Newbies need help sometimes when they
are alone with Tux. Where do they look for
it? www.penguinmagazine.com is a site for
Linux rookies which should be able to
clear most of the doubts. You can use the
message board at the site to get answers
to most of your questions. Another place
where you’ll be able to get answers is
www. linuxnewbie.org. 

>Help for the Uninitiated
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Upon her word
From the Microsoft stable, my mother
hates just one software: Microsoft Word.
She absolutely blows her top at the ‘gram-
matical intrusions’ and generally seems
irritated when working with Microsoft
Word, but she’s used to it. I’d got her
Notepad earlier but she started sending
mails with too many mistakes. Now I’ve
got her AbiWord.

KWord is a good word processor but
can’t perform too well when it comes to
output quality, especially in comparison
to Microsoft Word. This is where Abi-
Word steps in. In terms of usage and out-

put, it is very similar to MS
Word. My mom is quite
happy with it.  

AbiWord can be found in Start Appli-
cation > Applications > AbiWord. And I 
didn’t forget to create a shortcut for it on
the desktop. 

Movies with Tux
My mom likes movies—it doesn’t matter
how they play or what software they play
on as long as they play fine and open on

the entire screen. I let her choose between
KDE Media Player and GTV MPEG Play-
er, and left both the icons on the desk-
top, saying ‘Movies Here’. Just in case you
are thinking of doing the same for your
mom, remember you need to have
Gnome installed for using the GTV MPEG
Player. 

A note for the DivX guys too: Default
media players such as KDE Media
Player do not support DivX. You
have to download DivX and
install it on your Linux box
before you can watch all those
wonderful files. Download it
from http://mpeglib.sourceforge.net.

Uncompress the .gzip file using the
gunzip command at shell. Now extract
the .tar file using the command. For

example, if the file name is
mpeglib_divxplugin-0.1.8.tar, then the
command is
tar xvf mpeglib_divxplugin-0.1.8.tar
Change to the created directory using 
cd mpeglib_divxplugin-0.1.8
Now use the following commands to
install DivX: 
./configure
make 
make install
make clear

All a good movie now needs is a good
set of speakers. There’s nothing better
than an old classic in the afternoons for
your mom to unwind after a hard day’s
work.

For any musical family, XMMS is the
audio player I would recommend. It is
Winamp’s clone for Linux, easy-to-use,
and has the same shortcuts as Winamp.
My mom knows Winamp pretty well
enough (she can play, stop, choose songs,
and increase volume) and appeared com-
fortable with XMMS. Of course, I added a
shortcut on the desktop.

Autorunning CDs
Most Linux flavours do not allow
autorun of CDs, not as of now at least.
Download and install a utility called

Autorun, a CD mounting utility
that allows you to autorun CDs.
You’ll get it at http:/ sourceforge.
net/projects/ autorun.

I had to do a bit of tweaking
after installing Autorun since
autorunning CDs is usually avail-

able only if you log in as root. To allow
other users to autorun CDs, add user, exec
options to the CD-ROM line in /etc/fstab.
This ought to get all those autorun CDs
zipping. 

Mom’s a sport
Though my mom is not much into
games, I have known a few mates whose
moms are avid gamers! Most Linux
flavours come bundled with loads of
games. While installing Linux I added
games to the install list and got in a cou-
ple of games such as Tetris, Mahjongg,
Poker, Minesweeper, etc. 

Now my mom can do all her comput-
ing chores by herself and doesn’t even
need my help for entertainment. I kept a
soft toy, a Tux-like penguin actually, on
the monitor and she hasn’t taken it away
till now. I’m telling you she’s in love with
Tux and he’s here to stay.

ANIL PATRICK R. 
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As a Linux user and developer you
might find it much more productive to
have your mom use Linux than Win-
dows. Here are four reasons why:
" Saves the trouble of setting up a dual
partition.
" In Linux, user privileges and rights
are well-defined and there’s no way
your mom or anybody can access your
files or other applications without the
appropriate rights.
" You can have an application running
simultaneously under your username as
well as your mom’s.
" Run multiple processes in the back-
ground while your mom works.

Why Mom Needs Linux

To set up a printer, just go to the KDE
Control Panel, select Printer Configuration,
enter the root password and in the 
printconfig-gui dialog box, click on the
New icon. 

This brings up
the Add a
New Print
Queue wizard.
Click on Next.
Enter the
Printer name

and select the Local
Printer option. Click
on Next, and you
will be able to see
the printer. If you
cannot see the

printer, click on Rescan Devices. 
If it still doesn’t appear in the table, click
on the Custom Device tab. 

In the Question dialog box, enter
/dev/lp0, which is the default device set-

ting for most print-
ers. Click on OK and
you will be able to
see the printer
added to the queue.
Now click on Next
and select the print-
er driver from the
list. Click on Next
again and then Fin-
ish. The printer is
added. Fire a print
to see if it works.

>Setting up a Printer in Linux

Create a shortcut to your printer
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Dying to get your friends swooning
over your own music? Waiting des-
perately to compose a song to
impress your girlfriend? No sweat.

Remix and add your own inimitable stamp to
your favourite songs or, what’s better, compose
your own album. You need to start off with a
PC, some really neat software, healthy doses
of patience, a sense of music and harmony,
and you’re all set to create your own home 
studio.

Remixing music and playing the DJ is fun
with user-friendly software such as the Mixman.
This software lets you add effects such as cross-
fading (see glossary) and increasing the beats of
the song, or EZ-Mixer and PCDJ, which let you
create playlists and play two tracks simultane-
ously to a lively euphony. If you are adventur-
ous enough, you can go a step further and add
beats to your songs.

Your own studio 
You don’t need expensive hardware to get start-
ed. A remix software, remixable tracks and
sound samples should be good enough. Fruity-
Loops, a loop and music creation software, lets
you create loops from sounds, and
sequencers such as ACID Pro help you knit
your loops and tracks to create an original
song. You may also need sound editors
such as SoundForge or CoolEdit Pro to
tweak loops and add final touches to your
tune. (See box ‘Remixing Freebies on the Net’
and ‘What you need’.)

Most of the professionally used remix
software are fairly expensive but you can
mix, remix, edit, rip, burn, encode and
perform a whole host of tweaks and edit-
ing right there. You won’t find freeware or
shareware remix software but the demo
versions of professional software, for

example, ACID Xpress 3.0 and FruityLoops 3.0,
are good too.

On ACID 
ACID Xpress is a sequencer that lets you layer
and manipulate all your sound loops together
in the order and sequence that you like. You’ll
need DirectX 8.1 installed to get ACID Xpress
running on your PC. 

The work area in ACID has three main sec-
tions—Window Docking area, an Explorer-style
interface that lets you browse through folders to
locate your tracks and loops; a Track List which
lets you view and control individual tracks; and
a Track View where you get the individual ele-
ments of your song together. 

The ACID Xpress demo version doesn’t
come with its own songs, tracks or content to
play around with. You’ll need to download
tracks and loops. 

Drag your tracks and loops from the Win-
dow Docking area to the Track List to begin 
getting your song together. You can even drag
a full-length track to ACID and add different
loops and tunes to it. You don’t need to 
convert files to different formats as ACID

The workspace in ACID Xpress

You don't need a fancy PC to set up a home
studio, but make sure you have the following to
run remix software:
xGood processor speed of at least 350-400 MHz
to run remix software 
xAt least 64 MB of RAM, but generally 128 MB
recommended 
x The more disk space the better. You’ll need
around 100 MB for program installation and for
storing loop and sound libraries and remixes
xA soundcard that supports DirectX 
xCD-ROM drive

xCD-Writer (if you plan to burn CDs)
xMicrophone for voice recording
xHeadphones or speakers (you need to hear what
you’re remixing, right?) 
xWindows 95/98, Me or 2000, though some
software won’t work with Windows NT 
xMicrosoft DirectX  
x SVGA Graphics (800x600 minimum resolution
at 16-bit colour depth) 
x Patience. Lots of it. Remixing is hard work

What you Need

SCRATCH. RIFF. AND LET RIP. BE YOUR OWN DJ AND GROOVE WITH REMIXED

MUSIC CREATED IN YOUR OWN HOME STUDIO

IMAGING: Ashwin Boricha



accepts WAV and MP3 formats as well as
the .acd format.

Once all your tracks are in the Track
List, you can layout the sequence or order
of the loops or sounds on the Track View
by simply drawing them in, and playing
them together to see how they sound. 

If you want to change the order of the
loops, simply shift them around on the
Track View. You can easily adjust the beats
per minute (BPM) and keep dragging and
deleting tracks as many times as you
want. ACID automatically time-stretches
samples so that they fit into the tempo of
the song you are working on.

ACID Pro saves your mix in the .acd
format, which is compatible with a lot of
other software such as Cakewalk. You can
even record from an audio device plugged
into a soundcard, record your mix and
play it back.

The ACID Pro version lets you rip and
burn CDs and save files,
but all this is disabled in
ACID Xpress, the demo
version. Exporting or
saving is also disabled
but you can record
your mix and play it
back. Use the demo version
to get a hang of the soft-
ware and how to remix
music. Later, when you’re
sure that you think of
remixing as something
more than a hobby, you
can invest in the Profes-
sional version.

Sonic Foundry, the
developers of ACID, have a
portal called www.acidplan-
et.com where you can

download loops and samples and publish
your music. 

Some Trance please
Browsing through available sound sam-
ples won’t satisfy you. Create your own
loops or even some trance music with 
FruityLoops. 

FruityLoops can be a bit intimidating
at first with its array of controls and set-
tings. Stick with it and you’ll find that it’s
not that tough to create basic tunes—
things get easier as you get the hang of it.

Let’s first understand how FruityLoops
creates loops. This is a pattern-based
sequencer, which means that you compose
your songs in pieces or patterns that you
later put together to make a tune or a loop.

You create patterns using the sound library,
which has instrument sounds, drumbeats,
synthesiser sounds, vocal sounds and even
full-length tracks. It also has built-in gen-
erators that use the sounds to get the
melody going.

Now let’s help you create your first
pattern. The top bar of FruityLoops con-
tains the menu, the volume and tempo
controls, and the beat counter. There are
a lot of ‘floating menus’ such as the
Browser which gives you easy access to
the sound libraries, loop generators and
channel settings—the place where you
add effects to your tunes.

Close all menus except for the Brows-
er and the channel window (see screen-
shot). You’ll see a channel window with
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Beats: A pulsing unit of musical time is
considered a beat.
Crossfading: An audio editing technique
in which one sound is faded out as another
moves in, allowing for a smooth transition
between the two. Crossfading is common
in samplers, where it is used to smoothen
loop transitions (crossfade looping) and
sound design to create hybrid sounds (one
sound morphing or turning into another). 
Loop: A sound that continually repeats
itself over and over again. 
Mixer: A device used to combine and
adjust sounds from a variety of sources in
order to create a final recorded audio
product, such as the soundtrack of a
movie.
Notes: The symbol used to indicate the
duration and pitch of each sound. Also
used to describe the actual sounds pro-

duced by an instrument when reproducing
the tones indicated by these written 
symbols.
Samplers: Recording devices that can
record almost any sound digitally and
make this recording accessible to a synthe-
sizer or computer.
Sequencers: An electronic device or soft-
ware program that can be instructed to
order and modify digitally stored musical
sounds for playback, as through a 
synthesizer.
Tempo: The speed at which a piece of
music is played is referred to as its tempo.
Tracks: Any piece of music on a record-
ed and playback medium is referred to as
a track. ‘Track’ is also used to refer to a
single aspect of music that has been
recorded in the ‘record’ production
process.

Glossary

Remix Tools
■ Cakewalk Plasma and Cakewalk

Club: Tracks for loop creation and
remixing

■ Sound Forge 5.0 and Cool Edit
Pro: Audio editors for tweaking loops
and audio files

■ Reason: A sophisticated synthesiser
studio system with a sequencer; great
for remixing

■ Cubase VST: A fairly complex audio
recording and editing software used
by professional remix artists

■ Other popular software: Mixman
Studio, Groovemaker 2.0, PCDJ Sil-
ver, Ez-Mixer and Rave Ejay

To get a hang

of what sound

effects to

use and

how to

sequence

patterns, load a

song that

comes with the

FruityLoops

library and

notice how the

remixer has

used patterns

and elements

for your guide-

lines.

Pick your
sounds and
loops from
the
FruityLoops
browser

Set volume
or adjust the
BPM and
record
sounds from
here

Drag sounds from the browser
here to generate loops

Use Channel Settings to add
effects to your tunes

Creating your own Tunes in FruityLoops



channels or generators such as TS404,
C_snare, etc. To get a beat going, right-
click the generator button, say, TS404 and
set the basic tempo. For example, for a
faster beat pick ‘Fill each two steps’ or ‘Fill
each eight steps’ for a slower beat. Hit the
Play button on the top bar and you'll
have your first basic beat playing. 

The beat
The channel window is somewhat like a
‘beat map’—there’s an indicator of the beat
that’s playing. The buttons let you manip-
ulate the frequency of the beat. You can
stick with a beat playing at regular, faster or
slower intervals or you can have irregular
beats. Just click on the buttons to select a
beat and right-click to ‘mute’ that beat.

The beat that you’ll have playing is
the same note playing at the interval that
you’ve set. You’ll need to set different
notes to each beat. The Piano Roll is
where you can do this. Select a channel,
say TS404, and click the Piano Roll button
at the upper right corner of the window.
You’ll see a keyboard map for each beat.
Here’s where you select the note for each
beat. It helps if you know a bit about
musical notations but even if you don’t,
just play around till you hear something
that sounds good. 

Click on the TS404 button to activate
the channel settings. This is where you
add effects such as delays and distortions,
and control the pitch and tempo. Each
channel has different settings; there are
way too many to talk about all of them
here. When you’re learning to remix,
stick with the simple effects and use the
FruityLoops manual to figure out what
each effect can do to your loop.

Drag in more sounds such as drums
or synthesiser sounds and generate loops
and tunes the same way. Keep experi-
menting till you’re satisfied with what
you’ve created. This is how you get a pat-
tern or loop done. You can create more
patterns based on different elements,
sounds or vocals.

Now you need to bring these patterns
together to the FruityLoops playlist and
play them together in a sequence. You
can have just two or three patterns or sev-
eral depending on how complex you
want your loop to sound. Play around
with the sequence of the loop by moving
around your patterns with your mouse. 

You can save your project in different
formats in the complete version, but saving
is disabled in the demo version. You can,
however, export to WAV, MP3 and MIDI in
the demo version through File > Export.

After you export your file as an MP3, you
can drag it into ACID to get it together with
the other tunes that you have.

If you have an ear for perfection, you
might want to edit your loops in an audio
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Copyrights:
How not to go wrong
Hold it right there! Before you start get-
ting all musical, you’ll need to check
about this one little thing that could get
you in big trouble. Most songs produced
today are protected by copyright and
can’t be remixed, edited or distributed in
any way, and that includes the free
music you download from sites such as
MP3.com. So make sure you read the
fine print before remixing anything. Sites
such as Mixman offer remixable tracks of
popular music but you’re restricted to a
particular file format and the Mixman
software. In addition, you can broadcast
it only on the Mixman Web site.
However, some artistes do offer tracks
that they have created for remixes. If
you do find a song that you would like
to work on, check with the composer or
the person who created the song
before remixing it.

Ever

Wondered what the experts use to mix
their music? DJ and musician Bally Mix-

master’ Sagoo pioneerd the remix genre
with Chura Liya way back in the 1990s. 
“Computers have been the most signif-

icant thing ever to hit the
music scene world-

wide,” says Sagoo.
“With all these

great new pro-
grammes, soft-
ware and down-
loads coming out
each day, you can
stretch, move,

pitch correct, sam-
ple and manipulate

sounds. When I start-
ed mixing  in 1974, I
could only dream of
doing this.” Now
with computers,
the sky’s the limit!

“At the
moment, I use a

Macintosh system with several programs, mainly using a sequence
program called Logic Audio Platinum,” explains Sagoo. He also owns
two state-of-the-art professional recording studios in the UK where he
works with many famous artists from all over the world, one of which
is called BSP Studios (Bally Sagoo Productions). It is here that he’s set
up his own record label, Ishq Records, and where he produces and
writes everyday.

Plan to be a DJ? Sagoo recommends that you get a set of good
turntables such as TECHNICS SL1200, a good DJ Mixer with EQ
(equalisers) on each channel, and a good CD Mixer. 

To get into the groove with remixing, Bally suggests: “You need
to spend each and every day getting into mixing from the one side
to the other till you feel that you can do fancier stuff like scratching
and dropping. When you feel a little more confident, try playing at
some parties, entertain your friends and get their feedback. This way
you get to ‘test drive’ your home grown mixes at clubs, before you’re
ready to release your own creation. This is what I do! 

“You can use computers to take your work to a totally different
dimension,” adds Sagoo. “The best remixers in the world are most
definitely DJs or producers who also use computers. 

“Being a good remixer is all about having a great knowledge on
music, owning a serious music collection, knowing the type of trends
that are making noise everywhere, being confident, experimental,
and having a great taste about how mixes and blends work while
remixing. So, get your decks out and start scratching.” 
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“Get your decks out and start scratching”— Bally Sagoo
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editor such as Sound Forge. But this isn’t
absolutely necessary if you’re just mixing
for fun and are not too concerned about
professional sound quality. You can skip
the editing process and just run the final
remix through Sound Forge and give it a
few effects, as well as add finishing touch-

es such as normalising, removing spaces
or silences and compressing your files.

Exporting your work
WAV, MP3 and MIDI are the file formats
supported by almost all remix software.
Most samples are available in WAV and

MP3. Audio recording is done in MIDI but
you can use an encoder to convert to
MP3. Ideally, you should work in either
WAV or MP3 but you should avoid too
much of conversion from one file format
to another as you’ll lose out on sound
quality.

Play that loony tune now!
We’ve shown you how to get started with
the ‘technology’ aspect of remixing just to
get a few basic tunes going. For the ‘musi-
cal’ aspect of remixing, check out Web sites
such as www.remixworld.com, www.remix-
mag.com and www.intermusic.com. Remix-
world.com even has different types of
remix projects that you can participate in.
You should hang out at forums on sites
such as Mixman.com and Computermu-
sic.co.uk where you can interact with other
music enthusiasts and pick up tips and
remix techniques from DJs or remix artists.

You can upload your tunes on to your
Web site or burn it on CDs to broadcast
your remix or distribute it to friends. If
it’s your own original creation, then you
have absolutely no problem. So what are
you waiting for? Get the world 
grooving.

AVINA LOBO

If you’re remixing for the first time and
don’t want to spend on software or sam-
ples, there’s lots of free stuff on the Net. 
1. www.hitsquad.com: Offers a huge col-
lection of music software downloads. A
weekly music software newsletter alerts you
on the new releases 
2. www.audiotools.co.uk: Great for audio
software and tools, CD rippers, encoders,
converters and mixing tools
3. www.harmony-central.com: Latest
news on music-making and download soft-
ware. The section on computer music has
software reviews and forums
4. www.soniccontrol.com: This site has
good content, downloads, reviews and
forums for computer music creation and
remixing

5. www.synthzone.com: Download music
loops, samples and digital audio software
6. www.samplenet.co.uk: Free music loops
and samples and FX in WAV and MP3 format
7. www.sonicfoundry.com: Download
loops in the .acd file format for ACID Pro
and ACID Xpress (www.sonicfoundry.com/
Loop_Libraries/default.asp?) 
8. www.traxinspace.com/music: Great
place to locate remixable tracks and free
samples
9. www.flashkit.com/loops: Offers a wide
collection of sound loops—country, jazz,
tribal, classical and techno in various formats 
10. www.samplecity.net: Wide collection
of free sounds, from piano samples to kicks,
vocals and sound effects such as air raid
sirens and door knocks

10 Remixing Freebies on the Web

1/2 H AD
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Need a Palm to code for a Palm? Not really. You can code and test
applications meant for different platforms on your PC…if you know how 

open
platform

You want to develop an applica-
tion for a mobile phone, a PDA
or perhaps for Linux, but you
have only one PC with Windows

installed on it. You could write the code
in Windows but to test it, the normal
process would be to have an assembly line
of machines with the relevant operating
systems (OSes) and compilers installed.
But this obviously increases the cost of
development. Even installing multiple
OSes on different partitions would entail
extra time and effort in switching from
one OS to another. 

A cost-effective solution, especially
for students and rookies, is to set up a
multi-platform development unit on a
single PC, converting your PC into a Swiss
Army knife kind of development platform
using certain software and emulators. 

Starting blocks
The least you would need for such a setup
is a PC with at least a 500 MHz processor,
256 MB of RAM and a 20 GB hard disk.
Anything less than this and you might
not be able to run other applications
while developing. After all, we are talking
about running a whole bunch of devel-
opment tools and platforms at the same
time, which will hog a sizeable amount
of processing power. 

It’s best to install Windows 2000/NT
as the base OS on which you can install
all your tools. This platform supports
almost all the development tools you’ll
need. The support factor is especially
important when it comes to developing
for mobile applications, and most mobile
development tools are built to operate on
the NT platform. It is also pretty stable
and user-friendly. 

If you want to develop for Linux
using Windows, you can use applications
such as VMWare. Also check out for
development issues within Linux. Sever-
al free development tools are also avail-
able for Windows, and unless you are real-
ly good at Linux, Windows 2000 will do. 

Once these are in place, you can
install software that allow for virtual
machines to be created or use software
development kits and emulators specifi-
cally built for multi-platform use. 

VMware your PC
VMware Workstation (version 3.0 is the
current one) is a desktop application that
will help you run different OSes on one
PC. It creates virtual machines inside a
single computer, which can interact with

each other through a virtual network set
up by the software inside your PC. For
example, if you have Windows 2000
installed on your machine and also want
to install Linux, you have to make your
PC a dual boot system with a separate par-
tition for Linux. With VMware Worksta-
tion you can install Linux as a virtual
machine running at the same time as
Windows 2000. It can run several such
OSes at once, allowing you to test your
applications across a virtual network of
different platforms. (See the box, ‘Using
VMware to set up Guest Operating Systems’) 

MS DOS, Windows (versions 3.11 to
XP), Linux (Red Hat, SuSE, and Mandrake)
and FreeBSD are supported as guest oper-
ating systems, which means you can run
these in VMware Workstation after
installing them. You can install other OSes
but they may not function properly.

You can also buy VMware Worksta-
tion with pre-installed guest OSes, but
you have to pay more for these packages.
A 30-day evaluation version of VMware
Workstation is available from
www.vmware.com. You will have to regis-
ter before downloading it to get the eval-
uation license number. 

Go mobile!
To develop for the mobile platforms you
can make do with emulators that can be
installed on the desktop. But before you
start, you need to have some basic utilities
on your PC, all of which are available as
free downloads. 

To develop for the Palm, the SDK (Soft-
ware Development Kit) of choice is SDK
3.5, which you can get from the Palm

O N E PC, MANY PLATFORMS

Jack of all Trades
In addition to Java, several languages
offer Virtual Machines (VMs) for multi-
ple platforms. Programs developed in
these languages can run on platforms
other than the ones in which they
were developed. If you want to devel-
op for Windows, Linux, and Palm, use
Python. If Windows and Linux are
your target platforms, you can use
PHP, Perl, and Rebol. If you want to
add a graphical interface to the appli-
cations you develop with these lan-
guages, there are tools for that as well.
You will need Cygwin and 
either GTK or QT windowing libraries
for this.



developers site. The next thing to have is
PRC-Tools, which is a GCC- (GNU C Com-
piler) based compiler for development on
the Palm platform. (See box, ‘GCC Tools for
Palm’). Some of the C-C++ tools available
for development on the Palm OS are Visu-
al Form Designer and Teenie. If you are
willing to pay, get Metrowerks CodeWar-
rior, which is much better with visual
tools. You also need a (free) Palm emulator

and a Palm ROM dump used by the emu-
lator as otherwise you won’t be able to test
any of the code you develop.

To develop for the Pocket PC, you
would need Microsoft Visual eMbedded
Tools 3.0, which consists of eMbedded
Visual Basic, eMbedded Visual C++, and
SDKs for Pocket PC.

Let’s have a look at how we can use the
emulator to test a program for Pocket PC—
say, using eMbedded Visual Basic. When
the application is ready to be tested, select
Run in the project menu. This will compile
the program and run it in the emulator. 

If you want to transfer the application
to a Pocket PC and run it, select the 

Pocket PC (Default
Device) option in the
drop-down menu as
shown. This will run
the application in
your Pocket PC
device.

Yet another tool
you may require is
the Java 2 Platform
Micro Edition 2
(J2ME), Wireless
Toolkit. This toolkit
helps you develop

applications for mobile phones, two-way
pagers and PDAs and works on the Pock-
etPC and the Palm as well. You need to
have Java 2 runtime environment
installed on your PC to use J2ME. You
can also use the free Waba programming
platform.

There! That ought to start you going
with your development work. Add more
tools as you need. With this set up 
running, you’ll be able to develop and
test applications for a host of platforms.
Get, set and go ahead on the path to
code Nirvana. 

ANIL PATRICK R.
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Install VMware Workstation 3.0 on your computer and give the
registration number. 

Click on the New Virtual Machine icon in the main window and
choose the Typical option to create a new virtual machine with auto-
matic configuration. Click on Next and select the OS you want to
install as the guest OS. 

Let’s select Linux as the
guest OS for now. Click on
Next, give a name to the
virtual machine and browse
to select the location where
you want to create the virtu-
al disk. Click on Next to
bring up the Select Network
Connection dialog box. 
Of the four options, only
the last three are relevant if

you are setting up your PC at
home. The Use network address
translation (NAT) option allows
your virtual machine to access your
Internet connection directly with-
out you having to set it up. You can
create a virtual network within your
PC with the Use host-only network-
ing option. If you don’t want any

kind of network set up for
the virtual machine, select
the Do not use a network
connection option. Click on
Finish. You will be able to
see the details of your virtu-
al machine now. 

Now insert a bootable
CD or floppy disk to install
Linux. Click on the Power
On button to start the virtu-
al machine. Linux will be
installed in your virtual machine. Make sure to also install the devel-
opment tools that come with your Linux installation. 

One of the best programmer
tools available for Linux is GCC
(GNU C Compiler), which comes as
part of the developer tools package.
You can use GCC to program using
C or C++. Code all your programs
on a good editor program and run
the files. Some of the good editors
available for Linux are jEdit, Jext,
Scintilla, Glimmer, etc. Ensure that you select the Use the VMWare
Power Off button to switch off your virtual machine when you are
through with your day’s work.

Using VMware to set up Guest Operating Systems

Select ‘Typical’ to create a new
virtual machine

Select the appropriate network
connection

Insert a bootable CD or flop-
py to install the guest OS

Select the guest OS

1

2

Event emulation
in eMbedded
Visual Basic

3

4

Programming for the Palm
PRC-Tools is a compiler tools package,
which helps you build applications for
the Palm in C or C++. This package
consists of patched versions of GCC
(GNU C Compiler), binutils, GDB and
post-linker tools. If you are using Win-
dows as the platform on which you
want to use PRC-tools, you will need to
install Cygwin b20.1, PRC-Tools 2.1,
pilRC for Win 32, Palm OS SDK, and a
Palm OS emulator. If you are a Linux
user, you will need GCC 2.95, PRC
Tools 2.0, pilRC, Palm OS SDK, and the
Palm OS emulator. You can get all these
from the Palm OS site—both for Win-
dows and Linux users.  

www.palmos.com/dev: Development
tools for the Palm
http://sourceforge.net/projects/prc-
tools/: PRC development tools 
www.microsoft.com/mobile/: Emula-
tors and development tools for work on
mobile platforms
http://java.sun.com/: Toolkits for Java
www.wabasoft.com: Get the Waba pro-
gram from here
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It’s time to stop being a
victim. Turn the tables on

vicious spammers 

Romeo53@dhakdhak.com is at it
again! You’re looking at the 38th
message you’ve received in the
last couple of weeks from this e-

mail address. It also digs out from the
dark recesses of your consciousness that
disturbing e-mail you received from
another unknown person. You wish you
could find out who’s behind all of this.
Spam and more spam, anonymous e-mail
from people you can’t identify.

This seamy, not-so-great side of the
Internet is something we’re all familiar
with. Sure, you can always hit the [Delete]
key, but wouldn’t you rather find out who
is behind this nuisance and put a final
stop to the invasion of your Inbox?

On the digital trail
Just as a physical letter has an origin and
path by which it travels to the receiver, 

e-mail too originates from somewhere,
that is, the machine it was sent from

and the path by which it travelled
to you; for example different mail

servers that carry the message.
The same holds true for spam,

though most bulk e-mail
messages originate from

List serve IDs (automat-
ed mailing

lists). Simi-
larly, an

anonymous post directed at someone in a
newsgroup originates from a news server.

Hence, it’s possible to trace an anony-
mous e-mail to the machine it was sent
from or at least tell whether the e-mail
address is genuine or fake.

There are several possibilities when it
comes to the origin of an anonymous
mail. The most common one is when a
person creates a fictitious e-mail ID at a
site of a prominent e-mail service
provider, such as Yahoo! or Hotmail, and
sends e-mail from that ID. In this case
what you could do is send an e-mail to
abuse@e-mailprovider.com with a copy of
the mail that you received. For example:
abuse@yahoo.com if you receive a mail
from a Yahoo! ID or the postmaster at 
the Web site from which you received 
the mail. 

If it’s a well-known mail service
provider, such matters are taken very seri-
ously and the particular e-mail ID will be
blocked. But that won’t solve the prob-
lem, as it’s very easy for the person to reg-
ister another fake ID at some other site
and continue spamming you. 

Reading e-mail headers
When you receive an e-mail, it seems as
though the mail reached you directly
from the sender’s machine. But that’s not
how it happens. Typically, an e-mail 

passes through at least four computers on
its way from sender to receiver.

Every e-mail comes accompanied
with information about the path that it
travelled. This information is in its head-
er. That’s the place you should look at first
while trying to trace a mail.

If you’re using a mail client such as
Outlook Express or Netscape Communi-
cator, right-click the mail and select Prop-
erties or open the mail and go to File >
Properties. You’ll see a screen with two
tabs. The General Tab will give you basic

Armed for Defence
Arm yourself with these useful tools to
help you find who’s bothering you
online.

TJPing, a utility available at www.
topjimmy net/tjs, performs ping and
Traceroute functions and looks up IP
addresses. While doing a Traceroute, try
and avoid confusion by using Ping Plot-
ter, a visual Traceroute program avail-
able as freeware as well as shareware at
www.nessoft.com/pingplotter/down-
load.html.

Neotrace Express and Neotrace Pro
at www.neoworx.com/download/
default.asp help you trace the source of
an e-mail and protect yourself.

!
Track that nasty

e-m@il

ILLUSTRATION: Mahesh Benkar



information such as the e-mail address
from where the mail came, the size of the
mail, attachments, and the time it was
sent and received by you.

The Details tab is where you’ll see the
e-mail header. This is what a typical 
e-mail header looks like. 

Return-Path: <achanen@bemybabey.com>
Delivered-To: mohank@mmb4.vsnl. net.in
Received: from isa.es.kr (unknown
[211.184.249.61]) by mmb4.vsnl.net.in
(Postfix) with SMTP id 34621EE76 for
<mohank@giasbm01.vsnl.net.in>; Wed, 12
Dec 2001 05:43:22 +0530 (IST)
Received: from bronxcra.cx (unknown
[233.144.259.67]) by isa.es.kr (Postfix) with
SMTP id 34644BB76 for <mohank@gias-
bm01.vsnl.net.in>; Wed, 12 Dec 2001
05:43:22 +0530 (IST)
Received: (qmail 6042 invoked from net-
work); 27 Aug 2001 11:17:09 -0000
Received: from pppa96-
resalechicagometro13-5r7120.dialinx.net
(HELO gw08??192.168.227.32?)
(4.4.242.29) by 211.184.249.61 with
SMTP; 27 Aug 2001 11:17:09 -0000
Received: from mail4.bemybabey.com by
gw08 with ESMTP; Mon, 27 Aug 2001
06:10:54 -0400
Message-ID:
<00007a84395a$00001903$00005320@m
ail4.bemybabey.com>
To: <achanen@bemybabey.com>
From: achanen@bemybabey.com
Subject: Make It Happen! (Email Special)
21280
Date: Mon, 27 Aug 2001 06:10:52 -0400

The Received: header entry contains
the site from which the mail was sent and
the IP address from where the mail origi-
nated. The IP address could be of the
computer that’s connected to the Net or
more often the IP address of an ISP or the
proxy server (that is if the e-mail was sent
from a corporate LAN). It also contains
information about the SMTP servers or
other Web sites through which the mail
passed on its way to your computer. 

The important thing to realise here 
is that if a person is faking his e-mail
address or the SMTP servers through
which it passes, then there would be

many additional Received entries. In the
header above, most likely the mail has
been sent from Isa.es.kr and the rest of
them are false headers. Using the tracert
command, you can check which headers
are fake and which are genuine. 

The headers also contain information
about the time (mostly local time) and
the date the e-mail passed though that
particular server. The header has a mes-
sage ID, which is a unique ID assigned to
a message. The message ID here is: 
00007a84395a$00001903$00005320@mail
4.bemybabey.com

The latter half of the message ID
would contain the Web site from where
the mail came or an IP address.

What if I use Web mail?
You can still check the e-mail header.
Most e-mail service providers such as
Yahoo! or Hotmail, by default, don’t dis-
play the entire message header, but they
have an option to enable display of mes-
sage headers. In Hotmail, click on
Options and check Mail Display Settings.
You can choose to not display it at all or
choose from Basic, Full or Advanced
header display options.

At Yahoo! you’ll find message header
options at Options under Mail Prefer-
ences. You have a choice between Brief or
Full header display. 

Unfortunately, not all mail services let
you view the header information when
you need to complain to the site from
where the e-mail was sent or report the
matter to the police.

Performing a Traceroute
The Received: entry could either contain
the name of a Web site or an IP address.
To find out who the IP address belongs
to or the name of the site, you could
look up the IP address at a database of 
IP addresses. For example, a ‘whois’
search on the address at a site such as
www.internic.net/whois.html will help you
find out the registrar of the domain
name or the e-mail address of the
administrator.

You could also run a Traceroute on
the IP address to trace the e-mail to the
host Web site or server. Traceroute utilities
track the path taken by packets as they
travel from source to destination. A
Traceroute can be run from Windows
Start at Accessories > Command Prompt.
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In a cyber crime, it's the computer and
the storage media within the computer,
such as the hard disk, that hold the key to
uncovering the mystery. Cyber-forensics
or computer forensic science is a process
of extracting data from computer storage
media in an organised manner using a set
of tools and techniques. It's certainly not
a plug-and-play operation or a collection
of just physical evidence or data. It also
involves sifting through enormous
amounts of technological data collected;
interviewing suspects, narrowing down
suspects and piecing together a trail of
evidence that holds good in a court of
law.

Forensics analyses involves examining
free space on hard disks, examining the
file slack (the space from the end of a file
to the end of a storage cluster) for hidden

or deleted data, analysing Windows swap
files, etc. In fact it's possible for cyber-
forensics experts to even locate files that
have been consciously deleted. 

The various tools and forensics soft-
ware used in a cyber-forensics analysis
work with specific platforms such as Unix,
Linux, Windows, Macintosh, etc. They
include software such as DiskScrub,
DiskSearch or Net Threat Analyser from
companies like New Technologies Inc.
(www.forensics-intl.com) or enCase from
Guidance Software (www.guidance-soft-
ware.com).

In India, the Mumbai Cyber Crime Cell
works with Internet security consultants
such as CyberForensics India to help
uncover cyber crimes like hacking and
online credit card fraud.

Sniffing out the Spammer
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Just enter the command tracert and the IP
address. 

There are also a number of online
tools as well as software (see box, ‘Armed
for Defence’) that help you do a Traceroute
on an IP address such as
www.samspade.org/t/, or portscanning util-
ities at www.nscan.hypermart.net. One of
the best Traceroute tools is available at
http://network-tools.com.

Running a Traceroute will track the
route of IP addresses of the servers that
the e-mail went through to get to your 
e-mail account. You can look up all the IP
addresses and do a ‘whois’ look up to
trace the e-mail to the host. 

A red herring
Tracing an e-mail won’t always lead
directly to the culprit. Often, the actual
location of a computer will not match the
‘whois’ information.

On the Net, it’s very easy to forge 
e-mail addresses and headers. Several
online tools such as Anonymisers, Re-
mailers and other software allow people
to cover their tracks and wipe out all trace
of Internet activity while sending an 
e-mail or spam.

In certain cases, IP addresses can also
be ‘spoofed’ or forged to cover up the cul-
prit’s tracks. This happens mostly in hack-
ing cases and rarely with anonymous 
e-mail.

At best, tracing an e-mail will take
you to an ISP that has its own e-mail
address, or you could go through their
logs and find out the location of the per-
son who sent you the mail. 

“It could lead you to a company
proxy server connected to a corporate
LAN,” says Flynn Remedios from Cyber-
Forensics India, an organisation that
assists the Mumbai Cyber Crime cell in
investigating cases. He adds, “It’s difficult
to pinpoint the computer out of the sev-
eral on the company LAN that the e-mail
originated from. Proxy servers maintain
a log of all Internet activity within that
location.”

But hold on! You can’t just walk in
and ask for ISP logs or logs of the proxy
server. At the most, you can complain to
the ISP. You also can’t ask a company to

do anything about e-mail that originated
from their mail server.

Report it!
Here’s where the benefits of reporting a
cyber crime to the police come in. The
police can investigate and handle the trac-
ing of your e-mail as well as ask the ISP, or
anyone, for logs to find out the physical
location of the person who’s harassing you.

“But they can only do this if the per-
son who’s being harassed has lodged a
formal complaint,” says Remedios. The
police too have their share of problems
trying to track down cyber crime offend-
ers. “In most cases the computer that is
used in either hacking or a cyber crime is
located at a cyber cafe,” says Inspector 
I. M. Zahid. “Cyber cafes don’t keep a

record of the people using the computers
there, which adds to the problem of trac-
ing cyber crime culprits.” Additionally,
the most important factor is collecting
proof of the crime committed, which is
extremely difficult to do if the crime is
committed from a cyber cafe.

“The most important advantage of
going to the cops rather than trying to
trace the mail on your own is the com-
plete anonymity and protection of your
identity,” says Remedios.

So the next time you receive spam or
anonymous mail from someone you
don’t know, it would help to know a
thing or two about protecting yourself
online. But if you really want bring the
culprits to book, call the cyber cops!

AVINALOBO

You’ve received
a spate of dis-
turbing e-mail
and don’t know
whom to turn
to. Well, one
place that you
can count on to
take some
action is the
Cyber Crime
Cell of the

Mumbai and Bangalore police.
According to the IT Act chalked out in

2000, certain acts performed online such
as hacking, denial of service, spoofing,
spamming, pornography, cyber harass-
ment or cyber stalking by e-mail, IRC chat
or Usenet, credit card fraud and online
fraud, are considered punishable crimes
and persons found breaking the law can
be arrested, fined or imprisoned.

The Cyber Crime Cell at Mumbai, part
of the Economic Offences Wing of the
Greater Mumbai Police, was inaugurated
on December 18, 2000, to deal with 
the enforcement of cyber laws. (For 
more information check out www.ccic-
mumbai.com). The Cyber Crime Cell
works along with a technical committee

and an advisory committee that include
Vijay Mukhi and Amitabh Kumar (Director
- Operations, VSNL), to help nab cyber-
crooks.

According to Inspector I. M. Zahid of
the Cyber Crime Cell, every cyber crime
leaves behind a trail of evidence, which
can be tracked from the destination
machine to the machine from where an
offensive mail was sent, or the machine a
hacker used to break into a system.

“The important thing is to deconstruct
the crime and build a concrete trail of evi-
dence so that the case can be presented
in a court of law and withstand judicial
scrutiny,” adds Zahid.

“In cases of cyber harassment, most
victims are women and the person the
mail originates from is often someone
who’s known to the victim, like an ex-
fiancé or ex-boyfriend seeking revenge.”
He adds that there has been a spurt in 
e-mail crime and a fairly good percentage
of detection.

When you receive an anonymous or
offensive e-mail and need to report it,
preserving a copy of the e-mail in your
inbox is very important as that’s physical
evidence of the crime and will help the
cops trace the culprit.

Who can Help you?

I. M. ZAHID 
CYBER CRIME CELL, MUMBAI
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If you share your computer with others,
you can set up multiple user logins in
Windows XP and Windows 2000. 

Setting up multiple logins allows each
unique user to have his own tailored com-
puting environment. Images and music
are stored in personalised folders and,
above all, you don’t have to worry about
other users of the same machine tamper-
ing with your content. Here’s how to go
about it.

Creating user accounts
Windows XP
Click on Start > Control Panel >
User Accounts. Under ‘Pick a
task…’, click Create a New

Account. Enter the name for the account.
Either a real name or an alias will do.

Pick an account type and click Create
Account. You can create three types of user
accounts: a Computer Administrator
account where the user has unlimited
access, allowing him
or her to view and
modify files from
other user accounts.
A Limited account
gives the user access
to operate the com-
puter and run vari-
ous applications, but
not modify software
and hardware con-
tents.  The last type
of account offered in
Windows XP is the
Guest account. It
functions just like a Limited account
except that it is not password protected. 
Windows 2000
Right-click My Computer on the Desktop.
Then click on Manage. Of course we are
assuming that you have the administra-
tive rights on your PC. (If Windows 2000
gives you a warning that you do not have
enough privileges, contact the person who
installed the operating system.) Then click
on Local User and Group in the System
Tools section. Double-click on Users fold-

er and right-click on the white space. Click
on New User in the menu. Fill in the
details and click on the Create button.
Then click on Close. Select the newly
formed user, click on Properties and then
click on the Member tab. Click on the Add
button and double-click on the type of
rights you want to give to the new user.
You can change the rights of the user at a
later date by following the same procedure
of selecting a user and then choosing the
Properties option.  

Changing your look
Windows XP

For each user that Windows XP
creates, an image is randomly
chosen for you and displayed
on top of the Start menu. You

can change it by clicking on an account to
change under User Accounts. Select
‘Change the picture’ and choose one that
you like. Browse for and change the desk-
top icons and views.
Windows 2000
Currently, Windows 2000 doesn’t have
the feature of your photo while logging
in, so you can only make do with cus-
tomising the desktop and Start menu set-
tings. Right-click on the desktop and
click on the Appearance, Screensaver, etc
tab to select the settings you want. Each
user can likewise maintain his own 
customised look. 

Speed it up…20 min 
Windows XP
Windows XP uses the Fast
User Switching feature; you
do not have to worry about

shutting down the PC or closing all active
tasks if someone needs urgent access to
the computer. Enable Fast User Switching
from Settings > Control Panel > User Accounts
and tick the Allow Fast User Switching fea-
ture under Change the way users log on
or off. 

After that, in the Start menu select Log
off and in the prompt select Switch user
instead of Log off. Once you log back in

under your profile, the system resumes
with all processes and tasks, and applica-
tions pick up from where you left off. 
Windows 2000
Unlike Windows XP, Windows 2000 does-
n’t allow 2 users to simultaneously log on.
So, for another user to take over, the current
user has to log off first.

PRASHANT MASRANI

Create Multiple Logins
Multiple User Logins in
Windows 98/Me

Windows 98/Me doesn’t allow protec-
tion of files but you can still create multi-
ple user profiles for customising and
maintaining at user level Desktop folder,
Documents menu, Start menu, Favorites
folder, Downloaded Web pages and a
separate My Documents folder.

To create User Profiles, you need to
first have Client for Microsoft Network-
ing Installed. For this, go to Start > Con-
trol Panel > Network, select the Add
Client option and add Client for
Microsoft Networking.

Restart your machine and then go to
Start > Control Panel > Users. Follow the
step-by-step wizard to create individual
user profiles. Restart for the settings to
take effect. At the login prompt now,
you have to enter the username and
password you have created for yourself. 

1
STEP

3
STEP

2
STEP
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Applications

Hardware and software
decoders

I have a problem with my
DVD player. I have a P-III 700
MHz CPU and Windows Me as
the OS. When I try to run a
DVD disk in Win DVD, 
which I obtained from C:\win-
dows\dvdplay. exe, I get the
following error message: ‘To
use the DVD player, you need
to install either a software
DVD decoder or a hardware
DVD decoder. For more infor-
mation click Help.’  What are
hardware and software
decoders and how can I get
these?
Ameya Sathye
Via e-mail

In order to play a DVD
disk, the DVD files on it
need to be decoded and dis-
played on your monitor.
There are two ways of doing
this, either by using a special
card (a DVD decoder card) or
a software that can read and
play DVD disks using the
system's main processor.
These are known as DVD
decoders. 

Hardware DVD decoders
usually cost significantly
more but for your needs,
your Pentium III 700 MHz
processor with a software

DVD decoder will be more
than capable.

Writer won’t write
I tried Nero Burning Rom

v5.4.4.8 Demo (October 2001,
Mindware) with my new CD-
Writer (HP CD-12 series) but
I’m experiencing some prob-
lems while writing/simulation.
After compilation, when I try
to write/simulate, it detects
both my CD-Writer and the
blank CD-R media disk but
shows an error, ‘Invalid field in
parameter. Aborting the job’. 
Sourav Basu
Via e-mail 

Make sure you have the
right ASPI drivers installed.
Also, according to the log file
you sent us, the DMA (Direct
Memory Access) for your
writer is off. Turn it on and
also turn Auto Insert
Notification off and
Disconnect on. You can get
the latest ASPI drivers from
Adaptec’s Web site if you use
any Adaptec software such as
Easy CD creator, that are
bundled along with your CD
Writer. This should solve
your problem. 

Tally error
I have a brand new PC with

the following configuration:
Pentium 4, 1.5 GHz, 256 MB

RAM, 40 GB hard disk and
Windows 98 SE running on it.
Tally 4.5 used to run smoothly
on my old PC (Pentium 100
MHz, 16 MB RAM, 1.9 GB
hard disk and Windows 98 SE
OS), but in this new configura-
tion it gives me the following
error: ‘Tally abnormal comple-
tion. Status:3. Insufficient files
provided by DOS. Internal
error. Contact Peutronics.’ 

The main thing is it works
fine in DOS mode without any
lines being added in
config.sys, but in Windows it
shows errors!
Ravi Meghani 
Via e-mail

You need to run Tally from
the command prompt mode
in Windows. Start a standard

command prompt, change to
the Tally folder by typing cd
C:\tally, and then run t.exe
from the command prompt
itself. The problem you’ve
encountered is because the

file is being run individually
by Windows in a separate
shell, like a temp folder. If
you create a shortcut that
sets the ‘run in’ folder of the
program to C:\tally, that
should solve the problem.

Word doesn’t check 
grammar

When I try to run a gram-
mar check in Microsoft Word
2000, I get the following error
message: ‘There was an unex-
pected error in the grammar
checker. Word cannot com-
plete the grammar check.’ I’ve
tried to solve this by unin-
stalling and installing Word
repeatedly, but all in vain. 
Nibhay Joshi 
Via e-mail 

It seems the pro-
gram Office2000 has
not been installed
properly. First unin-
stall Microsoft Office
by going to
Add/Remove pro-
grams. Then go to
Program files and
delete the Microsoft
Office folder. Lastly,

go to the registry and delete
the Microsoft Office registry
entries.

Before deleting any reg-
istry entries make sure you
take a backup. Now reinstall

Printing goof ups, missing RAM, Web page errors— 
get the fixes for your PC’s ailments 

Error while starting Tally

■ troubleshooting
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Microsoft Office and your
problem will be solved.

Printing problems
I use a Pentium III 900 MHz

CPU with 128 MB RAM and a
20 GB hard disk drive, running
on Windows Me. I recently
installed Office XP Professional,
but after that I have not been
able to print clipart or pictures
while working in Word or Pow-
erPoint XP. I have no problems
printing the images with other
applications. I tried the Help
menu in the Office XP trou-
bleshooter, which asked to
deselect the draft output fea-
ture, but that was not selected
in my application. I tried the
repair feature, reinstalling
Office and reinstalling my
printer driver, but to no avail. 
I had no problem printing 
pictures and clipart with 
Office 2000 and I also had no 
problem in printing borders
with art or shading in 
my document. 
Anshul Singh
Via e-mail

Try printing a heavy image
in any image-editing package,
even MS Paint. If that works
fine, then the problem is
surely with Office XP’s print
engine, otherwise it’s a print-
er cartridge problem. If it’s an
Office XP problem, first try
printing in high quality
mode and if that doesn’t
solve the problem, reinstall
the package. If that doesn’t
work either, remove and
clean the cartridge. Make sure
you buy the original cartridge
from the authorised dealer
and do not try to refill ink.

Deleted display drivers
I have a problem with my

laptop. I had installed a demo
game named Driver from the
Digit November 2001 CD.
When I tried removing the
game in Control Panel, I acci-
dentally removed the display
driver. 

Now my laptop’s screen
resolution has reduced to
640x480 pixels and 16-bit

colour. I tried to correct it from
Display Properties but it didn’t
work. Please help me. 
Anurag
Via e-mail

Since you have removed
your display drivers you will
have to reinstall them. You
can do this with the diskette
you would have received
from the manufacturer when
you bought the laptop.
These drivers are usually
available on the Web site of
the manufacturer, so you can
also download them. After
you have installed them you
will be able to change your
display settings. 

PRN files in Pagemaker 
I would like to create PRN

files in Pagemaker but am
unable to do so as I don’t get
an option to create such a file
in the page setup of Pagemak-
er. I have an HP Laserjet 6L
Gold printer. What should I do?
Bobby T. 
Via e-mail

In order to create PRN
files in Pagemaker you need
to enter a virtual Linotronics
printer driver to your print
folder and redirect the out-
put to a file. You can do this
by going to Control Panel >
Printers > Add Printer > Local
Printer > Print to File. When it
shows you a list of various
printers, select Linotronic
and install the drives. Then
enter the filename as a .prn
when it asks you for an 
output. Now you should 
be able to create PRN files 
in Pagemaker. 

Error loading Web pages
I am an amateur Web

designer. I registered at Geoci-
ties a year back and
started developing
my site. I built it in
Microsoft Word
2000 on a laptop
using the Web page
wizard embedded
in the software and
uploaded it using
Yahoo!’s FTP client.
When I viewed it
using IE 5.0 and
5.5, it gave an error
message, ‘Done,

but with errors in the page’, at
the bottom left corner. It also
gave me a runtime error and
the undetermined string con-
stant in line 566. Is this due to
HTML encoding errors? (I have
not used Java Scripts).
Shambho Mahadeva
Via e-mail

When Office exports doc-
uments to HTML, it includes
an XML data tag, which is
useless in general. This tag
looks something like this at
the beginning of the page: 
<html xmlns:o="urn:schemas-
microsoft-com:office:office"

xmlns:w="urn:schemas-microsoft-
com:office:word"
xmlns="http://www.w3.org/TR/RE
C-html40">
<head>
Change this tag to
<html>
<head>

Windows

Cannot print Outlook mail
I have a P-III, 733 MHz PC

with 96 MB RAM and an HP
Deskjet 640c printer. Of late, I
have been unable to take
printouts from Outlook
Express. When I try to print
selected messages by pressing
[CTRL] + [P] or the print icon
in the toolbar, the printer dia-
log box doesn’t appear and
there is no response. I’ve tried
printing from Microsoft Out-
look by importing messages
from Outlook Express but the
same error occurs. I also tried
uninstalling and reinstalling
the printer, but to no avail.
However, the printer works
well with Word and Excel.
Please suggest a remedy. 
Gokul 
Via e-mail 

Unable to watch TV using my graphics card
My machine configuration is as follows: Pentium 4, 1.5

GHz processor, Intel 850
DGB board, 128 MB
RDRAM, 32 MB ASUS 7100
Deluxe Combo graphics
card and a 40 GB hard disk
drive. I was able to watch
TV on my computer
through the ASUS card, but
after installing Windows XP,
the ASUS driver software
does not run. It gives an
error ‘Access violation’. I
tried installing the drivers
of this card in Windows 98
emulation option in Win-
dows XP but the program still does not run. Please help.
Sam Deshmukh
Via e-mail

The ASUS DVCR will not run till ASUS updates the soft-
ware to support XP. To use the DVCR software, you can
download nVidia’s latest drivers, which have their own
support for the TV out function. Otherwise you can down-
load the TVCC tool by going to www.tvtool.de.

Adding a Linotronic driver
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Uninstall Office XP, delete
the folder it creates in the
Program files and also delete
the registry entries (type
regedit from Start > Run
and navigate to
HKEY_LOCAL_MACHINE/So
ftware/Microsoft/Office and
delete the folder). Make sure
you take a backup of the reg-
istry before making any
changes to it. Now reinstall
Office XP and your problem
should be solved. 

Using AVG in Windows NT
I have a Pentium III 500

MHz system with 128 MB
RAM and a 10 GB hard drive
with two partitions. One is of
2 GB (C) with FAT Windows
NT 4.0 and service pack 6
installed and the other is 8 GB
(D) with NTFS Windows 2000
professional installed. Of late I
am facing a problem: when I
run the anti-virus package
AVG 6.0 from the C drive and
try to scan drive D, it shows a
line at the top: ‘page_fault_
in_nonpaged_area’ and
restarts. After restarting I went

through event viewer of NT
and found an entry named
‘Save Dump’. When I opened
this event it showed me the
following lines: ‘the computer
has rebooted from a bug
check. The bug check was:
0x00000050 (0xc2080000,
0x00000000, 0x00000000,
0x00000000). Microsoft Win-
dows NT [v15.1381]. A dump
was saved in: C:\NTSERV-
ER\MEMORY.DMP.’
What’s the problem? 
Pravesh Taparia
Via e-mail

The problem seems to be
related to AVG 6.0 and NT.
Uninstall AVG, delete the
folder it creates in the pro-
gram file, and also go to the
registry and delete the
entries created by this pro-
gram. Make sure you take a
backup of the registry before
deleting any entries. Then
try reinstalling it.

Partition Problems
I have a P-III 450 MHz

based system with an Intel
440BX motherboard and

Award BIOS V4.51PG. 
I recently bought a 20 GB
hard drive to add to the exist-
ing 6.4 GB hard drive. The 6.4
GB hard drive is the Primary
Master with Windows 98 SE
and Red Hat Linux 7.0, CD-
ROM-primary slave. The 20
GB hard drive is set as a sec-
ondary slave with the entire
space being extended into
DOS partition without any pri-
mary DOS partition. I have
the following problems: In the
standard CMOS settings in
the BIOS, I have disabled the
20 GB hard disk by selecting
None in the corresponding
column. In spite of this, both
Windows and Linux recognise
all the partitions and I am able
to read/write data from/into
the 20 GB hard disk.
The second problem is that
the moment I enter User in
the standard CMOS settings
in the BIOS and go to Win-
dows, there appears an addi-
tional partition along with the
existing partitions on the 20
GB hard disk, displacing the
existing partitions’ drive let-
ters. In addition, this partition
is inaccessible and Windows
issues a ‘Cannot read from
drive E’ error message when I
shut down Windows.

Lastly, the hard disk activi-
ty indicator LED does not turn
off when I try to shut down
either Windows or Linux.
Dileep S. 
Via e-mail

To solve the first problem,
go to the BIOS and disable
the IDE controller or discon-
nect it. Now you won’t be
able to read or write data
from that hard drive. 

Regarding the second
problem, it seems that that
particular partition has not
been formatted and is thus
inaccessible. So if you are
sure that there is no data on
this partition, format it and
you will be able to access the
partition.

Lastly, it is absolutely nor-
mal to see your hard disk LED
indicator till you shut down

your PC completely. It will
turn off only when your com-
puter is switched off com-
pletely. So, there is nothing to
worry about.  

Hardware

Of DVDs and soundcards
I have recently bought a

Pentium 4, 1.5 MHz system
with 256 MB RDRAM and an
Intel motherboard. I also have
an SBLive! Platinum sound-
card and an ASUS GeForce 2
32 MB graphics card. The
speaker system is a DTT2500.
My problem is that although I
can play DVDs, the Dolby
Digital indicator in the ampli-
fier of my system has not yet
detected the Dolby Digital
signal as mentioned in the
user’s manual of the
DTT2500. 

I am told that while using
SBLive! Platinum and DTT
2500, only the amplifier
(DTT2500) needs to be con-
nected using a S/PDIF cable
and no line out and rear out is
required. But when I remove
the rear out and line out con-
nection, I don’t get any sound
while playing MP3s or other
music files, but there is no
problem while playing a DVD.
Can you verify this and tell me
how I can test that these con-
nections are made right?

The third problem I face is
that when I changed over
from Windows 98 to XP, I was
unable to install the driver
CDs and software of either the
Creative soundcard or the
ASUS graphics card. How can
I use the demos and the
remote centre, etc of the
SBLive! Platinum? 
C. J. Mathew
Via e-mail

In order to playback
Dolby Digital signals using
your DTT 2500s, you will
need to drive these speakers
digitally. These speakers have
a digital input that can be
supplied by your soundcard.
The SBLive! should have a
Digital Out connector—you

Cannot detect Web cam
I have the USB Card and the Intel Create and Share soft-

ware for my Web cam. I have installed the card and the soft-
ware in my PC. Everything works fine until the PC attempts
to detect the camera, at which point the PC hangs and then
restarts. After restarting, the following error shows up:
‘inst30.hlp files is missing in the CD. Try to reinstall the soft-
ware’. What should I do now? 
Shishir 
Via e-mail

Download the latest drivers from the manufacturer’s
Web site and the error should be fixed. Also, you are hav-
ing problems
with fully
installing the
software as you
probably have no
space on your
hard disk. Free
some space on
your hard disk by
running the Disk
Cleanup utility
or delete some
data.
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will need to feed this output
to your Digital In connector,
which is on the amplifier of
your speaker system. This
will enable true Dolby
Digital compliance and will
let you playback your DVDs
using AC-3 (that’s Dolby
Digital). This will not be pos-
sible if you are driving your
speakers only through the
four speaker inputs.

Regarding your second
query, what your friend said
is correct—you will need to
connect both the four-
channel outputs (for your
MP3 and gaming playback)
as well as your S/PDIF (for
Dolby Digital compliance)
for movies.

As for your third query,
both Creative (www.creative.com)
as well as nVidia
(www.nvidia.com) (for your
graphics card) have released
drivers that are compliant
with Windows XP. Use these
and you will be able to access
all the features of your hard-
ware like before.

Video card blues
A couple of months ago I

upgraded my graphics card to
a RIVA TNT2 M64 32 MB
card. My machine is a Celeron
300a and I have 114 MB
RAM. The problem is that the
system hangs whenever I run
games such as FIFA 2001 and
Quake III while games such as
Need for Speed 4 and FIFA 98
run smoothly. I tried reducing
the 3D acceleration, but all in
vain. What could be the rea-
son for this and what are the
remedies?
Jayanta Kumar Dey 
Via e-mail

Your problem can be easi-
ly solved. You can install the
drivers from the November
CD of Digit or else you can
visit nVidia’s Web site and
download the latest drivers
for your card. 

Low frame rates in UT
I am facing a problem

while running Unreal Tourna-

ment. I have an ASUS
GeForce2 MX 32 MB AGP
with a Creative SBLive! Value
soundcard, 256 MB RAM,
AMD Duron 600 MHz proces-
sor and DirectX 8.0. I run
Unreal in D3D with patch
4.36 at 1024x768x16 and
detail textures off. When 
I play it in Windows 98, I get
60 fps. But as SBLive! Value
doesn’t work in Windows 98, 
I installed Windows 98 SE and
my fps dropped to 30, and
further to 9 fps in the heat of
combat. What should I do?
Shikhar
Via e-mail

We would recommend
you to load the latest deto-
nator drivers (version 23.11)
for your graphics card and
the newest drivers for your
soundcard. Also remember to
load DirectX 8.1.

Half-duplex soundcard
I have a Pentium II machine

with 32 MB SDRAM, 20 GB
hard disk and Windows 98.
When I tried configuring MSN
Messenger, I got an error
message as follows: ‘*** Sorry
it is not possible to use a
microphone and speaker at
the same time with a half-
duplex soundcard in your
machine. You may need to
contact the soundcard manu-
facturer to update the device
driver. You will not be able to
use the voice or phone feature
of this program****’. My
soundcard is an Aztech 2320
compatible PNP audio
(WDM), hardware version
1.0.02. Is it possible to config-
ure voice chat with this
soundcard? The same prob-
lem occurred when I tried to
configure Yahoo! Messenger. 
Dhirender Nirwani
Via e-mail

Since you have a half-
duplex soundcard you can-
not speak and hear at the
same time. You will have to
buy a soundcard that is fully
duplex. There are a lot of
fully duplex soundcards
available in the market.

Disappearing RAM
I have a Pentium III 850

MHz system with 128 MB
SDRAM and a 20 GB hard
disk with four partitions,
namely C, D, E and F. I have
installed Windows NT 4 on
the primary partition C and
Windows 98 on the extended
partition D. A few days back
while restarting my computer
my monitor started flickering
while loading Windows 98
but it came back to normal
after booting. After that
when I checked my system
properties to see whether
there was any hardware fail-
ure, it showed that I had only
64 MB RAM installed in my
computer. I don’t know what
happened to the remaining
64 MB. I recently installed
Office XP. Could you please
tell me what has happened?
Has there been any hardware
failure, because there aren’t
any error messages being dis-
played, and there isn’t any
problem while booting the
computer? Or has one of my
RAM modules got corrupted,
in the sense, has it failed? 
Rohit 
Via e-mail

Check the memory at the
time the machine starts up.
If that too says 64 MB, then
you would need to replace
the faulty RAM module or
try plugging it into another
slot and see what happens.
As for your other problem,
the monitor flickering dur-
ing the setup, that’s usually
because of the lower refresh
rate used while running the
setup, hence this should not
be a cause for worry.

Scandisk error
I am running Windows Me

on a Duron 600 PC with 

192 MB RAM. It took about
50 minutes for a thorough
scan (with auto fix errors) of
the first partition (5 GB). No
messages were displayed dur-
ing the scan. However, for
the second partition (10 GB),
it took 11 hours for a thor-
ough scan (with auto fix
errors) and after 7 minutes
showed a message, ’Scan
disk has restarted 10 times
because Windows or other
program has been writing on
the drive, etc’. The above
message was displayed even
after disabling auto protect in
Norton AntiVirus 2001. 
Komal 
Via e-mail

There is nothing to worry
about as most people have a
similar experience while try-
ing to scan their disk or
defragment it as some pro-
gram or the other is usually

running in the background.
Due to this the Scandisk pro-
gram automatically restarts
without fully scanning.  To
overcome this problem,
make sure you start your
computer in safe mode or
ensure that you terminate all
programs running in the
background before doing the
scan.

Now you will be able to
scan your disk completely.

FAQs

Scan-disk utility in Windows 98

Send your problems to sos@jasubhai.com
or write in to Digit, D-222/2, Om Sagar, MIDC,
Nerul-400 706
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Working with multiple
identities
If you share a computer
and do not download mail
for fear that they’ll be read
by others, create different
user identities for secure
downloading. If Outlook
Express is your e-mail
client, go to Files > Identities
> Add New Identity. Create a
new identity, protect it with
a password, and choose this
the next time you start the
program. You will be
allowed access only after
you enter the right pass-
word. Don’t forget to log
out once you’re done. In
order to do that you will
have to go to File > Exit and
log off identity. 

Blocking senders
Unsolicited e-mail (spam)
can be quite irritating. To
stop this, block the senders
so that the next time they
send a mail, it goes straight
to the Deleted Items folder.
In case of Web-based e-mail
service, it’s obligatory for

your e-mail service provider
to offer you with this
option. If you’re using Out-
look Express, all you need to
do is select the message and
click on the Block Senders
option under Message in the
toolbar. Combine this with
the option under Tools >
Maintenance to ‘Empty Mes-
sages from the ‘Deleted
Items’ folder on exit’, and
you will be rid of many
spam mail.

You can access the
Blocked Senders list at a
future date from the
Blocked Senders tab in Tools
> Message Rules > Mail and.
An alternative way to
remove unwanted mail is to
create a message rule that
directly deletes the message
from the server without
downloading it. 

Receipt notification
If you have a really impor-
tant message and need to
know if it’s been received,
use a feature called Read
Receipt in Outlook Express.

This feature is available on
most e-mail clients and
requests the recipient to
confirm that he has
received the message by a
return e-mail. 

To do this while com-
posing a mail in Outlook
Express, click on Tools >
Request Read Receipt in your
message window. If you
desire, you can have all
your outgoing messages
sent with the Read Receipt
notification. For this, go to
Tools > Options, click on the
Receipts tab and tick
‘Request a read receipt for

all sent messages’. Remem-
ber, the read receipt confir-
mation is dependent on
the e-mail client the recipi-
ent is using and also
whether he wants to send
the confirmation.

Reduce message size 
Sending messages in HTML
format increases the file
size. The message size will
be lesser if one sends mes-
sages in Plain text format.
In Outlook Express, go to
Tools > Options > Send and
select the format in 
which you want to send
messages.

Adding signatures to
your e-mail
If you send a lot of mail
each day, then a repetitive
task like signing your name
at the end of each mail can
be quite tedious. It’s easier
to create a signature and
attach it automatically to
every mail that’s sent. To do
this in Outlook Express, go
to Tools > Options > Signa-
tures. Then go to New and
add the contents of the sig-
nature in the Edit Text
field. Also select the option
of sending the signature
automatically with all out-

going messages. In
case you don’t
want to send this
with replies or 
forwards, enable
the option, ‘Don’t
add signatures to
Replies and For-
ward’. For creative
signatures, use the
option to append
a file that contains
the signature you

have created. If you happen
to have multiple e-mail
accounts, select the account
with which you want to
send the signature. 

To do this, go to Tools >
Options > Signatures and click
on the Advanced 

E-MAIL AND CHAT

Sign off with a personal message

Request for receipt of mail 
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button near the Edit Signa-
ture tab. A new box will
appear saying ‘Advanced
Signature Settings’ where
you can select the account
with which the signature
should be automatically
added.  

Customise the mailbox
You can change the feel and
look of your mailbox, and
personalise it with the fonts
of your choice, along with a
view that you like. 

To change the default
font for all your outgoing
messages from Arial to
something better, go to Tools
> Options > Compose > Font Set-
tings and specify the font
and font size for all new
messages. 

To change the default layout
go to View > Layout. Here you
can change the way mes-
sages are viewed and remove
other components such as
the toolbar, status bar, folder
bar, etc. This will give a
neater look to your Outlook
Express. 

Customise your toolbar
The Outlook Express toolbar
is cluttered with many not-
so-useful icons. Right-click
on the toolbar and 
customise it by adding or
removing the icons; you can
also reduce the size of icons
and remove the text labels.

Disable MSN Messenger
from auto-starting
Whenever one opens 

Outlook Express or
Microsoft Outlook XP, MSN
Messenger loads automati-
cally. To disable it, go to
Tools > Options in Outlook
Express and uncheck ‘Auto-
matically log on to MSN

Messenger Service’.
Then go to View >
Layout and uncheck
the option of Con-
tacts. In Microsoft
Outlook XP, go to
Tools > Options > Other
and uncheck ‘Enable
MSN Messenger’.
The over-eager Mes-
senger won’t be so
eager now! 

Keep a copy of
the message 

If you are on a trip and
want to access your e-mail
from another machine, keep
a copy of your messages on
the server of your e-mail
service provider. 

Go to Tools > Accounts and
select the account (if you
have multiple accounts),
then go to Properties >
Advanced. Check ‘Leave a
copy on server’. 

This has one more
advantage: if you’ve format-
ted your machine without
taking a backup of your
mail, you can retrieve the
mail as a stored copy.

Autocomplete e-mail
addresses
Enable the AutoComplete
feature in Outlook Express
to automatically finish the
e-mail addresses after you
type the first letter in the
‘To’ column. Go to Tools >
Options > Send and check the
option, ‘Automatically com-
plete e-mail addresses while
composing’. This will make
it less tedious and save a lot
of time. 

Auto-respond facility
Won’t be checking mail for

A three-step process
to ensure that your

Inbox never looks
cluttered. 

1. Organising: Outlook Express
allows you to create folders
within which mail can be organ-
ised. To create a new folder in
Outlook Express, go to File >
Folder > New. This will display
the directory tree of your Inbox.
Just select the location (say
Inbox) where you want to create
a folder and enter the Folder
Name. Or, you could use the
shortcut [Ctrl] + [Shift] + [E] and
enter the Folder Name. You can
also drag and drop folders to
change their location. Folders
can be quite useful, especially if
you have multiple accounts con-
figured on the same identity or
to sort out e-mail messages on

the basis of sender, subject, etc. 
2. Filtering: Message Rules can
automatically sort your mail into
the appropriate folder as soon as
it is downloaded. Specify the
folders where you want the mes-
sages to be downloaded based
on names in the From address,
names in the To address, certain
words in the Subject line or in
the message body. 

Go to Message > Create
Rule From Message. Create a
rule selecting the appropriate
options offered, and the next
time you download your mail, it
will be sorted according to the
rules created. 

You can also sort your exist-
ing messages based on the mes-
sage rules created. In Outlook
Express, go to Tools > Message
Rules and click on Mail. You will

get a list of the message rules
you have created. Click on
‘Apply Now…’, select the rules
to apply, and click on Apply to
filter your existing folder.  
3. Grouping: Outlook Express
allows you to group e-mail mes-
sages on the basis of the conver-
sation carried. To enable this, go
to View > Current View and click
‘Group Messages by
Conversation’ (In Outlook, this
option is available from View >
Current View > Conversation
Topic). 

With this feature, all e-mail
messages are sorted on the basis
of the subject line and the mes-
sages that are a reply to that
particular subject are grouped
together. A ‘+’ sign next to a
message indicates responses
based on that subject. 

Optimising your Inbox

Disable MSN startup in Microsoft Outlook
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some time? Activate a fea-
ture called ‘vacation reply’
(if you are using a Web-
based service). Most e-mail
services such as Indiatimes
provide this feature which
can be activated through
the options menu.You can
type a short message which
will be sent to all who e-
mail you while you are
away. In Outlook Express,
you can do this from Tools >
Message Rules > Mail and
clicking on the New Rule
option. Select the ‘For all
Messages’ options from the
condition for your rule field
and in the Action select
Reply with a message. You
will have to select a message
that you have already creat-
ed and saved.

Change storage location 
By default, all your e-mail
messages are stored in a par-
ticular folder allocated by
Windows. You can change
this location by going to
Tools > Options > Maintenance
and clicking on the Store
Folder. This will display the
default location. Click on
the Change button and
select the new folder where
you would like to store 
your mail. 

Forwarding e-mail as
attachment
In cases where a message
needs a reply from a col-
league or a friend, you
should forward the mail to
that person as an attach-
ment. This will allow a reply
to be composed to the origi-
nal message without having
to create a new e-mail mes-
sage from scratch.

To do this just right-click
on the e-mail and select the
‘Forward as Attachment’
option or use the [Alt] + [M]
+ [D] shortcut in Outlook
Express.

Using voice chat
Most messengers such as
Yahoo!, MSN and ICQ allow
users to have voice chats.
You need a mike and a good
soundcard to use this facili-
ty. Voice chat is a conven-
ient way of communicating
and saves a lot of time and
money. To do so in Yahoo!
Messenger, click on the per-
son’s name and select the
Voice tab, which will enable
voice.  

Improve video quality 
The new generation of chat
clients allow you to video-
conference using a Web

camera. Usually, on a dial-
up connection you will
experience a delay between
the time that an action takes
place and when it is record-
ed on the camera. To min-
imise this delay you could
reduce the image quality
and increase the refresh rate.

In Yahoo! Messenger, go

to Login > Preferences > Web
cam and move the slider to
‘Faster refresh’. The image
that you receive now will be
refreshed at a faster rate,
which means lesser lag time
in the transmission of
actions at the other end.

Organise list of friends
When you have a huge set
of friends in your Instant
Messenger list, it becomes
difficult to keep an eye on
all of them. Add folders and
name them appropriately,
for instance, Family, Friends,
Colleagues, and so on. You
can now place names in the
relevant folders. If you are
using Yahoo! Messenger, go
to Tools > Manage Friend List >
Create Group.

In MSN messenger, the
newer version by default
organises or sorts the

friends’ list by
groups. But if you
are wondering how
to sort them back
to the online or
offline status
which your previ-
ous MSN version
displayed, go to
Tools > Sort Contacts
By > Online/Offline. 

Disable auto-
matic saving of
passwords

Never keep your passwords
saved if you’re sharing your
computer, even though it
makes automatic logins easi-
er. Saving passwords makes
it very easy for other users
to log on using your name.
In MSN Messenger or
Yahoo!, during signing in
you get the option to auto-

matically save passwords.
Disabling this option will
prompt you for a password
each time you log in. 

Save the contact list
If you have more than a
handful of contacts in your
MSN Messenger list then it
makes sense to have their
addresses backed up some-
where just in case you run

Reduce camera refresh rate in Yahoo! Messenger

Download Mail to
your PC

If you use a Web-based 
e-mail service, such as those
run by Yahoo! and MSN,
download a copy of your
mail directly to your browser.
This is much quicker than
using the bandwidth-hungry
Web interface and also allows
you to access your mail with-
out having to be connected
to the Internet.

To do this first add a new
account by going to Tools >
Accounts > Add and select the
Mail option. You will be
prompted for personal details

and account information.
Select the POP3 server
option in the screen that asks
you for your e-mail server
information and enter the
appropriate POP3 server
address for incoming mail. 

Download Web-based mail
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into trouble accessing your
MSN account. Switching
over to a new account is a
lot less painful if you have
your contacts list handy.
The current version of the
messenger client (3.6 or
later) will let you save your
contact list as a .ctt file. You
can do this from File > Save
Contact List. 

This can be later import-
ed using the File > Import
Contacts option.

Blocking persons
Sometimes blocking is a
very good option to get rid
of overbearing friends. If
one wishes to do so, simply
go to Tools > Options > Privacy
(for MSN Messenger) and
select the person to be
blocked. Block and delete
will permanently remove
the contact from your list
and you also have options
to remain invisible or
offline.  

Quick access to received
files  

When you receive files
using MSN Messenger they
automatically download to
\My Documents\Messenger
Service Received Files folder
in Windows 98/Me and
\Documents and
Settings\username\My
Documents\Messenger
Received Files in Windows
2000. Instead of opening
Windows Explorer and
browsing to the folder each
time, you can access the file
faster through MSN itself.
Just go to File > Open Received
Files and the folder where
the files are located auto-
matically opens.

Saving Web pages
If you often feel the need to
save copies of Web pages,
use Internet Explorer to save
all the elements of the page
in a single .mht file. Go to
File > Save as and in the Save
as type option select Web
Archive, Single File (*.mht). 

Managing your 
bookmarks
Bookmark interesting Web
sites that you want to revisit.
You can furthur organise
your favourite Web pages
according to the content, for
instance, music, humour,
troubleshooting, leisure and
so on. Go to Favorites > Add to
Favorites and select the New
Folder option to save the
Web page. You can also
move or modify your book-
marks from the Favorites >
Organise Favorites option. 

Restricting access
An increasing number of
Web sites disseminate adult
content but it’s possible to
restrict viewing of such sites
using Internet Explorer

instead of relying on a third-
party software such as Net-
Nanny. Go to Tools > Internet
Options > Content > Content
Advisor. Set the level of pro-
tection you want and assign
a password so that the level
of protection cannot be
changed. 

Smarter surfing
It’s no use twiddling your
thumbs waiting for a Web
page to load. Open multiple
browser windows and start
getting used to surfing with
many pages at one time.
This saves time and you can
avoid some of the Web traf-
fic blues too. Using a brows-
er such as NetCaptor will
ensure that the multiple
windows don’t clutter your
taskbar and are instead
placed as tabs within the
browser itself. 

Autocomplete URLs 
You don’t always have to
type the complete URL to
open a site. IE has an 
autocomplete feature that
lets you type the name of

the Web site and press [Ctrl]
+ [Enter] (only if the Web
site ends in .com). For a 
frequent surfer, exercising
this option saves a lot 
of time.

Autocomplete data
Many browsers such as
Netscape and IE let you
autocomplete the Web site
name as well as the data
entered in the previously
visited Web sites. User
names and passwords need
to be entered just once and
on your next visit the brows-
er automatically fills in the
required fields. This is a
timesaver if you are brows-
ing multiple sites—your
next visit to the site will not
require you to type the data
all over again.

Importing bookmarks
If you’d like to import book-
marks from one browser to
another, go to File > Import
and Export and the wizard

will guide you through the
process. This gives you the
same set of links organised
in the same manner in
another browser. 

BROWSING

Bookmark favourite sites
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Disable animation and
sound
Irritated by the time it takes
for sites to load all the
images? You can make the
Web pages load faster 

provided you are willing to
compromise on certain
applications. Disable

options such as playing
videos, animation, sound
and even images. The Web
pages will then load in 
a jiffy. 

Blocking 
cookies
Most Web sites
today place a cook-
ie on your comput-
er whenever you
visit them. These
are sometimes used
to identify surfers
when they come
back to the Web
site. Because cook-
ies often contain
personal informa-
tion, you might
want to prevent
them being stored
on your drive.

This can be prevented in
most browsers. If you are
using IE 6, go to Tools > Inter-
net options > Privacy and
adjust the settings to ensure
that only sites that you trust
will be allowed to store
these cookies.

Increasing cache 
Whenever you visit a Web
site, the graphics and the
text on the pages get stored
in your computer’s cache.
This allows the browser to
load Web pages faster when
you next visit the site by
reading data from the cache.
The larger the size of the
cache, the more the amount
of data that can be stored,
and the faster will be the
browsing.

However, an increase in
the size of the cache will
take up valuable disk space.
To find the right balance

you should experiment with
the size of the cache. Do this
by going to Tools > Internet
Options > General > Settings
and use the slider to
increase or decrease the size
of your cache.

Disabling automatic
refreshing
Every time you visit a site
you’ve been to before, the
browser tries automatically
refreshing the contents of
that page. 

This means a wastage of
bandwidth in case the infor-
mation on the page does
not change often. One can
avoid this by going to Tools >
Internet Options > General > Set-
ting > Never. However, on
dynamic pages like the
home page of a portal you
need to remember to press
[F5] (the Refresh key) so that
you don’t end up looking at
old information. 

Remove IE icon from
desktop
For those who like a mini-
mum of clutter on their
desktops you can remove
the icon of Internet Explorer
by going to Tools > Internet
Options > Advanced. There you
can scroll down till you see
the option of ‘Show Internet
Explorer on Desktop’.
Uncheck that option and
the Internet Explorer icon
will disappear from the
desktop.

Keep your passwords
private
If you surf from an Internet
café you should check to
see that your browser is not
saving your passwords in its

cache. This might allow
people who use the system
later to access your private
e-mail account. To disable
this you will need to go to
Tools > Internet Options > Con-
tent > AutoComplete Settings
and disable the ‘User names
and passwords on forms’
option.

Use a firewall
Installing a firewall is a
must for those hooked to
the Net. A firewall not only
protects you from attacks
from the outside but also
against Trojans. There are
several personal firewalls
that provide protection
against these. ZoneAlarm is
one such free software,
which allows you to select
the programs which are
allowed access to the 
Internet.

Block unwanted distractions

PC-TO-PC CALLS
Buddy Phone, Yahoo! and
MSN Messenger allow users
to make phone calls from
one computer to another,
provided both computers are
online. If you would like to
use this facility in MSN
Messenger, select your
friend’s name from the list
and go to Actions > Start a
voice conversation. This can
also be done by right-clicking
on the person’s name and
selecting the option of ‘Start
a Voice Conversation’. After
the opposite person has
accepted your request, you
can start talking into the
microphone. 

BROWSING
OFFLINE

Quite often you may want to
refer to a page that you have
visited at some point in time.
While finding the link in your
browser’s History is not too
difficult, you can view the
site without actually logging
on to the Internet by going
to File > Work Offline. Then
just click on a link in your
History folder to view the
complete page from your
hard disk.
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Search toolbars
Download search toolbars
provided by Google and
Yahoo! and make them a
part of your browser’s tool-
bar. Type the search query
directly in the toolbar.
Netcaptor allows you to use
shortcuts to directly search
from the address bar. For
example, typing g digit will
automatically search for
Digit in Google. 

Browser plugins such as
UCmore and Atomica are
very useful when you are
searching for specific 

information. Both the
Google toolbar and
UCmore let you locate
pages or Web sites that are
similar to the ones that you
are visiting at a particular
point in time. 

Girafa is a free browser
add-on that provides a
visual preview of Web sites
thrown up by a search
engine without requiring
you to actually visit the
Web sites. 

Defining search criteria
In order to get accurate

results from a search, define
the query in a proper man-
ner so as to generate correct
results the first time itself.
Using exact phrases: To
find an entire phrase as it
is, add quotes (“ ”) around
the term. For example,
“Digit India” returns list-
ings where the words
“Digit” and “India” appear
together and in that order,
either in the title, the URL,
the description, the key-
words, or the document. 
Search for required words:
Type the plus sign (+) or
the word AND before a
word for it to be found in
all of the search results. For
example, Digit + India
(include a space between
the first word and the +
symbol) or Digit AND India
returns all listings that con-
tain ‘India’ and ‘Digit’ but
not necessarily together. 
Search by excluding: Use
the minus sign (-) before a
word or the word NOT for
it to be not found in the
search results. 
Search for multiple
words: Use the word OR
for one or the other term to
be found in the search
results. To find documents
containing the word ‘Digit’
but not the word ‘India’ or,
for example, the word
‘cricket’, type digit NOT
(India OR cricket). You could
also type this as digit - (India
OR cricket).

Using wildcards
An asterisk (*) indicates a
wildcard search. This is use-
ful when you are trying to
match a term that may or
may not be plural or might

use one of several verb
tenses. For example, physi*
will find results containing
words that begin with
‘physi’ (like physics, physi-
cal, etc). You must have at
least four non-wildcard
characters in a word before
you introduce a wildcard. 

Some search engines
support two wildcards. The
asterisk (*) is used to replace
multiple characters and the
per cent (%) symbol is used
to replace only one charac-
ter. For example, psych*ist
will find all results which
contain words that begin
and end with ‘psych’ and
‘ist’ (like psychologist and
psychiatrist), and
gene%logy will return sites
containing words begin-
ning with ‘gene’ and end-
ing with ‘logy’, separated by
a single letter (like genealo-
gy and geneology) which is
useful for commonly mis-
spelled words.

Third-party searching
aids 
Third-party software such
as Copernic 2001 allows
you to obtain fast and rele-
vant results from multiple
search engines right off
your desktop. Copernic
searches 80 search engines
which are grouped into
seven categories. It does
not display any broken
links, and it also allows
Web translation into seven
different languages.

Secret tips for search
engines 
Google: If you want
extremely quick results 
for your search, there’s

SEARCHING
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nothing better than Google.
It generates highly accurate
results in barely a couple of
seconds, depending upon
your speed. You might also
have noticed two more
options, ’Cached’ and ‘Simi-
lar Pages’—shown after
every search in Google. So if
you want sites similar to the
one displayed in the result,
click ‘Similar Pages’.
Yahoo!: Yahoo! has a huge
index of sites. So if you are
clear on what you are look-
ing for, head for Yahoo!
Directory.
Lycos: The search feature in
Lycos filters out inappropri-
ate material by dropping
certain keywords from the
search criteria. This prevents
children from viewing
offensive material. 

AltaVista: AltaVista has a
filter option to sift the con-
tents of the search. More
importantly, it provides
users with a password facili-
ty so that the search settings
may not be changed. For
this, one must first activate
the family filter which is
present on the home page.
MetaCrawler: MetaCrawler
provides a mini crawler that
allows you to search from
your desktop. If you have a
slow connection or are using
an old browser, it offers a
‘Low bandwidth search’.

Dragging and dropping
links in FlashGet
Sometimes, after clicking a
download link, the browser
prompts you to download
required files. In order to
make your download man-
ager do so automatically,
drag and drop the link in
the download manager. If
you are using FlashGet as
your download manager,
activate the ‘drop zone’
option. This will display a
small window on your
screen; drag and drop the
link on to the window and
your file will begin down-
loading. 

Increasing downloads
If your download manager
refuses to download more
than two or three files at a
time, go to Options and
change the number of files
which are to be down-
loaded. Usually, by default,
download managers allow
downloading of two or three
files at a time. Increase the
limit. Also, you don’t have

to wait for the previous file
to complete downloading.

Specifying speed in
FlashGet
If you frequently download
multiple files on a network
you will end up depriving
others of bandwidth. To
avoid this, set a speed limit

which restricts the band-
width utilised by your
download manager. For
most situations you should
set this at about 3 Kbps by
going to Options > Connection
> Download Speed Limit.

Scanning downloads
A virus finds ingenious

ways of entering your PC
and downloading files with-
out scanning content is an
open invitation to PC pesti-
lence. Most download 
managers give you the
option of automatically set-
ting your anti-virus soft-
ware to scan every file that
is downloaded.

In FlashGet you can do
this by going to Tools >
Options > File Manager. Select
the ‘Use virus scanner to
scan the downloaded file(s)’
checkbox and then specify
the path to your anti-virus
software and scan com-
mand. 

For McAfee AntiVirus this
would be something like
C:\Program Files\McAfee\
VirusScan95\scan95, args
/autoscan /nosplash 

Norton AntiVirus users
might try C:\Program
Files\Norton
Antivirus\navw32.exe

Split files
Splitting files can increase
download speeds tremen-
dously in FlashGet. Usually,
splitting the file in three or
five segments is sufficient.
However, if you are down-
loading a particularly large
file which is available from
several servers, you could get
better speeds by increasing
the number of segments
being downloaded simulta-
neously. 

The number of segments
that you want the file in can
be set in the option box that
pops up when a download
begins. Just set the option
for the number of segments
that you want the file to be
split into.

DOWNLOAD MANAGERS

Time the downloads for efficiency 

Content filtering in Lycos

insight ■
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Enthralling scenarios,

mind-blowing graphics,

fast-paced action and 

thrills that have kept us 

glued to our PC! 

Games that have 

inspired us,

scared us, and 

amazed us.

Here's a count down of 

games that no gamer 

worth his salt should miss.

Want to play?

■■ Deus Ex
Conspiracy theories, global domination, secret service and a few cho-
sen who rule the world. That’s the background for ION Storm’s
FPS/RPG, Deus Ex. (FPS: First Person Shooter, RPG Role Playing Game).
The role-playing element in Deus Ex comes primarily from skills and
augmentations, which makes the game very interesting. Want rock
solid aim with the sniper rifle? Invest your points in the rifles skill.
Want to make it easier to pick locks or hack computers? Invest in lock-
picking and computers, respectively. The choices you make in skill 
distribution directly affect your performance in the game.

arcade ■
■ games

■■ No One Lives Forever
Monolith never had a track record of making good games before

this. But suddenly, almost out of nowhere, they
came out with a kitschy, 1960s-Bond-themed
No One Lives Forever (NOLF), which rejuvenated
the FPS genre itself. 

For once, there’s a female lead, Cate
Archer, who doesn’t rely on her ‘assets’ but
on her quick wit and quicker reflexes to ‘save
the world’. The game uses several clichés
from Bond movies with humour that would
put Austin Powers to shame. The cut-scenes
are full of one-liners, like Archer’s partner
assuring her, “I can be subtle,” and Cate
replying, “Then explain that shirt.”

■■ Black and White
In contrast to the traditionally violent game
worlds such as Quake and Soldier of Fortune,
Black and White is almost  a work of art.
Peter Molyneaux is a British scallywag —a
guy who re-reads Lord of the Rings
during his free time. He’s the creator of a
subgenre called the ‘God game’ and is the
mastermind behind Populous and Black
and White.  

The game has an insanely complex
artificial intelligence (AI) and offers an
open-ended gameplay with a limitless
range of emotional and moral paths.
Black and White stands apart in creativi-
ty and perhaps even surpasses our
best films or books on that count.
Call it interactive art, this game
changes itself as you play it, and
over a period of time, it becomes
a reflection of who you really are.   
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■■ Tetris
Russia’s greatest export! No other game has had the impact and
fan following to match Tetris. A simple game, the objective is to
stack falling blocks of four into a line. You do so until infinity, or
until you lose. But within that game are multiple layers of strate-
gy and approaches that fascinate both the layman and the
mathematician. The game is simple and can be played on even
the most primitive computer and yet can be seen on some of
the most powerful consoles and PCs. In fact, it sold 30 million
copies on the Nintendo Gameboy. Add an equal number to the
uncounted clones sold in grey markets as 'Brick Game', in key
chains, in handhelds and cell phones. Ironically, Alexey Pajinov,
the creator of this game did not make a single rouble out of the
royalties, all of which went to the Soviet Ministry of Commerce.

■■ Diablo II
In 1996, Blizzard, the company that perfected the RTS genre
with Warcraft, unleashed Diablo. Before Diablo, RPGs and Action
games never found a common ground. In many respects Diablo
is a simple action game, requiring only the left mouse button to
play, but it has the storyline of an adventure game and the
open-endedness of an old-school RPG. 

In Diablo you play either as a warrior, rogue, or sorcerer who
has journeyed to the town of Tristram for whatever reason you
want (money, adventure, obsessive-compulsive desire to beat
the unliving crap out of the undead) to fight back an invading
demonic horde from beneath the town, led by the strongest of
the Evils, Diablo himself.

■■ MDK 2
MDK was one of those unfortunate games that had everything
going for it except sales. It had great graphics, wicked level
design, and critical acclaim.Though it went largely unnoticed, its
sequel offered some redemption to the characters and made
them gaming icons. 

MDK 2 is a third person shooter where you control three
characters: Dr Fluke Hawkins, Max the six-legged dog, and Kurt
the Janitor. Each of these characters lend itself to an innovative
form of gameplay: Max can use four weapons at a time, which
makes him ridiculously powerful; Kurt has sniping and paraglid-
ing skills; and Dr Hawkins is the wacky scientist who creates dev-
astating weapons by combining items at hand together. 

■■ Counter-Strike
What started out as a simple mod on the Half-Life engine two years
ago has now gone through several enhancements, improved net-
work code, balanced gameplay, and voice support. Counter-Strike
enjoys popularity unlike any other mod; more people play it online
than Unreal Tournament and Quake III combined. The game basi-
cally boils down to this: two teams, terrorists and anti-terrorists,
fight it out. The team that survives wins the round. Since you have
to play as a team, it creates a unique team play atmosphere where
cooperation is as crucial as your ping. More than anything else, it
creates gameplay that never gets boring. Even after playing a par-
ticular map to death, there are always new permutations and pos-
sibilities to explore. 

Since it’s based on a three-year-old Half-Life engine, it can play
on the leanest machines. A game fit for both LAN parties and pro-
fessional gaming tourneys. Best played online or on a LAN, this is
the perfect game for after office hours. But here’s why Counter-
Srike takes the cake—it’s free.

■■ Max Payne
With fantastically slick narration, the Max engine, and Bullet-Time
motion, Max Payne is one of the shortest and sweetest gaming
experiences you’ll ever have. No game to date has featured such
sharp visual quality in its environments—environments that not
only look real, but also act real. John Woo was the main source of
inspiration for some of the intentional movie-like elements.

Max Payne has Bullet-Time, an effect much like the slow-
motion scenes in The Matrix. This effect causes the entire game to
slow down significantly in a dramatic effect that is designed to give
Max a lethal advantage over his enemies. Max Payne is about style,
about fast pacing, and that little compromise on realism keeps this
game centered on the sweet spot all the way. 

■■ Need for Speed 4: High Stakes

Recreated through close collaborations with the world's most
renowned car manufacturers, Need for Speed: High Stakes lets you
unleash a dream collection of cars on the wide, open roads. The
star of the show is, of course, the police mode, which is almost a
whole new game in itself. Ramming a few hundred thousand dol-
lars worth of vehicles off the road is pretty good fun, and makes
High Stakes worth it. 

The Need for Speed series may not win accolades from the
purists, but when it comes to the thrill of riding some of the
world's fastest sports cars, nothing comes close. This game might
have sequels that are better looking and counterparts that are sim-
ulated to the very minute detail, but in terms of replayability and
clean fun, this is simply the pinnacle of sports car racing. 
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■■ Commandos
Pyro’s Commandos ranks as one of the most memorable games
in the tactical strategy genre. The game is a combination of sin-
gle and multi-squad campaigns in which you have to manage
Dirty Dozen-type special agents during infiltration missions in
World War II. At every situation, you have to be constantly
aware of the consequences. Playing a mission is like figuring out
a puzzle and it takes many retries before one would finally get it
all together. While Commandos may not win any awards for its
graphics, it’s great to see the aesthetic value and the attention
paid to detail. It works smoothly on the leanest of machines—a
Pentium 166 will do just fine. 

■■ Homeworld
A terrific story, amazing narrative, mystery, and surprises at
every turn. In a genre (real time strategy or RTS) notorious for
being boring and predictable, Homeworld is revolutionary.
The story is of a colony struggling to find its home and roots.
Equipped with hyperspace capabilities, you take a massive
colony of people in search of their home, only to run smack
into a swarm of hostile aliens. You have to guide your fleet
through a series of 16 missions by building more vessels,
researching new technologies, and harvesting resources in the
voyage to your Homeworld. 

The 3D engine is stunning and the attention to detail is
simply staggering. The interface is very intuitive, though the
three-axes movement may be a little tricky. 

■■ Half-Life
No game has come this close to capturing public imagination
and the critic’s mind alike. The story line was genuinely scary,
and the interaction with non-playing characters (NPCs) such as
scientists made the game seem much more real. 

Half-Life didn’t just raise the bar for PC gaming, it obliterat-
ed it. Hard to believe, but this first game by a couple of
Microsoft milionaires brought about many staggering innova-
tions to FPS games: skeletal animation, intelligent AI, great story
telling, NPCs, map and mod support. In the single-player game,
you play Gordon Freeman, a research scientist working in a
secret government lab with strange alien materials. Very early
on, disaster strikes and you have to fend off alien attackers and
the US military. The plot, though rigidly linear, serves its purpose
admirably. Half-Life has deservedly won over 50 ‘Game of the
year’ awards from publications and print magazines worldwide.

■■ Command and 
Conquer Red Alert 2
The C&C series deserve the credit for taking RTS to a main-
stream level. If you had to pick one more title to add
to your shopping list, it would have to be Red Alert,
the best of the C&C games and one of the great-
est strategy games every made. C&C has a fic-
tion-meets-the-real-world type of story
line, where Einstein invents a
time machine and using it,
kidnaps Hitler to prevent the
outbreak of World War II.
Though early versions of
C&C were strongly single-
player based, later ver-
sions began to explore
the multi-player options
and more specifically, the
skirmish mode. That’s
because the AI gets pre-
dictable after a while
and is not able to put
up much of a fight against a
human. A single skirmish can
take several hours to com-
plete, especially when both
the opponents are evenly
matched.

■■ Quake III

id software has always set stan-
dards in terms of graphics. Curved
surfaces, reflections, environment
mapping and volumetric fog—
Quake III was the first graphics

engine to enable curves to be creat-
ed, rather than lots of polygon flat

shapes placed close together.
This game has been the basis for many

other retail games such as Star Trek: Elite Force,
and American McGee’s Alice. Return to Castle

Wolfenstien uses a modified version of the Quake III
engine. Quake III is the reason people buy graphics

cards, and these graphics cards lead to better games, and
better games need better graphics cards. The gaming

industry would have been significantly different today if not 
for Quake.

SRIRAM SHARMA

■■ Unreal Tournament
When Unreal Tournament (UT) was released in 1999, everyone
drew a comparison to Quake III, and in many review sites, UT
was the more popular choice. 

The UT bots were far more skilled than the ones Quake III
had, and with a feature called auto-adjust skill, the bots could
match the average skill set of the player they were currently
engaging. UT followed the everything-but-the-kitchen-sink philos-
ophy, having game types such as Tournament DeathMatch,

Assault, Domination, Capture The Flag, and Last
Man Standing as the standard package. 

UT has a markedly inferior 3D engine
than Quake III in terms of raw power and
capability. This conversely makes the

game run acceptably on older PC hard-
ware in software mode. Besides, UT has the

ability to render extremely large maps with-
out choking your video card. 
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If you'd kill for single player action games, it’s time you took
a Payne shot

MRP: Rs 699 · Min Requirements: 450 MHz Processor, 96 MB RAM, 16 MB Direct 3D compatible graphics card · Distributor: Express Interactive, Phone: 022 8870017

Shooting in 
Bullet-Time
Max Payne would be impossible to
complete without the bullet-time
shootdodge, which helps you
move in slow motion and perform
some amazing aerial manoeuvres.
For the perfect
shootdodge, start
diving from behind a
wall to the left or right, pepper any
enemies with bullets, and dive
behind any available cover. Shoot-
ing in slow motion allows you to
size up your enemy and manoeuvre
yourself right into them. Make sure
you are behind a wall or a table
after your bullet-time manoeuvre,
as it can leave you vulnerable to
enemies. 

A Dig at Hollywood
Max Payne takes a few referential jibes
at Hollywood action movies. Conver-
sations between thugs give away endings to some popu-
lar movies such as Pulp Fiction, Seven, and The Usual
Suspects. And then there’s the lobby scene complete with
metal detectors, a la The Matrix.

Three years in the making and the latest release from the
Finnish company Remedy, Max Payne is the best single
player action title after Half-Life and arguably the game of
the year for 2001. It follows the story of a fugitive under-

cover cop, framed for murder and hunted by the cops and the
mob, on a wintry Christmas Eve in New York. The game boasts

of several new innovations, a proprietary graphics engine,
bullet-time ‘Matrix’ gameplay and noir storytelling.

SRIRAM SHARMA

A Cold Day in Hell
This is probably the most difficult part of Max Payne, where he
gets stuck in a drug-induced hallucination and has to run

through a corridor maze. Head into
the corridor maze and take the follow-
ing directions: right, left, right, left,
left and straight ahead, left and a
right, which will bring you to a path
that leads you to a blood trail. On left
is the map of the blood trail for your
navigation. You must walk only on the
blood trail or you fall off and die.

To get access to the game console, create a
shortcut on the desktop and enter 
-developer in the target. Access the game con-
sole with [F12] once you have developer
mode running.

Example: 
C:\maxpayne\maxpayne.exe -developer

Press [F12] to bring up the console, then type: 

Coder For God mode, all 
weapons, 
unlimited ammunition,etc. 

God For God mode 
Mortal Switches God mode off 
Getallweapons All Weapons 
Getinfiniteammo Unlimited ammunition 
Noclip No clipping mode 
Noclip_off No clipping mode off 
Getbullettime Fill up when bullet-time 

runs out 
Showfps Show frame rate 
Getpainkillers Get eight painkillers 
C_addhealth (100) Add 100 to health 
Jump10 Jump higher (set to 20 

or 30 for even higher) 
Setwoundedstate Walk as if wounded 
Setnormalstate Walk normally 

Activate cheats

Being Max Payne 



Budget game packs come in
three flavours: games that

have been out for a decade or
more; shareware compilations;
and custom-built nonentities.
However, there are glimmers
of hope. Companies such as
Milestone and EA have made
noble efforts
at improving
the overall
quality of
budget titles
with games
that play
smoothly on
your not-so-
state-of-the-
art -PC-any-
more type of set up. Lock and
Load, the first FPS-only game
pack, is not a run-of-the-mill
budget title but is a good
chance for the FPS enthusiast
to play games that were over-
shadowed by Half-Life. 

This is what the line up
looks like: Soldier of Fortune
Platinum Edition, SiN, Kingpin:
Life of Crime, Spec Ops II with
Spec Ops II: Operation Bravo an
expansion pack.

Soldier of Fortune is an
ultraviolent shooter. It uses
the proprietary GHOUL tech-
nology that manages individ-
ual hit points and makes gore
even more visceral. Kingpin
puts you on the streets as a
gangster, where violence is the

only means of
negotiation.
With in-game
music from
rap group
Cypress Hill,
this game has
one of the
best sound
effects for any
FPS.  SiN, an

under-appreciated classic from
Ritual, will surprise you in
many ways, with controllable
vehicles and fantastic level
design. Spec OPS II is a Tactical
sim where you assume the role
of squad commander. Howev-
er, the game is riddled with
bugs that sour the experience. 

Released during 1998-99,
these games have an excellent
mod community, you can
download custom missions
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weak enemy AI which fails to
respond even to gunfire at
some places. The stealth feels
more like a ‘me too’ feature
than a gameplay device.  

Single player mode in the
game is quite short, with
about 13 hours of gameplay at
most. While this version may

not have lived up to the hype,
the multiplayer mode adds
extra grace and makes it a
winner. 
Developer: Gray Matter Studios
Genre: Action
Web site: www.returntowolfen-
stein.com
Rating: ★★★★

It’s been nearly 10 years
since Allied espionage soldier

William J. ‘B.J.’ Blazkowicz
made his first escape from 
Castle Wolfenstein. After
almost a decade comes the long
awaited sequel to the game that
started it all. With a huge budg-
et and a modified Quake III
engine behind

the project,
fans of the FPS genre have
keenly awaited Return to Castle
Wolfenstein (RTCW).

RTCW’s story unfolds in
the early levels through seem-
ingly unrelated events. B.J.
Blazkowicz is asked to infiltrate
and examine the activities of
the Nazi Paranormal Division,
headquartered at Castle
Wolfenstein. The story pro-
gresses through a wide variety
of mediums-in-engine cut
scenes, enemy conversations,
mission briefings and scattered
notes around the levels. 

The graphics engine is
truly next-generation, and
together with the level design
makes for some of the
smoothest gameplay on single
player mode. Enemy models

are highly detailed, their
movements realistic. 

RTCW is a mix of ele-
ments from the great shoot-
ers of the last decade, blend-
ing stealth with action, Half-
Life at some parts and at
some places, Thief. The
game’s seven missions are

divided across 26 levels
and take you through a
variety of locations,
each differing in struc-
ture and design.  Some

of the missions exercise
stealth while others are run-
and-gun missions. The ones
that are centred on combat
with Nazi troops are highly
engrossing. The guns are
modelled  marvellously—
especially the flamethrower
and the sniper—and give off
very impressive sound feed-
back. Gaming sweetness lies
in seeing the flamethrower
creating a near arc in the air. 

The pitfalls? With highly
objective-oriented missions,
linear gameplay renders the
objectives near redundant to
the game’s levels. The action
parts of the game were really
incredible; the stealth parts
were not, partly due to the

A killer espionage game, the Best Guide to Illustrator,
a guide to Ayurveda and more games and books reviewed…

Death Matches
RETURN TO CASTLE WOLFENSTEIN

It's good to be back

LOCK AND LOAD

Pick and Play

➜
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and maps, and replayability is
assured, thanks to the multi-
player modes. All these games
have multiplayer modes,
though not as popular as
Quake III or UT, but immense-
ly playable. Finding online
servers would be a nightmare,
but on a LAN these can surely
get the party started. 

SiN, Kingpin and Soldier of

Fortune use modified Quake II
engines, so the graphics are
definitely fetching. For a
game pack, this is an impres-
sive line up of games,
although the Rs 1,299 price
tag is a tad steep for only four
games. However, this remains
an excellent purchase for peo-
ple with mid-range systems
who don’t intend making an

upgrade just to play the latest
games.
Developer: Various
Genre: Action
Contact: Milestone Interac-
tive 
Phone: 022-8381614
Web site: www.milestoneinter-
active.com
Price: 1,299
Rating: ★★★★

Whether you are a begin-
ner or a seasoned user of

Adobe Illustrator, this book
should cater to your needs. The
focus is on the Adobe Illus-
trator 9.0. There’s
an eight-page intro-
duction to the new
features of the latest
version.  The infor-
mation is categorised
as  Basics, Tips, Exer-
cises, Techniques, Gal-
leries and References.
All along the book you will find
illustrations or screenshots to
assist you. A CD-ROM icon
along with any of these illus-
trations is an indicator that the
art sample is available in the
accompanying CD. Every
chapter has an ‘advanced tech-
niques’ section, which discuss-

es the nitty-gritty of complex
artwork and all of them are
accompanied with a step-by-
step explanations. Altogether

this book is a combina-
tion of a guide, tips and
tricks galore and also an
expert advisory to the
latest version of Adobe
Illustrator. The book
also has a handy pull-
out at the rear side,
which is full of short

cuts and keyboard and mouse
combinations to quicken your
working and learning in Illus-
trator.
Publisher: Peach Pit Press
Contact: Computer Bookshop
Phone: 022-2070989
Fax: 022-2623551
Price: Rs 2,534 (approximate)
Rating: ★★★★

THE ILLUSTRATOR 9 WOW! BOOK
Illustrator’s delight

This book is a true tutor for
users at all levels. An

absolute beginner should find
it eye opening, while an expe-
rienced user might find it to be
a helpful tool in achieving
complex designs with
Dreamweaver 4. Starting off
with simple HTML designs and
ending with site management,
the book gives you a complete
insight into how you can go
about building and deploying
a site. The author takes you
into a step-by-step practical
process of building a site. By

quoting refer-
ences to existing
sites the book
makes learning
Dreamweaver 4
quite easy. Alto-
gether this
book is a good
guide for starters and an even
better tool to fall back on for
experienced users.
Publisher: Peachpit Press
Contact: Computer Bookshop
Phone: 022-2070989, 2076356
Price: Rs 1,100 (approximate)
Rating: ★★★

When you think image-
editing tools, the first

name that comes to mind is
Photoshop. The latest upgrade
of the software, version 6, has
ensured that things only get
better and easier for
the designer and
imaging artist. And if
you need an insight
into the juicy tidbits
in the new version
then you should prob-
ably start off with this
book. Photoshop 6
WOW! gives you a glimpse of
what’s new in version 6 and
also ImageReady 3. Take a brief
look at the new features added
and the improvements made
to the old ones. You can also
follow in-depth reviews of the
features in later chapters. Then
get a quick grasp of the basics

in the section on fundamen-
tals of Photoshop. From here
on the book takes you through
the essentials of Photoshop.
The book also has a section on

Web and motion
graphics as well as one
on paintings. While
the book does seem
textually dense in
certain sections, it
makes up for it with
some eye-catching
screenshots and

visuals. And for a real treat and
some inspiration, check out
the paintings and art work
showcased in the book.
Publisher: Peachpit Press
Contact: Computer BookShop
Phone: 022-2070989
Fax: 022-2623551
Price: Rs 2,028 (approximate)
Rating: ★★★★

MACROMEDIA DREAMWEAVER 4
Dare to weave a dream

THE PHOTOSHOP 6 WOW!BOOK

Oh WOW!

This CD title is chock full
with information on

Ayurvedic treatments for vari-
ous ailments. The

Shortcuts
icon on the
i n t e r f a c e
lets you
view a num-
ber of very
slick videos

on the various techniques of
therapy used. 

You can also get a list of
Ayurveda treatment centres in
Kerala from this section, as
well as a list of ancient

Ayurvedic terms and phrases.
In addition, you will find a list
of important medicines with
their scientific names and
medicinal uses in the Short-
cuts section. The References
section gives you a list of
books that you can refer to. All
in all, this is a very informa-
tive package. 
Developer: Invis Multimedia
Contact: Relax Herbals and
Exports
Web site: www.ayurvedicmas-
sage.com
Price: Rs 1,269 approximately
Rating: ★★★ 

Rejuvenated with Ayurveda
AYURVEDA:THE MANTRA OF NIRMAYA
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Sharing and distributing MP3s
Extract songs from an audio CD to an MP3 or any other
media format and it’s a crime. The moment you distrib-

ute the MP3s or allow other users access to those files, you
are in a bigger soup. In an office environment, your actions
of ripping audio CDs and sharing MP3s can even get your
employer into legal trouble. 

Pirating software 
When you buy an assembled PC, you get a
lot of software goodies. But unless you have
specifically paid for the software and have

the license for it, you are committing piracy.
Using a licensed copy of software on more com-
puters than what the license permits is also a
crime. You are also not allowed to distribute
games or software.

Using a software crack 
Taking the software demos or time-limited
versions available on the Internet or from CDs

and using cracks or passwords to make the soft-
ware fully-functional isn’t the right thing to do.

Copying source code 
Using code from a Web site for your own program is
fine as long as you give proper credits. Again, in an

office environment if you destroy or conceal source code,
especially when it is required to be maintained under law, the
lawmakers will throw the book at you. 

Disregarding copyright
It’s very easy to cut and paste from
Web sites, but browse down in the
page and you will see a copyright

notice. Unless it’s specifically mentioned
that the content on the site is free, you
cannot copy content, images or presenta-
tions from Web sites.

Deleting files in Office
If a person without appropriate permission from the
user or network administrator downloads, copies or
extracts any data or information from the office sys-
tem or deletes or damages such data, he is violating

the Information Technology Act, 2000. You are liable to
pay compensation to the extent of Rs 1 crore.

Hacking 
Proud of your hacking/cracking skills?
Change a user’s password and restrict his

access to a network (or Internet)or a PC, use
credit card numbers for purchases without the
knowledge of the owner, distribute viruses—
then you’re surely on the wrong side of the law. 

Publishing/sharing porn
Even though you can watch porn over
the Net, the moment you distribute
and share it over a network, you are

entering the dark world of crime. The law on this
may make for amusing reading (“whoever pub-
lishes….any material which is lascivious or appeals
to the prurient interest...”), but the law-upholders
take this matter quite seriously.

Ripping movies
You can rent a VCD and watch
it on your office computer, but

don’t think about ripping the VCD
and creating a DivX movie out of it.
DivX, per se, is not illegal, but creat-
ing DivX movies is.

Illegal downloading
So what if Napster, Audiogalaxy or similar sites
provide the service to search for MP3s or movies.

You cannot download them unless you have legal-
ly paid for the songs or movies to be downloaded in
that specified format or unless the songs/movies are
free for download. This is one of the major crimes
most of us are unknowingly guilty of. 

YOU MAY HAVE ALREADY COMMITTED

2

1

3

4

5

6

8

9

10

CRIMESCRIMES

Crime and 
Punishment

Most of the crimes
listed are due to an
infringement of The
Copyright Act, 1954

(and subsequent
amendments made in

1994/95) and The
Indian Information

Technology Act, 2000.
The sentence for these
may extend to three
years with fine which
shall not be less than
Rs 50,000 but which

may extend to 
Rs 200,000. 

7There are many digital
crimes you can commit

unknowingly.
Read on and see—

Are you a
Criminal?
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www.flashkit.com
The Flash Developer’s data-
bank; bookmark it. 
www.extremeflash.com
More extreme, more Flash.
There’s a screenshot below. 

www.flahoo.com
A fabulously well organised
directory of Flash sites 
www.virtual-fx.net
Look no further for tutorials;
meant for users at all levels
www.flashplanet.com
The planet indeed with
news, resources and views
www.actionscripts.org
Online community for
developers at all skill levels
www.epsilonconflict.com
Load to see the kind of
magic that you can weave
with Flash

Pop artist Anaida,
whose hits include
‘Oova Oova’ and
‘Mailu mailu’, finally
discloses her top
five sites

Go to one of the sites that
sell what you want, say a
PDA. Pay for it with your
credit card and relax. It’ll be
delivered at your doorstep.
Time taken: three days with
FedEx delivery. 

Kabir Malkani (a.k.a.
Slick) is the designer
behind the enthralling
Digit CD interfaces.
Read on if you want
to follow his Flash
footsteps.
“If you are new to Flash,
there’s no place better
than the Internet. No
matter what you are
looking for—tutorials or
advanced tips or some
dazzling Flash art—the
Net is the place to be.
Come join us.”

TECHWAY

Anaida’s

The dominant age

range on the Internet 

is 18 to 35 years old.

The average age is 

around 31 worldwide.

There are more than 

2,700 newspapers with

online editions
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Team’s Top Picks

anaida.com 
Definitely the one that I
frequent the most!
Check it out yourself to
know more. 
lifeminders.com
I keep myself updated
on subjects such as psy-
chology with the
newsletters at Life-
minders.com. You can
find many interesting
topics here.
Gogo.com
Music is in my genes.
Gogo keeps me
informed about new
releases and music that
you can publish online.
Amazon.com
Can’t do without it; go
there to check out the
best music and order.
Cosmopolitan.com
The articles… definitely
worth a read!

5

Tell your friend or relative,
who lives abroad, to buy it
for you. Then wait for
months till they bring it.
Pay with cash. 
Time taken: months, if
relatives don’t come any
sooner, or at least a week. 

Getting things from abroad
OLD WAY
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Can working on a story have side
effects, besides the usual late
nights and caffeine addiction?
This month, one of our cover

stories, ‘Virusproof forever’, had a strange
effect on the team.

Things were running smooth while
we were redesigning Digit: stories were
being furiously edited, writers told to
write again, illustrations improved further
upon, design and graphics being coor-
dinated like never before. But glitches
happen with nary a warning. A real-
world virus quietly sneaked into people’s
systems and soon you could hear sniffles
and sneezes all over the place. 

The first casualty was Karan. Now
taking time off to rest and recover
would have put the schedule for the
redesign back by a few days. So our assis-
tant editor who is rarely seen in anything
other T-shirt and a pair of shorts, gave in
to the demands of the occasion and came
dressed in ‘full pants’ and a jumper for an
entire week.

The next to go down was the writer
Avina. But with very tight deadlines to
take care of, she simply updated the usual
writer’s arsenal of notepad, pen and 
dictaphone with a trusty box of tissue
papers to combat the changing war scene.
And in between juggling with her sniffles,
researching her stories, going out to 

interview people and then writing her
articles, she also found time to pack and
shift house.

Soon the virus infiltrated the bastions
of the copy desk. Anshul, our copy edi-
tor, was the first victim at the desk and
was missing in action for a day. But with
stories piling up at his desk, he was soon
back on the job and right where the
action was—making up for lost time by
working extra long, fortified with several
cups of hot tea.

Although the virus had taken its toll,

it was not done yet.
The design team

was one area where
it had not tried to
spread its tentacles as

yet. And so it
marched on—
Shiva, our senior

designer, was the next
victim. But he too continued

to man his post, trying out different lay-
out options between coughs and sneezes.

The joke going around the office was
that the virus was following the path of
the stories…from planning to writing,
copyediting and finally the design. We’re
wondering if it will next infect the pro-
duction team. We are also wondering if
we can draw lessons from our cover story,
‘Virusproof forever’. One other suggestion
floating around is that the next time we
do a ‘dangerous’ story, we test it first for
possible side effects.

Astory on supercomputing? That’s no
big deal for our writers. But ask a
technology writer to interview

celebrities and the initial reaction is one of
sheer bewilderment: “But I don’t know
any!” That’s what happened when we
decided to include a small item on the
favourite sites of celebrities. 

But our ‘proud-to-be-geeky’ writers,
who can talk technology backwards to you
if they want, were not so easily put down.

Soon everybody pitched in at digging out
every contact who could possibly help
them get in touch with a celebrity. Obvi-
ously, most of them were eager for a brush
with their favourite stars.

Now pinning down the stars is no easy
task because of their busy schedules and
the only time you can get hold of them is
late at night. 

Our writer Avina took the help of
Adarsh Kaul from our Events team, to call

up people in the entertainment industry
and try and track down the elusive stars.
Adarsh dug out his little black book and
they made some 30 calls in a single
evening. Then followed a late night vigil
by the phone waiting for responses.

Some of our more enterprising col-
leagues went on to scouting out cousines,
aunts and uncles—folks whom they didn’t
know existed till that moment. Just anoth-
er adventure in the remaking of Digit. 
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Adventures in Star Gazing

O P E R A T I O N  

RHINO VIRUS
Of a month that was filled with germ warfare, combat outfits and starry starry skies

ILLUSTRATION: Mahesh Benkar
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White Hazel
Trees
‘Llanfairpwllgwyngyll-
gogerychwyrndrobwlll-
landysiliogogogoch’ is the
name of a small village in
Great Britain, which has
probably been the longest
URL on the Net. 

It means the ‘Church of
St Mary in the hollow of the
white hazel trees, near the
fierce whirlpool and the
Church of St Tysilio, by a red
cave’. A tailor in the 19th
century invented this name
to attract traffic to a declin-
ing railway station. Perhaps
it may not encourage Web
traffic as well, which is why
the owners have taken it off.

Highlight the lighter side of 
computing. Mail your contri-
butions to  Backbyte
Digit, Plot D-222/2, 
TTC Industrial Area, MIDC, 
Shirvane, Nerul, 
Navi Mumbai 400 706
or send e-mail to
backbyte@jasubhai.com

Your chance to
bite back!

Suits and daggers
Business is war. And money is the most lethal weapon.
Bill Gates will be safe.
Taken from the Web

1. Great groups from little icons grow
2. Speak softly and carry a cellular phone
3. Don’t put all your hypes in one home page
4. Pentium wise; pen and paper foolish
5. The modem is the message
6. Don’t byte off more than you can view
7. What boots up must come down
8. Virtual reality is its own reward

9. Modulation in all things
10. A user and his leisure time are soon parted
11. Know what to expect before you connect
12. Oh, what a tangled Web site we weave when
first we practice
13.  Speed thrills
Contributed by:
Kamil Merchant

Jefferson vs Apple
Advertising is clearly one of the reasons why
Apple got famous. Here’s a vintage example.

Taken from 
www.sbrowning.com

Mirrored 
Computer
A PC is not 
an image 
consultant—not
yet. But we’re
getting there!
Contributed by:
Leena NairThe mail 

suspects
A police line-up is the last resort
for those troubled by spam. 
Taken from 
http://jokes.glowport.com

Beered!

A cold beer is a cure for most troubles. The right
peripheral for a certain guy.
Taken from www.funnyfreepics.com

Axioms for the Internet age

You grab him,

I’ll get the 40

billion

He keeps it on

him??

I should have

these guys

killed
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